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1 Introduction

1.1 Purpose of the Operating Guide

The purpose of this operating guide is to describe the VLT® Multiaxis Servo Drive MSD 510 System.

This operating guide contains information about:

• Installation

• Commissioning

• Programming

• Operation

• Troubleshooting

• Service and Maintenance

This operating guide is intended for use by qualified personnel. Read the operating guide in full to use the servo system safely and
professionally, and pay particular attention to the safety instructions and general warnings.

This operating guide is an integral part of the servo system and also contains important service information. Therefore always keep this
operating guide available with the servo system.

Compliance with the information in the manual is a prerequisite for:

• Trouble-free operation

• Recognition of product liability claims

Therefore, read this operating guide before working with the MSD 510 system.

1.2 Additional Resources

Table 1: Additional Resources

Manual Description

VLT® Multiaxis Servo Drive MSD 510 System Operat-
ing Instructions

Information about the installation, commissioning, and operation of the
MSD 510 servo system.

VLT® Servo Drive System ISD 510, DSD 510, MSD 510
Design Guide

Information about the setup of the MSD 510 servo system and detailed
technical data.

VLT® Servo Drive System ISD 510, DSD 510, MSD 510
Programming Guide

Information about the programming of the MSD 510 servo system.

1.3 Copyright

VLT® is a Danfoss registered trademark.
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1.4 Approvals and Certifications

Table 2: Approvals and Certifications

Certification Description

IEC/EN 61800-3 Adjustable speed electrical power drive systems.

Part 3: EMC requirements and specific test methods.

IEC/EN 61800-5-1 Adjustable speed electrical power drive systems.

Part 5-1: Safety requirements - Electrical, thermal, and energy.

IEC/EN 61800-5-2 Adjustable speed electrical power drive systems.

Part 5-2: Safety requirements - Functional.

IEC/EN 61508-1 Functional safety of electrical/electronic/programmable electronic safety-related systems.

Part 1: General requirements.

IEC/EN 61508-2 Functional safety of electrical/electronic/programmable electronic safety-related systems.

Part 2: Requirements for electrical/electronic/programmable electronic safety-related systems.

EN ISO 13849-1 Safety of machinery - Safety-related parts of control systems.

Part 1: General principles for design.

EN ISO 13849-2 Safety of machinery - Safety-related parts of control systems.

Part 2: Validation.

IEC/EN 60204-1 Safety of machinery - Electrical equipment of machines.

Part 1: General requirements.

IEC/EN 62061 Safety of machinery - Functional safety of safety-related electrical, electronic, and programmable electron-
ic control systems.

IEC/EN 61326-3-1 Electrical equipment for measurement, control, and laboratory use - EMC requirements.

Part 3-1: Immunity requirements for safety-related systems and for equipment intended to perform safety-
related functions (functional safety) - General industrial applications.

IEC/EN 60529 Degrees of protection provided by enclosures (IP Code).

UL 508C UL Standard for Safety for Power Conversion Equipment.

(Only applies to ISD 510 servo drive sizes 1 and 2.)
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Certification Description

UL 61800-5-1 Adjustable speed electrical power drive systems.

Part 5-1: Safety requirements - Electrical, thermal, and energy.

ISD 510 servo drive sizes 3 and 4:

MSD 510:

CE

2014/30/EU Electromagnetic Compatibility (EMC) Directive.

2014/35/EU Low Voltage Directive (LVD).

(2011/65/EU) amen-
ded (EU) 2015/863

Restriction of Hazardous Substances (RoHS).

2006/42/EC Machinery Directive (MD).

EtherCAT® Ethernet for Control Automation Technology. Ethernet-based fieldbus system.

Ethernet POWERLINK® Ethernet-based fieldbus system.

PROFINET RT/IRT® Ethernet-based fieldbus system.

PLCopen® Technical specification. Function blocks for motion control (formerly Part 1 and Part 2) Version 2.0 March
17, 2011.

1.5 Areas of Application

Potential areas of application are:

• Food and beverage machines

• Packaging machines

• Pharmaceutical machines

• Applications running with a group of servo drives

1.6 Software

Updates to the firmware, VLT® Servo Toolbox software, and PLC libraries may be available. When updates are available, they can be
downloaded from the danfoss.com website.

The VLT® Servo Toolbox software or the PLC libraries can be used to install the firmware on the servo drives or on the system modules.
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1.7 Terminology

Table 3: Terminology

Term Description

ACM 510 Auxiliary Capacitors Module

DAM 510 Decentral Access Module that connects the Danfoss decentral servo drives (ISD 510 and DSD 510) to
the servo system via a hybrid cable.

DSD 510 Decentral Servo Drive

DSD 510 system compo-
nents

Includes DSD 510 servo drives, PSM 510, DAM 510, and the optional ACM 510.

EXM 510 Extension module

Feed-in cable Hybrid cable for connection from the DAM 510 to the 1st servo drive.

ISD 510 Integrated Servo Drive

ISD 510 system components Includes ISD 510 servo drives, PSM 510, DAM 510, and the optional ACM 510.

LCP Local Control Panel

Loop cable Hybrid cable for connecting servo drives in daisy-chain format.

MSD 510 Multiaxis Servo Drive

MSD 510 system compo-
nents

Includes SDM 511/SDM 512, PSM 510, DAM 510, and the optional ACM 510.

PLC Programmable Logic Controller (external device for controlling the servo system).

PSM 510 Power Supply Module that generates a 565–680 V DC supply.

SDM 511 Servo Drive Module (single axis)

SDM 512 Servo Drive Module (double axis)

System modules Includes PSM 510, DAM 510, and the optional ACM 510.

VIN PSM Input of PSM 510 (V AC).

VOUT PSM Output of PSM 510 (V DC).
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2 Safety

2.1 Safety Symbols

The following symbols are used in this guide:

W A R N I N G
Indicates a potentially hazardous situation that could result in death or serious injury.

C A U T I O N
Indicates a potentially hazardous situation that could result in minor or moderate injury. It can also be used to alert against
unsafe practices.

N O T I C E
Indicates important information, including situations that can result in damage to equipment or property.

2.2 Safety Instructions and Precautions

Compliance with the safety instructions and precautions is necessary at all times.

• Orderly and proper transport, storage, fitting, and installation, as well as careful operation and maintenance, are essential for the
trouble-free and safe operation of the servo system and its components.

• Only suitably trained and qualified personnel may work on the MSD 510 system and its components or in its vicinity.

• Only use accessories and spare parts approved by Danfoss.

• Comply with the specified ambient conditions.

• The information in this manual about the use of available components is provided solely by way of examples of applications and
suggestions.

• The plant engineer or system engineer is personally responsible for checking the suitability of the supplied components and the
information provided in this manual for the specific application concerned:

- For compliance with the safety regulations and standards relevant to the specific application.

- For implementing the necessary measures, changes, and extensions.

• Commissioning the servo system or its components is not allowed until it has been ascertained that the machine, system, or plant
in which they are installed conforms to the statutory provisions, safety regulations, and standards that apply to the application in
the country of use.

• Operation is only allowed in compliance with the national EMC regulations for the application concerned.

• Compliance with the limit values specified by national regulations is the responsibility of the producer of the plant, system, or
machine.

• Compliance with the specifications, connection conditions, and installation conditions in this manual is mandatory.

• The safety regulations and safety provisions of the country in which the equipment is used must be observed.

• To protect the user against electrical shock and to protect the servo system against overload, protective grounding is obligatory
and must be performed in accordance with local and national regulations.

SafetyOperating Guide  | VLT® Multiaxis Servo Drive MSD 510 System

AQ262450196490en-000101 / 175R117018 | Danfoss A/S © 2019.10



2.2.1 Operational Safety

Operational safety

• Safety-related applications are only allowed if they are explicitly and unambiguously mentioned in this manual.

• All applications that can cause hazards to people or damage to property are safety-related applications.

• The stop functions implemented in the software of the PLC do not interrupt the mains supply to the Power Supply Module
(PSM 510). Therefore, they must not be used for electrical safety for the servo system.

• The servo system can be brought to a stop by a software command or a zero speed setpoint, however DC voltage remains present
on the servo drives and/or mains voltage in the PSM 510. Also, when the system is stopped, it may start up again on its own if the
circuitry is defective or after the elimination of a temporary overload, a problem with the supply voltage, or a problem with the
system. If personal safety considerations (for example, risk of personal injury caused by contact with moving machine parts after an
unintended start) make it necessary to ensure that an unintended start cannot occur, these stop functions are not sufficient. In this
case, ensure that the servo system is detached from the mains network, and prevent unintended motor starting, for example by
using the Safe Torque Off function.

• The servo system may start running unintentionally during parameter configuration or programming. If this poses a risk to
personal safety (for example, risk of personal injury due to contact with moving machine parts), prevent unintended motor
starting, for example by using the Safe Torque Off function, or by safe disconnection of the servo drives.

• In addition to the L1, L2, and L3 supply voltage inputs on the PSM 510, the servo system has other supply voltage inputs, including
external auxiliary voltage. Before commencing repair work, check that all supply voltage inputs have been switched off and that
the necessary discharge time for the DC-link capacitors has elapsed.

2.3 Important Safety Warnings

The following safety instructions and precautions relate to the VLT® Multiaxis Servo Drive MSD 510 system. Read the safety instructions
carefully before starting to work in any way with the servo system or its components. Pay particular attention to the safety instructions
in the relevant sections of this manual.

W A R N I N G
HAZARDOUS SITUATION

If the servo drive or the bus lines are incorrectly connected, there is a risk of death, serious injury, or damage to the unit.

- Always comply with the instructions in this manual and national and local safety regulations.

W A R N I N G
HIGH VOLTAGE

The MSD 510 system contains components that operate at high voltage when connected to the electrical supply network.
There are no indicators on the components that indicate the presence of mains supply. Incorrect installation, commissioning, or
maintenance may lead to death or serious injury.

- Installation, commissioning, and maintenance may only be performed by qualified personnel.

W A R N I N G
LEAKAGE/GROUNDING CURRENT HAZARD

Leakage/grounding currents are >3.5 mA. Improper grounding of the MSD 510 system modules may result in death or serious
injury.

- For reasons of operator safety, use a certified electrical installer to ground the system correctly in accordance with the
applicable local and national electrical standards and directives, and the instructions in this manual.
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W A R N I N G
DISCHARGE TIME

The MSD 510 system contains DC-link capacitors that remain charged for some time after the mains supply is switched off at
the Power Supply Module (PSM 510). Failure to wait the specified time after power has been removed before performing
service or repair work could result in death or serious injury.

- To avoid electrical shock, fully disconnect the Power Supply Module (PSM 510) from the mains and wait for the capacitors
to fully discharge before carrying out any maintenance or repair work on the servo system or its components.

Minimum waiting time (minutes)

15

D A N G E R

- Risque du choc électrique. Une tension dangereuse peut être présentée jusqu’à 15 min après avoir coupé l’alimentation.

W A R N I N G
UNINTENDED START

The MSD 510 system contains servo drives, the PSM 510, and DAM 510 that are connected to the electrical supply network and
can start running at any time. This may be caused by a fieldbus command, a reference signal, or clearing a fault condition. Servo
drives and all connected devices must be in good operating condition. A deficient operating condition may lead to death,
serious injury, damage to equipment, or other material damage when the unit is connected to the electrical supply network.

- Take suitable measures to prevent unintended starts.

W A R N I N G
UNINTENDED MOVEMENT

Unintended movement may occur when parameter changes are carried out immediately, which may result in death, serious
injury, or damage to equipment.

- When changing parameters, take suitable measures to ensure that unintended movement cannot pose any danger.

C A U T I O N
DANGER OF BURNS

The surface of the servo drives can reach high temperatures of over 90°C during operation.

- Do not touch the servo drives until they have cooled down.
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N O T I C E
RCD COMPATIBILITY

The MSD 510 system contains components that can cause a DC current in the protective earthing conductor, which may result
in malfunction in any devices connected to the system.

- Where a residual current-operated protective (RCD) or monitoring (RCM) device is used for protection in case of direct or
indirect contact, use a type B RCD or RCM device on the supply side of the MSD 510 system components.

2.4 Qualified Personnel

Installation, commissioning, and maintenance may only be carried out by qualified personnel. For the purposes of this manual and the
safety instructions in this manual, qualified personnel are trained personnel who are authorized to fit, install, commission, ground, and
label equipment, systems, and circuits in accordance with the standards for safety technology and who are familiar with the safety
concepts of automation engineering.

Additionally, the personnel must be familiar with all the instructions and safety measures described in this manual.They must have
suitable safety equipment and be trained in first aid.

2.5 Due Diligence

The operator and/or fabricator must ensure that:

• The servo system and its components are used only as intended.

• The components are operated only in a perfect operational condition.

• The operating instructions are always available near the servo system in complete and readable form.

• The servo system and its components are fitted, installed, commissioned, and maintained only by adequately qualified and
authorized personnel.

• These personnel are regularly instructed on all relevant matters of occupational safety and environmental protection, as well as the
contents of the operating instructions and the instructions it contains.

• The product markings and identification markings applied to the components, as well as safety and warning instructions, are not
removed and are always kept in a legible condition.

• The national and international regulations regarding the control of machinery and equipment, that are applicable at the place of
use of the servo system, are complied with.

• The users always have all current information relevant to their interests about the servo system and its use and operation.

2.6 Intended Use

The components of the MSD 510 system are intended to be installed in machines used in industrial environments in accordance with
local laws and standards.

N O T I C E

- In a domestic environment, this product may cause radio interferences, in which case supplementary mitigation measures
may be required.

To ensure that the product is used as intended, the following conditions must be fulfilled before use:
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• Everyone who uses Danfoss products in any manner must read and understand the corresponding safety regulations and the
description of the intended use.

• Do not alter hardware from its original state.

• Do not reverse-engineer software products or alter their source code.

• Do not install or operate damaged or faulty products.

• Ensure that the products are installed in conformance with the regulations mentioned in the documentation.

• Observe any specified maintenance and service intervals.

• Comply with all protective measures.

• Only fit or install the components described in this operating guide. Third-party devices and equipment may be used only in
consultation with Danfoss.

2.6.1 Prohibited Application Areas

The servo system may not be used in the following application areas:

• Areas with potentially explosive atmospheres.

• Mobile or portable systems.

• Floating or airborne systems.

• Inhabited facilities.

• Sites where radioactive materials are present.

• Areas with extreme temperature variations or in which the maximum rated temperatures may be exceeded.

• Under water.

2.7 Forseeable Misuse

Any use not expressly approved by Danfoss constitutes misuse. This also applies to failure to comply with the specified operating
conditions and applications. Danfoss assumes no liability of any sort for damage attributable to improper use.

2.8 Service and Support

Contact the local service representative for service and support.
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3 System Description

3.1 Overview of the VLT® Multiaxis Servo Drive System MSD 510

The VLT® Multiaxis Servo Drive System MSD 510 is a high-performance central servo motion solution. The open system supports the
real-time Ethernet protocols EtherCAT®, Ethernet POWERLINK®, and PROFINET®.
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PSM

SDM 511
          FS2

SDM 511
          FS1

SDM 512
          FS1

DAM 510
ACM 510

EXM 510

Illustration 3: MSD Modules

The system comprises:
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• Power Supply Module (PSM 510)

• Drive Modules:

- Single axis Servo Drive Module (SDM 511)

- Double axis Servo Drive Module (SDM 512)

• Decentral Access Module (DAM 510)

• Auxiliary Capacitors Module (ACM 510)

• Expansion Module (EXM 510)

• Software:

- Firmware for the servo drive modules (SDM 511 and SDM 512)

- Firmware for the Power Supply Module (PSM 510)

- Firmware for the Decentral Access Module (DAM 510)

- Firmware for the Auxiliary Capacitors Module (ACM 510)

- VLT® Servo Toolbox

- PLC libraries for AutomationStudio™, TwinCAT®, SIMOTION Scout, and TIA Portal.

Some modules are available in 2 enclosure (frame) sizes with widths of 50 mm (FS1) or 100 mm (FS2) depending on the power size.

Depending on the application, the system can be used exclusively in a central system, or together with Danfoss Decentral Servo Drives
(ISD 510 and DSD 510) in a mixed system. Use of an AC choke is mandatory.

The system modules PSM 510, DAM 510, ACM 510, and drive modules SDM 511/SDM 512 are mounted to a backplate located in the
control cabinet. DC-link and the control voltage supply are integrated in the backplate. The 'click and lock' backplate concept offers
easy mounting and installation.

N O T I C E

- The MSD 510 modules cannot be used in servo systems from other manufacturers. Drives from other manufacturers cannot
be used in the MSD 510 system.

- Contact Danfoss for further information.

N O T I C E

- The system modules have a protection rating of IP20 according to IEC/EN 60529 (except connectors, which are IP00). They
are only designed for use within a control cabinet. The system modules may be damaged if exposed to fluids.

3.1.1 Application Examples

There are numerous potential areas of application for the VLT® Multiaxis Servo Drive MSD 510 system as per the following examples.

Beverage machines

• Filling

• PET blow-moulding

Food and beverage packaging machines:
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• Flow wrapping

• Bag maker

• Tray sealing

• Shrink wrapping

Industrial and pharmaceutical packaging machines:

• Palletization

• Top loader

• Cartoning

• Tube filling

• Blister machine

• Liquid filling

• Solid dosing

3.1.2 Maximum Number of Modules

The maximum number of modules in the MSD 510 system is:

• PSM 510: 2 per system

• DAM 510: 3 per system (Depending on the system architecture it may be possible to add more. Contact Danfoss for further
information.)

• SDM 511/SDM 512: Depends on the current rating and output power of the servo drive modules and the AUX current consumption
during operation. Contact Danfoss for further information.

3.2 Power Supply Module PSM 510

3.2.1 Overview

PSM is the abbreviation for Power Supply Module. It is the power supply to the servo system. The PSM 510 supplies a DC power voltage
and guarantees high-density output. The DC-link and 24/48 V DC are distributed via the backlink in the backplates to all system
modules. The PSM 510 can be controlled via Ethernet-based fieldbus.

LEDs on the front of the PSM 510 show the operating status and warnings.

N O T I C E

- The MSD 510 system is designed for use within a control cabinet. If the STO function is used, the cabinet must be rated at
least IP54.

- The PSM 510 has a protection rating of IP20 according to IEC/EN 60529 (except connectors, which are IP00).

- The PSM 510 may be damaged if exposed to fluids.

All power cables are wired into the PSM 510, therefore at least 1 PSM 510 is required for each system.

The PSM 510 also performs service functions, such as voltage measuring, and is cooled by an internal fan.

The PSM 510 is available in 3 power sizes and delivers an output power of 10 kW, 20 kW, or 30 kW with 200% overload capacity for 3
seconds. Two PSM 510 modules can be used in parallel to achieve an output power of up to 60 kW.
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An example type code for the PSM 510 is: MSD510PSM510F2P10C0D6E20PLSXXXXXXXXXXXXX.
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1 Backplate

3 Cable relief and shielding

5 Operating LEDs

7 PE screw

9 Internal/external brake resistor connector

2 24/48 V input connector

4 Connectors: I/O, STO, relay, and Ethernet

6 LCP connector

8 AC mains supply connector

Illustration 4: PSM 510
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3.2.2 Connectors on the Top of PSM 510
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1 Ethernet connector IN

3 24/48 V IN connector

5 STO connector OUT

7 Relay connector

2 Ethernet connector OUT

4 STO connector IN

6 I/O connector

Illustration 5: Connectors on the Top of PSM 510

3.2.3 Connectors on the Bottom of PSM 510
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1 Holder for internal brake resistor connector when not in use

3 PE screws

2 AC mains supply connector

4 Internal/external brake resistor connector

Illustration 6: Connectors on the Bottom of PSM 510

3.3 Servo Drive Module SDM 511/SDM 512

3.3.1 Overview

SDM is the abbreviation for Servo Drive Module. The SDM 511 is a single axis servo drive available in 5 power sizes and 2 enclosure
sizes (FS1 is 50 mm and FS2 is 100 mm). The SDM 512 is a double axis servo drive available in 3 power sizes and 1 enclosure size (FS1,
50 mm). A double axis module operates 2 servo motors independently. Several feedback options are available. The SDMs are equipped
with digital I/Os and Safe Torque Off (STO) and support several motor feedback encoders.

System DescriptionOperating Guide  | VLT® Multiaxis Servo Drive MSD 510 System

AQ262450196490en-000101 / 175R1170| 27Danfoss A/S © 2019.10



N O T I C E

- The MSD 510 system is designed for use within a control cabinet. If the STO function is used, the cabinet must be rated at
least IP54.

- The SDMs have a protection rating of IP20 according to IEC/EN 60529 (except connectors, which are IP00).

- The SDMs may be damaged if exposed to fluids.
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SDM 512 Frame Size 1
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1 Connectors: I/O, STO, relay, Ethernet, and external encoder

3 LCP Connector

5 Connectors: Motor, motor feedback, thermistor, brake,
shielding, and cable relief

2 Operating LEDs

4 PE screws

Illustration 7: SDM 511/SDM 512 Modules

3.3.2 SDM 511/SDM 512 Types

N O T I C E

- The Drive Configurator shows the valid configuration of servo drive variants. Only valid combinations are shown. Therefore,
not all variants detailed in the type code are visible.
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Illustration 8: Type Code

Table 4: Legend to Type Code

[01–06] Product group [22–23] DC voltage [32–34] Firmware

MSD510 VLT® Multiaxis Servo Drive D6 600 V DC-link voltage SXX Standard

[07–12] Product variant [24–26] Drive enclosure SC0 Customized

SDM511 MSD 510 Servo Drive Module 511 E20 IP20 (1) [35] Safety

SDM512 MSD 510 Servo Drive Module 512 [27–29] Bus system T Safe torque off (STO)

[13–14] Drive variant FXX Without feedback (2) [36–40] Reserved

SA Single axis servo drive FRX Resolver XXXXX Reserved

DA Double axis servo drive FS1 BiSS ST feedback, 17 bit

[15–16] Enclosure (frame) size FM1 BiSS MT feedback, 17 bit

F1 Enclosure (frame) size 1, 50 mm FE1 EnDat 2.1

F2 Enclosure (frame) size 2, 100 mm FE2 EnDat 2.2

[17–21] Current rating FHF HIPERFACE® (2)

C02A5 2.5 Arms FHD HIPERFACE® DSL (2)

C005A 5 Arms [30–31] Bus system

C010A 10 Arms PL POWERLINK

C020A 20 Arms EC EtherCAT

C040A 40 Arms PN PROFINET

1 IP20 according to IEC/EN 60529 (except connectors, which are IP00)
2 In preparation

3.3.3 Components

3.3.3.1 Cooling

The Servo Drive Modules SDM 511 and SDM 512 are cooled by a speed-controlled internal fan.

3.3.4 Connectors on SDM 511

This section details all connectors on the SDM 511 in enclosure sizes 1 (FS1, 50 mm) and 2 (FS2, 100 mm).
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3.3.4.1 Connectors on the Top of SDM 511
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1 External encoder connector

3 Ethernet connector OUT

5 STO connector IN

7 Relay connector

2 Ethernet connector IN

4 I/O connector

6 STO connector OUT

Illustration 9: SDM 511, Enclosure Size 1 (FS1)
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1 External encoder connector

3 Ethernet connector OUT

5 STO connector IN

7 Relay connector

2 Ethernet connector IN

4 I/O connector

6 STO connector OUT

Illustration 10: SDM 511, Enclosure Size 2 (FS2)

3.3.4.2 Connectors on the Bottom of SDM 511
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1 Motor feedback connector 2 Motor brake and thermistor connector
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3 Motor connector

Illustration 11: SDM 511, Enclosure Size 1 (FS1)
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1 Motor feedback connector

3 Motor connector

2 Motor brake and thermistor connector

Illustration 12: SDM 511, Enclosure Size 2 (FS2)

3.3.5 Connectors on SDM 512

This section details all connectors on SDM 512 in enclosure size 1 (FS1, 50 mm).

3.3.5.1 Connectors on the Top of SDM 512
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67891011121314

1 External encoder connector SDM1

3 Ethernet connector OUT SDM1

5 I/O connector SDM2

7 STO connector IN SDM2

9 STO connector OUT SDM2

11 Ethernet connector OUT SDM2

13 Ethernet connector IN SDM2

2 Ethernet connector IN SDM1

4 I/O connector SDM1

6 STO connector IN SDM1

8 STO connector OUT SDM1

10 Relay connector SDM1

12 Relay connector SDM2

14 External encoder connector SDM2

Illustration 13: SDM 512, Enclosure Size 1 (FS1)
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3.3.5.2 Connectors on the Bottom of SDM 512
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1 Motor feedback connector SDM2

3 Motor brake and thermistor connector SDM1

5 Motor brake and thermistor connector SDM2

2 Motor feedback connector SDM1

4 Motor connector SDM1

6 Motor connector SDM2

Illustration 14: SDM 512, Enclosure Size 1 (FS1)

3.4 Decentral Access Module DAM 510

3.4.1 Overview

DAM is the abbreviation for Decentral Access Module. The DAM 510 is a central interface/gateway to the decentral servo system. It is
used to connect the Danfoss VLT® Integrated Servo Drives ISD 510 and VLT® Decentral Servo Drives DSD 510 to the servo system via a
hybrid feed-in cable.

The DAM 510 supplies the decentral servo drives with DC-link, UAUX, STO, and the Ethernet-based fieldbus via the hybrid feed-in cable.
The DAM 510 provides functions, such as:

• Overcurrent protection of the hybrid cable

• Overvoltage protection

• Charging circuit of the DC-link

• External encoder connection

• DC-link capacitance buffer for the decentral servo drives

The DAM 510 can be controlled via Ethernet-based fieldbus.

LEDs on the front of the DAM 510 show the operating status and warnings.

N O T I C E

- The MSD 510 system is designed for use within a control cabinet. If the STO function is used, the cabinet must be rated at
least IP54.

- The DAM 510 has a protection rating of IP20 according to IEC/EN 60529 (except connectors, which are IP00).

- The DAM 510 can be damaged if exposed to fluids.

An example type code for the DAM 510 is: MSD510DAM510F1C015AD6E20PLSXXXXXXXXXXXXX.
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Illustration 15: DAM 510

3.4.2 Connectors on the Top of DAM 510
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5 External encoder connector

Illustration 16: Connectors on the Top of DAM 510

3.4.3 Connectors on the Bottom of DAM 510
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Illustration 17: Connectors on the Bottom of DAM 510

3.5 Auxiliary Capacitors Module ACM 510

3.5.1 Overview

ACM is the abbreviation for Auxiliary Capacitors Module. The ACM 510 can be connected to the MSD 510 system to store energy,
enabling a controlled machine stop in emergency situations.

N O T I C E

- The MSD 510 system is designed for use within a control cabinet. If the STO function is used, the cabinet must be rated at
least IP54.

- The ACM 510 has a protection rating of IP20 according to IEC/EN 60529 (except connectors, which are IP00).

- The ACM 510 can be damaged if exposed to fluids.

An example type code for the ACM 510 is: MSD510ACM510F1E00C8D6E20PLSXXXXXXXXXXXXX.
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Illustration 18: ACM 510

3.5.2 Connectors on the Top of ACM 510
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Illustration 19: Connectors on the Top of ACM 510
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3.6 Expansion Module EXM 510

e3
0b

h6
60

.1
0

2

3

4

1

1 EMC Shielding Plate

3 PE screw
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4 Expansion connector

Illustration 20: EXM 510

N O T I C E

- The MSD 510 system is designed for use within a control cabinet. If the STO function is used, the cabinet must be rated at
least IP54.

- The EXM 510 has a protection rating of IP20 according to IEC/EN 60529 (except connectors, which are IP00).

- The EXM 510 may be damaged if exposed to fluids.

An example type code for the EXM 510 is:
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MSD510EXM510F1C062AD6E20XXXXXXXXXXXXXXXX

3.7 Local Control Panel (LCP)

3.7.1 Overview of the Local Control Panel

The LCP is the graphical user interface for diagnostic and operating purposes. It is available as an option and can be connected to the
system modules using an optional cable (M8 to LCP SUB-D extension cable).

The LCP display provides the operator with a quick view of the state of the system modules, depending on which device it is connected
to. The display shows parameters and alarms/errors and can be used for commissioning and troubleshooting.

It can also be used to perform simple functions, for example activating and deactivating the output lines on the DAM 510 and opening
the mechanical brake on the SDM 511/512.

The LCP can be mounted on the front of the control cabinet using a mounting set (available as an accessory) and then connected to
the modules via M8 to SUB-D cables (available as an accessory). See the VLT® Servo Drive System ISD 510, DSD 510, MSD 510
Design Guide for accessory order numbers.

N O T I C E

- Further information on the LCP functions can be found in the VLT® Servo Drive System ISD 510, DSD 510, MSD 510
Programming Guide.

3.7.2 Layout of the Local Control Panel

The local control panel is divided into 4 functional groups:

• A: Display area

• B: Display menu keys

• C: Navigation keys and indicator lights (LEDs)

• D: Operation keys and reset

To adjust the display contrast, press [Status] and the [▵]/[▿] keys.

3.7.2.1 A: Display Area

The values in the display area differ depending on which module the LCP is connected to.

The display area is activated when the module it is connected to received power from UAUX.
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Illustration 21: Display Area when Connected to the Power Supply Module PSM 510 or Decentral Access Module DAM 510
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Illustration 23: Display Area when Connected to the Auxiliary Capacitors Module ACM 510

3.7.2.2 B: Display menu keys

Menu keys are used for menu access for parameter set-up, toggling through status display modes during normal operation, and
viewing fault log data.

Table 5: Display Menu Keys

Key Function

6 Status Shows operational information.

7 Quick Menu Allows access to parameters.

8 Main Menu Allows access to parameters.

9 Alarm Log Shows the last 10 alarms.
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3.7.2.3 C: Navigation keys and indicator lights (LEDs)

Navigation keys are used for moving the display cursor and provide operation control in local operation. There are also 3 status LEDs in
this area.

Table 6: Navigation Keys

Key Function

10 Back Reverts to the previous step or list in the menu structure.

11 Cancel Cancels the last change or command as long as the display mode is not changed.

12 Info Press for a definition of the function being shown.

13 Navigation keys Use the 4 navigation keys to move between items in the menu.

14 OK Use to access parameter groups or to enable a selection.

Table 7: Indicator Lights (LEDs)

LED Color Function

15 On Green The On LED activates when the module it is connected to receives power from UAUX..

16 Warn Yellow When warning conditions are met, the yellow Warn LED activated and text appears in the display area
identifying the problem.

17 Alarm Red A fault condition causes the red Alarm LED to flash and an alarm text is shown.

3.7.2.4 D: Operation keys and reset

The operation keys are located at the bottom of the LCP.

Table 8: Operation Keys and Reset

Key Function

18 Hand On Enables the connected MSD 510 modules to be controlled via the LCP.

Switching between Hand On and Auto On modes is only possible in certain states (see the VLT® Servo Drive Sys‐
tem ISD 510, DSD 510, MSD 510 Programming Guide for further information).

19 Off Puts the servo drive module (SDM 511/512) into state Switch on Disabled and the other system modules into state
Standby.

This only works in Hand On mode.

Off mode enables transition from Hand On mode to Auto On mode.

20 Auto On Puts the system in remote operational mode.

In Auto On mode, the device is controlled by fieldbus (PLC). Switching between Auto On and Hand On modes is
only possible when the servo drive module is in state Switch on Disabled and/or the PSM 510, DAM 510 or
ACM 510 is in state Standby.

21 Reset Resets the MSD 510 system module after a fault has been cleared.

The reset is only possible when in Hand On mode.
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3.8 Cables

3.8.1 Hybrid Cable

Pre-configured hybrid cables are used to connect the decentral servo drives (when used) to the Decentral Access Module (DAM 510).

There are 2 types of hybrid cables that are available with both angled and straight M23 connectors:

• Feed-in cable for connecting the 1st ISD 510/DSD 510 servo drive of a group to the connection point on the Decentral Access
Module (DAM 510).

• Loop cable for connecting the ISD 510/DSD 510 servo drives in daisy-chain format in an application.

Both these cables are provided by Danfoss and are available in various lengths. See the VLT™ Servo Drive System ISD 510, DSD 510,
MSD 510 Design Guide for further information.

Both ends of the loop cable are fitted with M23 connectors.

The feed-in cable is fitted with an M23 connector at the output end for connection to the 1st ISD 510/DSD 510 servo drive. At the input
end it is pigtailed and the connectors are mounted on the corresponding terminals on the Decentral Access Module (DAM 510).

Table 9: Hybrid Cables

Cable type Shielded/unshielded Notes

Feed-in cable Shielded Hybrid cable (overall shield with additional fieldbus and safety section shield).

Loop cable

N O T I C E

- Hybrid cables are available in 2 cross-sections: 2.5 mm2 (15 A) and 4 mm2 (25 A). See the VLT® Servo Drive System ISD 510,
DSD 510, MSD 510 Design Guide for further information.

N O T I C E
Minimum bending radius

- The maximal number of bending cycles is 5 million at 7.5 x cable diameter (15.6 mm).

- Permanently flexible: 12 x cable diameter.

- Permanently installed: 5 x cable diameter.

3.8.2 Ethernet Cable

Table 10: Ethernet Cable Recommendations

Specification

Ethernet standard Standard Ethernet (in accordance with IEEE 802.3), 100Base-TX (Fast Ethernet)

Cable type S/FTP (shielded foiled twisted pair), ISO (IEC 11801 or EN 50173), CAT 5e or 6
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Specification

Damping 23.2 dB (at 100 Mhz and 100 m each)

Crosstalk damping 24 dB (at 100 Mhz and 100 m each)

Return loss 10 dB (100 m each)

Surge impedance 100 Ω

Maximum cable length 100 m between switches or network devices

N O T I C E

- Ground the Ethernet cable through the RJ45 connector. Do not ground it on the strain relief.

3.8.3 LCP Cable

The LCP cable is used to connect an LCP to a system module via the M8 connector on the front of each system module.

The LCP cable can be purchased from Danfoss (see the VLT® Servo Drive System ISD 510, DSD 510, MSD 510 Design Guide for further
information).

3.9 Cable Layout and Routing

The MSD 510 modules are connected via the backlink connector (see 11.7.1 Backlink Connector).

Connect the real-time Ethernet fieldbus to the 1st module in the MSD 510 system using a standard Ethernet cable (not provided).

Use the Ethernet loop cables provided by Danfoss to connect to the other modules in daisy-chain format.

3.9.1 Maximum Cable Lengths

Table 11: Maximum Cable Lengths

Cable type Specification Maximum Length

Hybrid cable M23 Feed-in 40 m

M23 Loop 25 m

Fieldbus extension Length: 2 m

Maximum length to next port: 100 m

Maximum cable length per line 100 m

Motor cable – Maximum length without additional output filter or choke: 30 m

Maximum length with additional output filter or choke: 80 m

Feedback cable – 80 m

Expansion module cable – 5 m
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3.9.2 Wiring of Output Filter
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Illustration 24: Wiring Diagram of Output Filter

3.9.3 Standard Cabling Concept for 2 Decentral Access Modules (DAM 510)

In this example, a hybrid feed-in cable with quick-release connectors provides the supply voltage from the DAM 510 to the 1st ISD 510/
DSD 510 servo drive.
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Illustration 25: Standard Cabling Concept for 2 Decentral Access Modules (DAM 510)

3.10 Software

The software for the servo system comprises:
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• The firmware of the system modules that is already installed on the modules.

• A package of PLC libraries for Automation Studio™ for operating the MSD 510 devices (see 6.11.2 Creating an Automation Studio™
Project for further information).

• A PLC library for TwinCAT® 2 for operating the MSD 510 devices (see 6.12.2 Creating a TwinCAT® Project for further information).

• A PLC library for SIMOTION SCOUT for operating the MSD 510 devices (see 6.14.3 Creating a SIMOTION SCOUT® Project).

• A PLC library for TIA Portal for operating the MSD 510 devices.

• VLT® Servo Toolbox: A Danfoss PC-based software tool for commissioning and debugging the devices.

3.11 Fieldbus

The servo system has an open system architecture realized by fast Ethernet (100BASE-T) based communication. The system supports
EtherCAT®, Ethernet POWERLINK®, and PROFINET® fieldbuses. See the VLT™ Servo Drive System ISD 510, DSD 510, MSD 510,
Programming Guide for further information.

In productive environments, communication to the devices always takes place via a PLC that acts as a master. The ISD 510/DSD 510
servo drives, the servo drive modules SDM 511/SDM 512, and the system modules can be controlled by these communication
methods:

• Using the VLT® Servo Motion libraries (available for TwinCAT®, Automation Studio™ and SIMOTION SCOUT®, and TiA Portal).

• Using the NC axis functionality of TwinCAT® (ISD 510/DSD 510 and SDM 511/SDM 512 only).

• Using the CANopen® CiA DS 402 standard by reading and writing to objects.

• Using application class 1 (AC1), PROFINET® only.

The ISD 510/DSD 510 servo drives, the servo drive modules SDM 511/SDM 512,and the system modules can be operated with the
following cycle times.

• EtherCAT® and Ethernet POWERLINK® fieldbuses:

- 400 µs and multiples of it (for example, 800 µs and 1200 µs).

- 500 µs and multiples of it (for example, 1 ms).

• PROFINET® fieldbus

- 500 µs and multiples of it (for example, 1 ms).

When the cycle time is a multiple of 400 µs and 500 µs, the time base of 500 µs is used.

The ISD 510/DSD 510 servo drives, the servo drive modules SDM 511/SDM 512, and the system modules are certified for fieldbuses
according to the corresponding rules and regulations. The servo drives conform to the CANopen® CiA DS 402 Drive Profile.

3.11.1 EtherCAT®

The ISD 510/DSD 510 servo drives, servo drive modules SDM 511/SDM 512, and the system modules support the following EtherCAT®

protocols:

• CANopen over EtherCAT® (CoE)

• File Access over EtherCAT® (FoE)

• Ethernet over EtherCAT® (EoE)
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The ISD 510/DSD 510 servo drives, servo drive modules SDM 511/SDM 512, and the system modules support distributed clocks. To
compensate for the failure of a communication cable section in the system, cable redundancy is available for all fieldbuses. See the
VLT® Servo Drive System ISD 510, DSD 510, MSD 510 System Design Guide for further information.
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Illustration 26: EtherCAT™ Port Assignment for the ISD 510/DSD 510 Servo Drive
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Illustration 27: EtherCAT™ Port Assignment for the Decentral Access Module (DAM 510)

System DescriptionOperating Guide  | VLT® Multiaxis Servo Drive MSD 510 System

AQ262450196490en-000101 / 175R117046 | Danfoss A/S © 2019.10



 
 

X1 X2

ESC
PSM/ACM/SDM

EtherCAT®
slave

 IN
LA

N
 1

 O
U

T
LA

N
 2

e3
0b

g7
97

.1
0

X1 RJ45 cable connector to the PLC or previous slave. X2 RJ45 cable connector to the PLC (cable redundancy) or next
slave.

Illustration 28: EtherCAT™ Port Assignment for the Power Supply Module (PSM 510), Servo Drive Module SDM 511/SDM 512, and Auxiliary
Capacitors Module (ACM 510)

3.11.2 Ethernet POWERLINK®

The ISD 510/DSD 510 servo drives, servo drive modules SDM 511/SDM 512, and the system modules are certified according to DS 301
V1.1.0 and support the following features:

• Work as controlled node.

• Can be operated as multiplexed stations.

• Support of cross-communication.

• Ring redundancy is supported for media redundancy.

Specific ports are not assigned for Ethernet POWERLINK®.

3.11.3 PROFINET®

The ISD 510/DSD 510 servo drive, servo drive modules SDM 511/SDM 512, and system modules support PROFINET® conformance class
C as per IEC 61158-5-10:2014, IEC 61158-6-10:2014, IEC 61784-2:2014, and IEC 61784-5-3:2013. All the system components (servo drives
and system modules) act as I/O devices in a PROFINET® network.

The following features are supported:

• I/O-Device - Device that is being controlled by I/O-Controller

• Dynamic module configuration

• Net load class III

• Ring redundancy (MRPD) as client

PROFINET® fieldbus devices are always connected as network components via switches that are integrated in the fieldbus device. There
are 2 ports on the ISD 510/DSD 510 servo drives, servo drive modules SDM 511/SDM 512, the PSM 510, and the ACM 510). There are 3
ports on the DAM 510.
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4 Mechanical Installation

4.1 Items Supplied

Depending on the application, the items supplied for the MSD 510 system are:

• VLT® Power Supply Module (PSM 510)

• VLT® Single axis Servo Drive Module (SDM 511)

• VLT® Double axis Servo Drive Module (SDM 512)

• VLT® Decentral Access Module (DAM 510)

• VLT® Auxiliary Capacitors Module (ACM 510)

• VLT® Expansion Module (EXM 510)

• AC choke

• This operating guide

• Feed-in (hybrid) cable

• Loop (hybrid) cable

N O T I C E

- The hybrid feed-in and loop cables are required when ISD510/DSD510 servo drives are used in the servo system.

The packaging unit depends on the number of modules delivered. Save the packaging for use in the event of product return.

4.2 Transport

• Always use means of transport and lifting gear with sufficient load capacity to transport the servo system components.

• Avoid vibration during transport.

• Avoid heavy impacts and blows.

4.3 Inspection on Receipt

Procedure

1. After receiving the delivery, immediately check whether the items supplied match the shipping documents. Danfoss does not
honor claims for faults registered later.

2. Register a complaint immediately with the carrier if there is visible transport damage.

3. Register a complaint immediately with the responsible Danfoss representative if there are visible defects or the delivery is
incomplete.

4.4 Safety Measures during Installation

Always observe the safety instructions in this manual during installation. Pay particular attention to ensuring that the following points
are always observed:
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• Installation may only be performed by qualified personnel.

• Installation must be performed with due care and attention.

• All safety regulations and protective measures must be complied with, and the environmental conditions must be observed.

• The manual is read and understood.

4.5 Installation Environment

4.5.1 System Components

The environmental conditions for the MSD 510 system components are:

• The allowable operating ambient temperature range and vibration levels must not be exceeded (see 11.8 General Specifications
and Environmental Conditions for MSD 510 System).

• The allowable relative humidity range is 5–93%, non-condensing.

• The minimum space required above and below the system modules is detailed in 4.7.1 Space Requirements for System Modules.

4.6 Preparation for Installation

4.6.1 System Modules

Context:

Make the following preparations to ensure that the servo system can be installed reliably and effectively.

Always fit the system modules in accordance with local regulations.

Procedure

1. Provide a suitable mounting arrangement for the application. This depends on the type and weight of the modules.

2. To avoid misalignment, ensure that the backplates are perfectly level.

3. To ensure sufficient cooling, pay attention to the specified minimum space requirements.

4. Ground the modules.
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4.6.2 Drilling Templates
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Illustration 29: Drilling templates for 50 mm and 100 mm System Modules

4.7 Installation Procedure

4.7.1 Space Requirements for System Modules

The modules can be mounted next to each other but require a minimum space at the top and bottom for cooling.
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Illustration 30: Minimum Space Required at the Top and Bottom
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Illustration 31: Minimum Space Required at the Sides

4.7.2 Installation Aids and Tools Required

For installation of the MSD 510 system modules, the tools corresponding to the fixings screws (not included) are required.

4.7.3 Fitting Instructions for System Modules

Context:

N O T I C E

- Mount the MSD 510system component with the highest output power next to the PSM 510. Mount the remaining system
components in descending order of output power.
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Procedure

1. Drill the holes for mounting the backplate as per the drilling template (see 4.6.2 Drilling Templates).

2. Connect the backplates via the click and lock method.
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Illustration 32: Connecting the Backplates

3. Mount the backplates to the mounting plate in the control cabinet using M5 screws with a minimum head diameter or washer
diameter of 9.5 mm. The tightening torque is 3 Nm.
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Illustration 33: Mounting the Backplates in the Control Cabinet

4. Slide the module onto the carrier at the bottom of the backplate.

5. Press the 1st module onto the backlink connector at the top of the backplate.
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Illustration 34: Pressing the Module onto the Backlink Connector

6. To secure the module, pull down the holding clamp ([1] in illustration 35) at the top of the backplate.
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Illustration 35: Pulling Down the Holding Clamp at the Top of the Backplate

7. Repeat steps 4, 5, and 6 for the remaining modules, ensuring that the lip at the left side of the 2nd module is inside the guiding
groove at the right side of the 1st module (([1] in illustration 36).
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Illustration 36: Guiding Groove
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5 Electrical Installation

5.1 Warnings for Electrical Installation

During electrical installation, observe the relevant local and national regulations in addition to the information in this manual.

W A R N I N G
LEAKAGE/GROUNDING CURRENT HAZARD

Leakage/grounding currents are >3.5 mA. Improper grounding of the MSD 510 system modules may result in death or serious
injury.

- For reasons of operator safety, use a certified electrical installer to ground the system correctly in accordance with the
applicable local and national electrical standards and directives, and the instructions in this manual.

W A R N I N G
HIGH VOLTAGE

The MSD 510 system contains components that operate at high voltage when connected to the electrical supply network.
There are no indicators on the components that indicate the presence of mains supply. Incorrect installation, commissioning, or
maintenance may lead to death or serious injury.

- Installation, commissioning, and maintenance may only be performed by qualified personnel.

W A R N I N G
HIGH VOLTAGE

Potentially lethal voltage is present on the connectors that may lead to death or serious injury.

- Before working on the power connectors (disconnecting or connecting the cable), disconnect the PSM 510 from the mains
and wait for the discharge time to elapse.

5.2 Electrical Environmental Conditions

Compliance with the following electrical environmental conditions is necessary to enable safe and effective operation of the servo
system:

• Only for use in TN-S, TN-C, TN-CS, TT (not corner earthed) supply earthing system

• Prospective short-circuit current: 5 kA

• Protective class I

• Grounded 3-phase mains network, 400–480 V AC ±10%

• 3-phase frequency 44–66 Hz

• 3-phase lines and PE line

• External supply for auxiliary voltage, 24–48 V DC (PELV)

• AC choke (see 5.9.1 AC Line Choke)

• Observe the national statutory provisions.

• The leakage current is >3.5 mA.
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N O T I C E
RCD COMPATIBILITY

The MSD 510 system contains components that can cause a DC current in the protective earthing conductor, which may result
in malfunction in any devices connected to the system.

- Where a residual current-operated protective (RCD) or monitoring (RCM) device is used for protection in case of direct or
indirect contact, use a type B RCD or RCM device on the supply side of the MSD 510 system components.

N O T I C E

- All modules must be mounted in a control cabinet.

5.3 Grounding

5.3.1 Grounding for Electrical Safety

e3
0b

h3
91

.1
0

Illustration 37: Grounding for Electrical Safety
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• Ground the ISD 510/DSD 510 servo drives with the PE wire of the feed-in cable. There is a dedicated PE screw on the front and
another on the back of the DSD 510 servo drive.

• Ensure that the machine frame has a proper electrical connection to the flange of the servo drive. Use the front side flange surface.
Ensure PE connection on that part of the machine.

• To comply with CE requirements, ensure a minimum ground wire cross-section of at least 16 mm2 (minimum 70 °C, Cu).
To comply with UL requirements, ensure a minimum ground wire cross-section of at least 6 AWG (minimum 60 °C, Cu).
If a PSM 510 module with 10 kW is used, the cable cross-section can be reduced to:

- 10 mm2 (minimum 70 °C, Cu) to comply with CE requirements

- 8 AWG (minimum 60 °C, Cu) to comply with UL requirements

• Do not ground the MSD 510 system components in daisy-chain format. Use the grounding method depicted in illustration 37.

• Keep the ground wire connections as short as possible.

• Follow the wiring requirements in this manual.
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5.3.2 Grounding for EMC-Compliant Installation

• Establish electrical contact between the cable shield and the enclosure using the I/O shielding plate on each module.
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2 Cable tie

Illustration 38: Cable Shielding on the Top of the System Components

1

2

3

e3
0b

h3
43

.1
0

1 Cable tie

3 PE screw

2 EMC metal shielding plate

Illustration 39: Cable Shielding on the Bottom of the System Components

• Use a cable with a shielding that has a high-coverage to reduce electrical interference.

• Do not use pigtails to connect the shielding. A 360° wire connection is recommended.
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N O T I C E
POTENTIAL EQUALIZATION

- There is a risk of electrical interference when the ground potential between the servo system and the machine is different.
Install equalizing cables between them. The recommended cable cross-section is 16 mm2.

N O T I C E
EMC INTERFERENCE

- Use shielded cables for control wiring and separate cables for power and control wiring. Failure to isolate power and
control wiring can result in unintended behavior or reduced performance.

- Ensure a minimum clearance of 200 mm between signal and power cables.

- Only cross cables at 90°.

5.4 Mains Supply Requirements

Ensure that the supply has the following properties:

• TN-S, TN-C, TN-CS, TT (not corner earthed) supply earthing system.

• Prospective short-circuit current: 5 kA.

• Protective class I.

• Grounded 3-phase mains network, 400–480 V AC ±10%.

• 3-phase lines and PE line.

• 3-phase frequency: 44–66 Hz

• Maximum input current for 1 PSM 510 at 30 kW: 55 Arms

5.4.1 Fuses

N O T I C E

- Use fuses on the supply side of the Power Supply Module PSM 510 that comply with CE and UL requirements (see table 12).

- When 2 PSM 510 modules are used, each PSM 510 must have its own dedicated set of fuses.

Table 12: Fuses

Model and power rating CE Compliance (IEC 60364) UL Compliance (NEC 2014)

Maximum fuse type Maximum fuse type

PSM 510 (10 kW) gG 25 A 30 A (class T or J only)

PSM 510 (20 kW) gG 50 A 50 A (class T or J only)

PSM 510 (30 kW) gG 63 A 80 A (class T or J only)
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5.4.2 Circuit Breakers

Use a type B or type C circuit breaker with a capacity of 1.5 times the rated current of PSM 510 to fulfill CE requirements.

N O T I C E

- Circuit breakers are not allowed in installations where C-UL is required. Only UL recommended fuses are allowed.

5.5 Auxiliary Supply Requirements

Supply the PSM 510 with a power supply unit with an output of 24/48 V DC ±10% (PELV) and maximum 50 A (the actual current
depends on the modules used). The output required depends on the system topology. The output ripple of the power supply unit
must be <250 mVpp.

Refer to the VLT® Servo Drive System ISD 510, DSD 510, MSD 510 Design Guide for power rating shell diagrams.

N O T I C E

- Only use supply units that conform to the PELV specification.

- Use a supply that is CE-marked according to the standards EN 61000-6-2 and EN 61000-6-4 or similar for industrial use.

- The secondary circuit must be supplied from an external isolated source.

The 24/48 V DC external supply for auxiliary voltage must be dedicated to the MSD 510 system, meaning that the supply is used
exclusively for powering the PSM 510. The maximum cable length between the supply and the PSM 510 is 3 m.

5.5.1 Fuses

UL listed fuses are recommended to protect the wiring on 24–48 V DC.

Table 13: Fuses

CE Compliance (IEC 60364) UL Compliance (NEC 2014)

Maximum fuse type Maximum fuse type

50 A (1) 63 A (2)

1 If the maximum current is lower, a fuse with lower current rating can be used. Rating of IEC fuses: according to 100% of maximum current. Use a time delay fuse rated according to

the DC voltage used.
2 If the maximum current is lower, a fuse with lower current rating can be used. Rating of UL fuses: according to 125% of maximum current. Use a time delay fuse rated according to

the DC voltage used.

5.6 Safety Supply Requirements

Supply the STO line with a 24 V DC supply for industrial use with the following properties:
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• Output range: 24 V DC ±10%

• Maximum current: 1 A

Use a 24 V supply unit that is CE marked for industrial use. Ensure that the supply fulfills the PELV specification and is only used for the
system safety input.

A common supply for auxiliary and safety supply can be used, provided the only connection point of the 2 circuits is near to the supply.
This is intended to avoid interference due to a common voltage drop. The maximum cable length between the 24 V supply unit and
the servo system is 3 m.

The safety supply can be looped from PSM 510 to the other MSD 510 system components except for ACM 510, which does not have an
STO connection. The cable for this is not provided. For further information, see 8.6 Installation.

N O T I C E

- Ensure reinforced isolation between safety signals and other signals, supplies (mains supply), and exposed conductive
parts.

5.7 UL Requirements

N O T I C E

- Integral solid-state short-circuit protection does not provide branch circuit protection. Branch circuit protection must be
provided in accordance with the National Electrical Code/Canadian Electrical Code, and any additional local codes or
equivalent.

- Suitable for use on a circuit capable of delivering not more than 5000 rms symmetrical amperes, 480 V maximum when
protected by maximum 80 A class J or T fuses.

- To meet the UL (Underwriters Laboratories) regulations, use a UL-approved copper cable with a minimum heat-resistance
of 60 °C. Use Class 1 wire only. For PSM 510 rated 30 kW, use a maximum heat resistance of 75 °C.

- Control Circuit Overcurrent Protection is required.
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5.8 Connecting the Servo Drive Module SDM 511/SDM 512

5.8.1 Connecting the Motor Cable

Context:
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Illustration 40: Motor Cable for 50 mm Wide Servo Drive Modules
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Illustration 41: Motor Cable for 100 mm Wide Servo Drive Modules
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Illustration 42: Connecting the Motor Cable on 50 mm Wide Servo Drive Modules
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Illustration 43: Connecting the Motor Cable on 100 mm Wide Servo Drive Modules

Procedure

1. Insert the wires into the motor connector.

2. Insert the motor connector [1].

3. Secure and shield the motor cable using the cable tie [2].
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5.8.2 Connecting the Brake/Thermistor Cable

Context:
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Illustration 44: Brake/Thermistor Cable
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Illustration 45: Connecting the Brake/Thermistor Cable

N O T I C E

- Use a motor with reinforced insulation between the thermistor and the motor windings (tested with 4300 V DC and
8000 Vpeak impulse).
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Procedure

1. Insert the wires into the brake/thermistor connector.

2. Plug the brake/thermistor connector [2] into the servo drive module SDM 511/SDM 512.

3. Secure the brake/thermistor cable using the cable tie [3].

4. Tighten the EMC plate screw [5]. The tightening torque is 3 Nm.

5. Plug the motor feedback connector (SUB-D, 26 pin) into the servo drive module.

6. Connect the servo drive module SDM 511/SDM 512 to PE by connecting a PE wire to the PE screw on the front side of the module
[1]. The tightening torque is 3 Nm.

5.8.3 Connecting the Cables on the Top of the Servo Drive Modules SDM 511/SDM 512

Context:
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7 Relay connector (REL SDM 511/512)

2 Ethernet connector IN (X1 IN)

4 I/O connector (I/O SDM 511/512)

6 STO connector OUT (STO SDM 511/512)

Illustration 46: Connectors on the Top of SDM 511/SDM 512 (Example)

Procedure

1. Connect the Ethernet cable from the output of the previous module to the input connector [2].

2. Insert the wires from the STO output of the previous module into the 24 V IN (STO input) connector.

3. Insert the 24 V IN (STO input) connector [5] into the SDM 511/SDM 512.

4. If required, insert the external encoder connector [1].

5. If I/Os are required, insert the wires into the I/O connector and insert the connector [4].

6. If a relay is required, insert the wires into the relay connector and insert the connector [7].
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5.9 Connecting the Power Supply Module PSM 510

5.9.1 AC Line Choke

It is mandatory to use a 3-phase AC line choke (see 5.9.1.1 Connecting 1 PSM 510 to the AC Choke and 5.9.1.2 Connecting 2 PSM 510
Modules to the AC Choke).

Table 14: Line Choke Characteristics for 1 PSM 510

Model Minimum Irms [A] Urms [V] Inductance [mH]

PSM 510 (10 kW) 20 500 Minimum: 0.47

Maximum: 1.47

PSM 510 (20 kW) 40 500 Minimum: 0.47

Maximum: 1.47

PSM 510 (30 kW) 60 500 0.47 ±10%

If 2 PSM 510 modules are installed in parallel, use an AC choke as specified in table 15. See 5.9.1.2 Connecting 2 PSM 510 Modules to
the AC Choke for further information.

Table 15: Line Choke Characteristics for 2 PSM 510 installed in parallel

Model Minimum Irms [A] Urms [V] Inductance [mH]

PSM 510 (2 x 30 kW) 125 500 0.24 ±10%

Danfoss recommends mounting the AC line choke close to the PSM 510.

The maximum cable length depends on the cross-section, and the required voltage and current at the DC-link.

If the AC line chokes are mounted away from the PSM 510, the maximum cable distance is 5 m.

5.9.1.1 Connecting 1 PSM 510 to the AC Choke

Connect the PSM 510 to the electric grid with the correct AC choke for the power size of the PSM 510.
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Illustration 47: Connecting 1 PSM 510 to the AC Choke

5.9.1.2 Connecting 2 PSM 510 Modules to the AC Choke

Connect the PSM 510 modules to the same AC choke as shown in illustration 48.

Ensure the choke used is the correct size based on the combined power of the PSM 510 modules.

When 2 PSM 510 modules are used, the wiring between the AC line choke and each PSM 510 must be the same length within a
tolerance of 0.5 m.

Connect each PSM 510 to the AC choke directly. Parallel wiring is not permitted.
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Illustration 48: Connecting 2 PSM 510 Modules to the AC Choke

5.9.1.3 Connecting 2 PSM 510 Modules to the AC Choke with System Splitting

Connect the PSM 510 modules to the same AC choke regardless of the load position (for example, before or after the system splitting)
as shown in illustration 49.

Ensure the choke used is the correct size based on the combined power of the PSM 510 modules.

When 2 PSM 510 modules are used, the wiring between the AC line choke and each PSM 510 must be the same length within a
tolerance of 0.5 m.

Connect each PSM 510 to the AC choke directly. Parallel wiring is not permitted.
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Illustration 49: Connecting 2 PSM 510 Modules to the AC Choke with System Splitting
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If 2 AC chokes are used (1 per PSM 510) and both PSM 510 modules are mounted at the same side of the system splitting, the setup is
permitted with derating equal to the AC choke's tolerance referred to 60 kW. For example, 10% derating is 54 kW.

If 2 AC chokes are used (1 per PSM 510) where 1 PSM 510 module is mounted before and 1 after the splitting, the loads must be
balanced equally. Otherwise, the derating of both PSM 510 modules is equal to the AC choke's tolerance. For example, tolerance 10%
+ 10% means –20% derating.

If 2 AC chokes are used (1 per PSM 510) and 1 PSM 510 module is mounted before the splitting and 1 after the splitting and half of the
loads are set before the system splitting and half are set after the system splitting, the setup is permitted with derating equal to the AC
choke's tolerance referred to 60 kW. For example, 10% derating is 54 kW.

N O T I C E

- Further information on the EXM 510 module and wiring can be found in 11.7.15 Expansion Module Connector.

5.9.2 Connecting the Cables on the Power Supply Module PSM 510

5.9.2.1 Connecting the Cables on the Top of the Power Supply Module PSM 510

Context:
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3 24/48 V IN connector (INPUT 24/48 V)

5 STO connector OUT (STO PSM)

7 Relay connector (REL PSM)

2 Ethernet connector OUT (X2 OUT)

4 STO connector IN (STO PSM)

6 I/O connector (I/O PSM)

Illustration 50: Connectors on the Top of PSM 510
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Procedure

1. Connect the Ethernet cable from the PLC to the Ethernet input connector [1].

2. Connect the Ethernet cable from the Ethernet output connector [2] to the next module.

3. Insert the wires into the 24/48 V IN connector.

4. Insert the 24/48 V IN connector [3].

5. Insert the wires into the STO connector IN connector.

6. Insert the STO connector IN (STO PSM) connector [4].

7. Insert the wires into the STO connector OUT connector.

8. Insert the STO connector OUT (STO PSM) connector [5].

9. If I/Os are required, insert the wires into the I/O connector and insert the connector (I/O PSM) [6].

10. If a relay is required, insert the wires into the relay connector and insert the connector (REL PSM) [7].

5.9.2.2 Connecting the Cables on the Bottom of the Power Supply Module PSM 510

Context:
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3 PE screws

2 AC mains supply connector

4 Internal/external brake resistor connector

Illustration 51: Connectors on the Bottom of PSM 510

Procedure

1. Insert the wires into the AC mains supply connector.

2. Insert the AC mains supply connector [2].

3. If an external brake resistor is required:

A Unplug the internal brake resistor connector [4] and insert the external brake connector in its place.

B Plug the internal brake resistor connector to the internal brake connector holder [1].

4. Connect the PSM 510 to the PE screw on the front side [3] using a PE wire. The tightening torque is 3 Nm.
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5.10 Connecting the Decentral Access Module (DAM 510)

5.10.1 Connecting the Cables on the Top of the Decentral Access Module DAM 510

Context:
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3 STO connector IN (STO DAM)

5 External encoder connector (E DAM)

2 Ethernet connector OUT (X3 OUT)

4 STO connector OUT (STO DAM)

Illustration 52: Connectors on the Top of DAM 510

Procedure

1. Connect the Ethernet cable from the output of the previous module to the input connector [1].

2. Insert the wires from the STO output of the previous module into the 24 V IN (STO input) connector, see 11.7.10.3.1 STO Connectors
on the Top of DAM 510.

3. Insert the 24 V IN (STO connector IN) connector [3] into the DAM 510.

4. If required, connect the external encoder connector [5].

5.10.2 Connecting the Feed-In Cable

Context:

1234

e
3

0
b

g
4

6
8

.1
0

1 Ethernet connector

3 STO out connector

2 AUX connector

4 UDC connector

Illustration 53: Connectors on the Bottom of DAM 510
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1

26

117
80

10
20

87

18

10

7

2
3

4
5

6
7

8

9

e3
0b

g8
06

.1
0

1 Shielded area

3 UDC– (gray, 2.5 mm2/4 mm2)

5 STO– (gray, 0.5 mm2)

7 AUX– (blue, 2.5 mm2)

9 PE (yellow/green, 2.5 mm2/4 mm2, fork lug)

2 UDC+ (black, 2.5 mm2/4 mm2)

4 STO+ (pink, 0.5 mm2)

6 AUX+ (red, 2.5 mm2)

8 Ethernet/fieldbus (green, RJ45 connector)

Illustration 54: Feed-In Cable

1

2

3

4
5

6

e3
0b

g8
07

.1
0

1 Feed-in cable PE screws 2 Bus connector
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3 Cable tie for feed-in cable

5 EMC plate

4 Cable tie for STO cable

6 EMC plate screw

Illustration 55: Connecting the Feed-In Cable

Procedure

1. Insert the wires into the UDC, AUX, and STO connectors.

2. Secure the feed-in cable using the cable ties [3], ensuring that the shielded area is positioned exactly under the cable tie.

3. Secure the STO cable using the cable tie [4], ensuring that the shielded area is positioned exactly under the cable tie.

4. Insert the connectors on the feed-in cable into their corresponding terminal block on the DAM 510.

5. Tighten the screw on the EMC plate [6]. The tightening torque is 3 Nm.

6. Insert the RJ45 bus connector [2].

7. Connect the DAM 510 to the PE screw on the front side [1] using a PE wire. The tightening torque is 3 Nm.

5.11 Connecting the Auxiliary Capacitors Module ACM 510

Context:

e3
0b

h3
50

.1
11 2

4 3

1 Ethernet connector IN (X1 IN)

3 I/O connector (I/O ACM)

2 Ethernet connector OUT (X2 OUT)

4 Relay connector (REL ACM)

Illustration 56: Connectors on the Top of ACM 510

Procedure

1. Connect the Ethernet cable from the output of the previous system module to the input connector (X1 IN) [1].

2. If I/Os are required, insert the wires into the I/O connector (I/O ACM) and insert the connector [3].

3. If a relay is required, insert the wires into the relay connector (REL ACM) and insert the connector [4].

4. Connect the ACM 510 to the PE screw on the front side using a PE wire. The tightening torque is 3 Nm.
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5.12 Connecting the Expansion Module EXM 510

Context:

12

5315
8

1

2

3

4

5

6

7

e3
0b

h6
61

.1
0

1 24/48 V

3 Functional earth

5 DC–

7 DC+

2 GND

4 DC–

6 DC+

8 Shielded area

Illustration 57: Expansion Module Cable

e3
0b

h3
92

.1
1

1

23

4

5

6

7

1 EMC shielding plate screw

3 DC cables

5 GND cable

7 Cable tie

2 PE screw

4 Functional earth cable

6 24/48 V cable

Illustration 58: Connecting the Expansion Module EXM 510
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N O T I C E

- If 2 separate backlinks are used (connected via 1 or 2 pairs of EXM 510 modules), the 2 grounding bars must be also
connected together with a 16 mm2 (6 AWG) cable cross-section.

Procedure

1. Insert wires [3], [4], [5], and [6] into the expansion connector.

2. Secure the DC cables [3] using the cable tie [7], ensuring that the shielded area is positioned exactly under the cable tie.

3. Secure the cables [4], [5], and [6] using the cable ties [7].

4. Plug the connectors into the backplate.

5. Tighten the screw on the EMC shielding plate [1]. The tightening torque is 3 Nm.

6. Ground the expansion module to PE using a PE wire and the PE screw [2]. The tightening torque is 3 Nm.

5.13 Connecting the Brake Resistor on the PSM 510

The PSM 510 is connected to the internal brake resistor as shown in illustration 59.

Alternatively, the PSM 510 can be connected to an external brake resistor. In this case, the internal brake resistor on the PSM 510 must
remain unconnected and the connector can be placed in the internal brake resistor connector holder (see 3.2.3 Connectors on the
Bottom of PSM 510).

Paralleling or series of brake resistors is not permitted.
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STATUS PSM
DEV
SVS ST
NET ST

LINK/ACT
X1
X2

LCP

1

e3
0b

h4
23

.1
0

PS
M

 5
10

1 Internal brake resistor

Illustration 59: Connection of Internal Brake Resistor on 1 PSM 510

When using 2 PSM 510 modules, connect each PSM 510 to its own internal brake resistor as shown in illustration 60 (factory setting).

Alternative permitted configurations for 2 PSM 510 modules:

• 1 PSM 510 is connected to the internal brake resistor and the other is connected to an external brake resistor.

• Both PSM 510 modules are connected to an external brake resistor. In this case, the internal brake resistor on the PSM 510 must
remain unconnected and the connector can be placed in the internal brake resistor connector holder (see 3.2.3 Connectors on the
Bottom of PSM 510).

Paralleling or series of brake resistors is not permitted.
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STATUS PSM

DEV
SVS ST

NET ST

LINK/ACT
X1

X2

LCP

STATUS PSM

DEV
SVS ST

NET ST

LINK/ACT
X1

X2

LCP

1

1
e3

0b
h4

24
.1

0

PS
M

 5
10

PS
M

 5
10

1 Internal brake resistor

Illustration 60: Connection of Brake Resistor on 2 PSM 510 Modules in Parallel
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6 Commissioning

6.1 Warnings for Commissioning

W A R N I N G
UNINTENDED START

The MSD 510 system contains servo drives, the PSM 510, and DAM 510 that are connected to the electrical supply network and
can start running at any time. This may be caused by a fieldbus command, a reference signal, or clearing a fault condition. Servo
drives and all connected devices must be in good operating condition. A deficient operating condition may lead to death,
serious injury, damage to equipment, or other material damage when the unit is connected to the electrical supply network.

- Take suitable measures to prevent unintended starts.

6.2 Pre-Commissioning Checklist

Context:

Always complete these checks before initial commissioning and before commencing operation after extended downtime or storage.

Procedure

1. Check if all the threaded connectors of mechanical and electrical components are firmly tightened.

2. Check if the free circulation of cooling air (inlet and outlet) is assured.

3. Check if the electrical connections are correct.

4. Ensure that contact protection is in place for rotating parts and surfaces that can become hot.

5. If using the STO functionality, conduct the functional safety concept commissioning test (see 8.8 Commissioning Test).

6.3 SDM 511/SDM 512 Configuration Parameter and Drive Commissioning

6.3.1 Configuration Parameter Subtool

The Configuration Parameter subtool is the VLT® Servo Toolbox subtool for configuring:

• Motor data

• Application data

• Control data

• Input/output configurations

• External encoder
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e3
0b

h6
57

.1
01 2 3

1 Save/Save as button

3 Write configuration to device button

2 Read configuration from device button

Illustration 61: Configuration Parameter Subtool

The configuration parameters are stored in a file.

• Click on the Read configuration from device button [2] to load the file.

• Click on the Save/Save as button [1] to save the file locally.

• Click on the Write configuration to device button [3] to transfer the file to a device. Power cycle the device to activate the transferred
configuration.

N O T I C E

- Refer to the subtool for a detailed description of each parameter.

6.3.2 Drive Commissioning Subtool

The Drive Commissioning subtool is the VLT® Servo Toolbox subtool for carrying out commissioning tasks, such as:

• Motor feedback adjustment

• Resolver amplitude calibration

• Inertia measurement

e3
0b

h6
58

.1
0

Illustration 62: Drive Commissioning Subtool
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6.4 EtherCAT® ID Assignment

EtherCAT® needs no special ID assignment (IP address). Special ID assignment is only required when using indirect communication via
the VLT® Servo Toolbox software.

6.5 Ethernet POWERLINK® ID Assignment

6.5.1 Overview

Ethernet POWERLINK® master communication must not be active when using the VLT® Servo Toolbox to assign IDs to the devices. ID
assignment via the VLT® Servo Toolbox is only possible when acyclic Ethernet POWERLINK® communication is used. If Ethernet
POWERLINK® cyclic communication is already started, perform a power cycle to stop it.

Detach the PLC and carry out a power cycle before setting IDs. Alternatively, in the POWERLINK® interface, restart the PLC in Service
Mode while parameter Basic Ethernet in Service Mode is set to Basic Ethernet enabled.

6.5.2 Single Device ID Assignment

When assigning an ID to a single device, use the Device Information window in the VLT® Servo Toolbox (see the VLT® Servo Drive
System ISD 510, DSD 510, MSD 510 Programming Guide for further information).

Setting an ID to a device can also be done via the LCP.

6.5.2.1 Setting the Node ID Directly on a Servo Drive or on the System Modules

Context:

All IP-related parameters are located in parameter group 12-0* IP Settings. According to the Ethernet POWERLINK® standard, the IP
address is fixed to 192.168.100.xxx. The last number is the value in parameter 12-60 Node ID. For parameter 12-02 Subnet Mask, the IP
address is fixed to 255.255.255.0 and cannot be changed.

Procedure

1. Attach the LCP to the servo drive or system module for which the Node ID should be changed.

2. Press the Hand On button for >1 s to make the LCP the controlling interface.

3. Press the Main Menu button then scroll down to submenu 12-** Ethernet and press OK.

4. Scroll down to submenu 12-6* Ethernet POWERLINK and press OK.

5. Change the PSM 510/DAM 510 node ID to the desired value (1–239).

6. Press OK to confirm the selection then wait for the ID assignment procedure to complete.

7. Carry out a power cycle to ensure that all ID changes are in effect and operational on the fieldbus.

6.5.2.2 Setting the Node ID for a Single Servo Drive via the Power Supply Module (PSM 510) or
Decentral Access Module (DAM 510) via the LCP

Context:

It is also possible to change the Node ID of a servo drive when the LCP is connected to the PSM 510 or DAM 510. This functionality is
contained in parameter group 54-** ID Assignment in subgroup 54-1* Manual.
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Procedure

1. Attach the LCP to the PSM 510/DAM 510 that is connected to the servo drives and system modules for which the Node ID should be
changed.

2. Press the Hand On button for >1 s to make the LCP the controlling interface for the PSM 510/DAM 510.

3. Press the Main Menu button then scroll down to submenu 12-** Ethernet and press OK.

4. Scroll down to submenu 12-6* Ethernet POWERLINK and press OK.

5. Change the PSM 510/DAM 510 node ID to the desired value (1–239) by pressing the OK button.

6. Return to the Main Menu and select parameter 54-** ID Assignment.

7. Select parameter 54-1* Manual.

8. PSM 510 only: In parameter 54-01 Epl id assignment line, select either Ethernet port X1 or X2. The PSM 510 will assign IDs to the
selected device via the selected port and the fieldbus network. On DAM 510 port, X2 will be used automatically.

9. Select parameter 54-12 Epl ID assignment start id then select a valid value (1–239). The value will be assigned to the device at the
specified position index. The PSM 510/DAM 510 connected to the LCP is at position 0 and the 1st reachable device on the selected
port is position index 1 and so on.

10. Select parameter 54-14 Manual Epl ID assignment start and change the status from [0] ready to [1] start.

11. Press OK to confirm the selection then wait for the ID assignment procedure to complete.

12. Check that the ID assignment was completed successfully using parameters:

A Parameter 54-15 Epl ID assignment state

B Parameter 54-16 Epl ID assignment error code

C Parameter 54-17 Epl ID assignment device count

13. Carry out a power cycle to ensure that all ID changes are in effect and operational on the fieldbus.

If an error occurs during ID assignment, the detected error is shown on the LCP. The following errors may be reported:

• Invalid NMT state

• Invalid comment

• Invalid Ethernet port

• Invalid node ID

• ID assignment failed

• Duplicate MAC address

• Invalid SW version

• Incomplete assignment

• No device found

• Internal error

6.5.3 Multiple Device ID Assignment

When assigning IDs to several devices (for example, when setting up a new network), use the VLT® Servo Toolbox subtool DAM ID
assignment (see the VLT® Servo Drive System ISD 510, DSD 510, MSD 510 Programming Guide for further information).

Setting the IDs of all the servo drives connected to a Decentral Access Module (DAM 510) or Power Supply Module (PSM 510) at the
same time can also be done via the LCP when it is connected to the DAM 510/PSM 510.
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6.5.3.1 Setting the Node IDs of all Servo Drives and System Modules on a Decentral Access Module
(DAM 510)/Power Supply Module (PSM 510) Line

Context:

The automatic PSM 510/DAM 510 ID assignment is used for automatically setting the Node IDs on all servo drives and system modules
for a specified PSM 510/DAM 510 line. This functionality is contained in parameter group 54- ** ID Assignment in subgroup 54-0*
Automatic.

Procedure

1. Attach the LCP to the PSM 510/DAM 510 that is connected to the servo drives and system modules for which the Node ID should be
changed.

2. Press the Hand On button for >1 s to make the LCP the controlling interface for the PSM 510/DAM 510.

3. Press the Main Menu button then scroll down to submenu 12-** Ethernet and press OK.

4. Scroll down to submenu 12-6* Ethernet POWERLINK and press OK.

5. Change the PSM 510/DAM 510 node ID to the desired value (1–239) by pressing the OK button.

6. Return to the Main Menu and select parameter 54-** ID Assignment.

7. Select parameter 54-0* Automatic.

8. PSM 510 only: In parameter 54-01 Epl id assignment line, select either Ethernet port X1 or X2. The PSM 510 will assign IDs to the
selected device via the selected port and the fieldbus network. On DAM 510 port, X2 will be used automatically.

9. Select parameter 54-02 Epl ID assignment start id then select a valid value (1–239). The value will be assigned to the device at the
specified position index. The PSM 510/DAM 510 connected to the LCP is at position 0 and the 1st reachable device on the selected
port is position index 1 and so on.

10. Select parameter 54-03 Automatic Epl ID assignment start and change the status from [0] ready to [1] start.

11. Press OK to confirm the selection then wait for the ID assignment procedure to complete.

12. Check that the ID assignment was completed successfully using parameters:

A Parameter 54-04 Epl ID assignment state

B Parameter 54-05 Epl ID assignment error code

C Parameter 54-06 Epl ID assignment device count

13. Carry out a power cycle to ensure that all ID changes are in effect and operational on the fieldbus.

If an error occurs during ID assignment, the detected error is shown on the LCP. The following errors may be reported:

• Invalid NMT state

• Invalid comment

• Invalid Ethernet port

• Invalid node ID

• ID assignment failed

• Duplicate MAC address

• Invalid SW version

• Incomplete assignment

• No device found

• Internal error

6.6 PROFINET® ID Assignment

Each PROFINET® device needs a device name and an IP address. The IP address and the device name are assigned by the I/O controller,
when the connection to the I/O device is established.
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The IP address assignment is also required when using indirect communication via the VLT® Servo Toolbox software (see the VLT®

Servo Drive System ISD 510, DSD 510, MSD 510 Programming Guide for further information).

The IP address and the device name can also be assigned using PRONETA, a free tool that supports in the analysis and configuration of
PROFINET® networks.

6.7 Power-Up Time

The maximum power-up time for the system components is 15 s. This means the time from supplying the system with auxiliary voltage
to the module being initialized completely.

The power-up time stated is an indicative time. The exact status of the module can be seen via the statusword.

N O T I C E

- Do not operate any of the system modules until they are all powered up correctly.

- If 2 PSM 510 modules are mounted in parallel, power up both PSM 510 modules simultaneously (within a maximum delay
of 1 second).

6.8 System Module Charging Time

The charging time of the system is determined by the longest charging time of each individual system module.

The exact status of each module can be seen via the statusword.

N O T I C E

- Do not operate any of the system modules until they are charged up completely and are in state Operation enabled.

Table 16: DC-Link (UDC) Charging Time for PSM 510, DAM 510, and ACM 510

Specification Unit PSM 510 DAM 510 ACM 510

UDC charging time s 2.0 2.0 3.5

Table 17: DC-Link (UDC) Charging Time for SDM 511

Specification Unit SDM 511

2.5 A

SDM 511

5 A

SDM 511

10 A

SDM 511

20 A

UDC charging time s 2.0
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Table 18: DC-Link (UDC) Charging Time for SDM 512

Specification Unit SDM 512

2 x 2.5 A

SDM 512

2 x 5 A

SDM 512

2 x 10 A

UDC charging time s 2.0

6.9 Switching on the MSD 510 System

Complete the cabling of the MSD 510 system before applying power to the Servo Drive Modules (SDM 511/SDM 512). This cabling
provides the supply voltage and the communication signals for the MSD 510 system. This is a fundamental requirement for operation
of the servo drives.

The MSD 510 system is switched on by supplying the Power Supply Module (PSM 510) with UAUX. This supply is then automatically
passed on to all connected system modules and only the control units of the connected modules are running. The system is ready for
operation when mains and STO are supplied.

6.9.1 Procedure for Switching on the MSD 510 System

Procedure

1. Switch on UAUX power to enable communication to the PSM 510, DAM 510, and SDM modules to be established.

2. Switch on the mains.

3. Set the PSM 510 to state Operation enabled.

Now the system modules are ready for operation.

4. Set the DAM 510 to state Operation enabled.

6.10 Libraries

The libraries provided for the MSD 510 system can be used in:

• TwinCAT® V2

• SIMOTION SCOUT® V4.4 and V4.5:

- C240 from V4.4

- D410-2 from V4.4

- D425-2 from V4.4

- D435-2 from V4.4

- D445-2 from V4.4

- D455-2 from V4.4

- P320 from V4.4

• Automation Studio™ environment (version 3.0.90 and 4.x, supported platform SG4) to easily integrate the functionality without the
need for special motion run-time on the controller.

• TiA from V13

The provided function blocks conform to the PLCopen® standard. Knowledge of the underlying fieldbus communication and/or the
CANopen® CiA DS 402 profile is not necessary.
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The library contains:

• Function blocks for controlling and monitoring the ISD 510/DSD 510 servo drives, servo drive modules SDM 511/SDM 512, and the
system modules.

• Function blocks for all available motion commands of the ISD 510/DSD 510 servo drives and SDM 511/SDM 512 servo drive
modules.

• Function blocks for controlling and monitoring the PSM 510, DAM 510, and ACM 510.

• Function blocks and structures for creating Basic CAM profiles.

• Function blocks and structures for creating Labeling CAM profiles.

6.11 Programming with Automation Studio™

6.11.1 Requirements for Programming with Automation Studio™

The following files are required to integrate the ISD 510/DSD 510 servo drives, the SDM 511/SDM 512 servo drive modules, and the
system modules into an Automation Studio™ project:

• Package of libraries for the MSD 510 servo system: Danfoss_VLT_ServoMotion_V_x_y_z.zip

• XDD file (XML Device Description) for the standard ISD 510 servo drive: 0x0300008D_ISD510_S.xdd

• XDD file (XML Device Description) for the advanced ISD 510 servo drive: 0x0300008D_ISD510_A.xdd

• XDD file (XML Device Description) for the standard DSD 510 servo drive: 0x0300008D_DSD510_S.xdd

• XDD file (XML Device Description) for the advanced DSD 510 servo drive: 0x0300008D_DSD510_A.xdd

• XDD file (XML Device Description) for the SDM 511/SDM 512 servo drive module: 0x0300008D_SDM510.xdd

• XDD file (XML Device Description) for the Power Supply Module (PSM 510): 0x0300008D_PSM.xdd

• XDD file (XML Device Description) for the Decentral Access Module (DAM 510): 0x0300008D_DAM.xdd

• XDD file (XML Device Description) for the Auxiliary Capacitors Module (ACM 510): 0x0300008D_ACM.xdd

6.11.2 Creating an Automation Studio™ Project

The procedures described in this chapter apply to Automation Studio™ Versions 3.0.90 and V4.x unless otherwise specified.

Information on how to install Automation Studio™ can be found in detail in the Automation Studio™ help. Open the B&R Help Explorer
and go to [Automation software → Software Installation → Automation Studio].

Information on how to create a project in Automation Studio™ can be found in detail in the Automation Studio™ help.

V3.0.90:

Open the B&R Help Explorer and go to [Automation Software → Getting Started → Creating programs with Automation Studio → First
project with X20 CPU].

V4.x:

Open the B&R Help Explorer and go to [Automation Software → Getting Started → Creating programs with Automation Studio →
Example project for a target system with CompactFlash].
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6.11.3 Including the Servo Motion Libraries into an Automation Studio™ Project

Procedure

1. In the Logical View, open the menu entry [File → Import...].

2. In the next window, select the Danfoss_VLT_ServoMotion_V_x_y_z.zip file (according to the location on the hard drive).

3. Click on Open.

4. Assign the libraries to the CPU in the next window.

5. Click on Finish. Now the libraries are integrated into the Automation Studio™ project.

A new folder containing the ISD libraries is created during integration:

• DDS_Drive

- Contains program organization units (POUs) defined by PLCopen® (name starting with MC_) and POUs defined by Danfoss
(name starting with DD_). The Danfoss POUs provide additional functionality for the axis.

- It is possible to combine POUs defined by PLCopen® with POUs defined by Danfoss.

- The names of the POUs that target the servo drive all end with _DDS.

• DDS_PSM

- Contains POUs defined by Danfoss (name starting with DD_) and provide the functionality for the Power Supply Module
(PSM).

- The names of the POUs that target the PSM all end with _PSM.

• DDS_DAM

- Contains POUs defined by Danfoss (name starting with DD_) and provide the functionality for the Decentral Access
Module (DAM).

- The names of the POUs that target the DAM all end with _DAM.

• DDS_ACM

- Contains POUs defined by Danfoss (name starting with DD_) and provide the functionality for the Auxiliary Capacitors
Module (ACM).

- The names of the POUs that target the ACM all end with _ACM.

• DDS_BasCam

- Contains POUs for the creation of basic CAMs.

• DDS_LabCam

- Contains POUs for the creation of labeling CAMs.

• DDS_Intern

- Contains POUs that are needed internally for the libraries.

- Do not use these POUs in an application.

When integrating the DDS_Drive package, some standard libraries are integrated automatically, unless they are already part of
the project.

N O T I C E

- Do not remove these libraries otherwise the Danfoss servo motion libraries will not work.

6.11.4 Constants within the DDS_Drive Library

Inside the library, the following lists of constants are defined:
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• Danfoss_VLT_ServoMotion

- Contains the version information of the library.

• DDS_AxisErrorCodes

- Constants for error codes of the axis.

- Error codes can be read using the function block MC_ReadAxisError_DDS and/or DD_ReadAxisWarning_DDS.

• DDS_AxisTraceSignals

- Constants for the trace signals of the axis.

- Intended to be used with the function block DD_Trace_DDS.

• DDS_BasCam

- Constants for the creation of basic CAMs.

• DDS_CamParsingErrors

- Constants for parsing problems of a CAM.

- Error reason is returned by function block MC_CamTableSelect_DDS.

• DDS_FB_ErrorConstants

- Constants for errors inside POUs.

- The reason is given in an output ErrorInfo.ErrorID that is available in all POUs.

• DDS_Intern

- Constants which are needed internally for the library.

- They are not intended to be used in an application.

• DDS_LabCam

- Constants for the creation of labeling CAMs.

• DDS_SdoAbortCodes

- Constants for errors concerning reading and writing of parameters.

- The reason is given in an output AbortCode that is available in several POUs.

• PSM_ErrorCodes

- Constants for error codes of the Power Supply Module (PSM 510).

- Error codes can be read using the function block DD_ReadPsmError_PSM and/or DD_ReadPsmWarning_PSM.

• PSM_TraceSignals

- Constants for the trace signals of the Power Supply Module (PSM 510).

- Intended to be used with the function block DD_Trace_PSM.

• DAM_ErrorCodes

- Constants for error codes of the Decentral Access Module (DAM 510).

- Error codes can be read using the function block DD_ReadDamError_DAM and/or DD_ReadDamWarning_DAM.

• DAM_TraceSignals

- Constants for the trace signals of the Decentral Access Module (DAM 510).

- Intended to be used with the function block DD_Trace_DAM.

• ACM_ErrorCodes

- Constants for error codes of the Auxiliary Capacitors Module (ACM 510).

- Error codes can be read using the function block DD_ReadAcmError_ACM and/or DD_ReadAcmWarning_ACM.

• ACM_TraceSignals

- Constants for the trace signals of the Auxiliary Capacitors Module (ACM 510).

- Intended to be used with the function block DD_Trace_ACM.
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6.11.5 Instantiating AXIS_REF_DDS in Automation Studio™

Procedure

1. Create 1 instance of function block AXIS_REF_DDS (located in folder DDS_Drive) for every SDM 511/SDM 512 drive module and
servo drive that has to be controlled or monitored.

2. To create a link to the physical servo drive, link each instance of AXIS_REF_DDS to 1 physical servo drive. This makes it the logical
representation of 1 physical servo drive.

Open the Logical View.

Initialize each instance with its node number and the slot name it is connected to (for example, IF3).

Initialize each instance of a drive with its DriveType.

Example:

Illustration 63: Instantiation of AXIS_REF_DDS and Setting of Initial Values

6.11.6 Instantiating PSM_REF in Automation Studio™

Procedure

1. Create 1 instance of function block PSM_REF (located in folder DDS_PSM) for every Power Supply Module (PSM) that has to be
controlled or monitored.

2. To create a link to the physical PSM, link each instance of PSM_REF to 1 physical PSM. This makes it the logical representation of 1
physical PSM.

Open the Logical View.

Initialize each instance with its node number and the slot name it is connected to (for example, IF3).
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6.11.7 Instantiating DAM_REF in Automation Studio™

Procedure

1. Create 1 instance of function block DAM_REF (located in folder DDS_DAM) for every Decentral Access Module (DAM) that has to be
controlled or monitored.

2. To create a link to the physical DAM, link each instance of DAM_REF to 1 physical DAM. This makes it the logical representation of 1
physical DAM.

Open the Logical View.

Initialize each instance with its node number and the slot name it is connected to (for example, IF3).

6.11.8 Instantiating ACM_REF in Automation Studio™

Procedure

1. Create 1 instance of function block ACM_REF (located in folder DDS_ACM) for every Auxiliary Capacitors Module (ACM) that has to
be controlled or monitored.

2. To create a link to the physical ACM, link each instance of ACM_REF to 1 physical ACM. This makes it the logical representation of 1
physical ACM.

Open the Logical View.

Initialize each instance with its node number and the slot name it is connected to (for example, IF3).

6.11.9 Importing a Servo Drive into Automation Studio™

Context:

N O T I C E

- For each physical servo drive, add 1 entry to the Physical View of Automation Studio™.
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6.11.9.1 Version V3.0.90

Procedure

1. Select the menu entry [Tools → Import Fieldbus Device...].

2. Select the XDD file (for example, 0x0300008D_ISD510_S.xdd or 0x0300008D_ISD510_A.xdd) from its location on the hard drive. This
import only needs to be done once per project. The device is then known to Automation Studio™.

3. Now add the SDM 511/SDM 512 drive module or servo drive to the Ethernet POWERLINK® interface of the controller in the Physical
View:

Right-click on the controller in the Physical View and select [Open POWERLINK].

Right-click on the interface and select Insert...

In the Select controller module window, select the servo drive in the group POWERLINK Devices.

Click on Next.

In the next window, enter the node number of the servo drive.
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Illustration 64: Adding a Servo Drive to the Project in V3.0.90
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6.11.9.2 Version V4.x

Procedure

1. Select the menu entry [Tools → Import Fieldbus Device...].

2. Select the XDD file (for example, 0x0300008D_ISD510_S.xdd or 0x0300008D_ISD510_A.xdd) from its location on the hard drive. The
device is then known to Automation Studio™.

3. Now add the SDM 511/SDM 512 drive module or servo drive to the Ethernet POWERLINK® interface of the controller in the Physical
View:

Select the menu entry [Open → System Designer] to show the System Designer.

To add a hardware module to the Physical View or System Designer, select the servo drive in the group POWERLINK in the Hardware
Catalog toolbox.

Drag the selected module to the desired position to connect it to the selected hardware module, network interface, or slot.

To change the node number, right-click on the device and select [Node Number → Change Node Number].
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Illustration 65: Adding a Servo Drive to the Project in V4.x

6.11.10 Importing PSM 510, DAM 510 and ACM 510 into Automation Studio™

Context:

N O T I C E

- For each physical Power Supply Module (PSM 510), Decentral Access Module (DAM 510), and Auxiliary Capacitors Module
(ACM 510), add 1 entry to the Physical View of Automation Studio™.
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6.11.10.1 Version V3.0.90

Procedure

1. Select the menu entry [Tools → Import Fieldbus Device...].

2. Select the XDD file for the PSM 510, DAM 510, or ACM 510 from its location on the hard drive. This import only needs to be done
once per project. The device is then known to Automation Studio™.

Power Supply Module (PSM 510): 0x0300008D_PSM.xdd

Decentral Access Module (DAM 510): 0x0300008D_DAM.xdd

Auxiliary Capacitors Module (ACM 510): 0x0300008D_ACM.xdd

3. Now add the PSM 510, DAM 510, or ACM 510 to the Ethernet POWERLINK® interface of the controller in the Physical View:

Right-click on the controller in the Physical View and select [Open POWERLINK].

Right-click on the interface and select Insert....

In the Select controller module window, select the PSM 510, DAM 510, or ACM 510 in the group POWERLINK Devices.

Click on Next.

In the next window, enter the node number of the PSM 510, DAM 510, or ACM 510.
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Illustration 66: 1 PSM 510, 1 DAM 510, and 2 ISD 510 Servo Drives Added to the Ethernet POWERLINK® Interface in V3.0.90
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6.11.10.2 Version V4.x

Procedure

1. Select the menu entry [Tools → Import Fieldbus Device...].

2. Select the XDD file for the PSM 510, DAM 510, or ACM 510 from its location on the hard drive. The device is then known to
Automation Studio™.

Power Supply Module (PSM 510): 0x0300008D_PSM.xdd

Decentral Access Module (DAM 510): 0x0300008D_DAM.xdd

Auxiliary Capacitors Module (ACM 510): 0x0300008D_ACM.xdd

3. Now add the PSM 510, DAM 510, or ACM 510 to the Ethernet POWERLINK® interface of the controller in the Physical View:

Select the menu entry[Open → System Designer] to show the System Designer.

To add a hardware module to the Physical View or System Designer, select the PSM 510, DAM 510, or ACM 510 in the group
POWERLINK in the Hardware Catalog toolbox.

Drag the selected module to the desired position to connect it to the selected hardware module, network interface, or slot.

To change the node number, right-click on the device and select [Node → Change Node Dumber].

PSM: Danfoss _VLT_R_PSM

DAM: Danfoss _VLT_R_DAM

ACM: Danfoss _VLT_R_ACM
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Illustration 67: 1 PSM 510, 1 DAM 510, and 2 ISD 510 Servo Drives Added to the Ethernet POWERLINK® Interface in V4.x
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6.11.11 I/O Configuration and I/O Mapping

Procedure

1. Parameterize the I/O configuration of the SDM 511/SDM 512 drive modules or servo drives so that the library has access to all
necessary objects.

Right-click on the entry of the SDM 511/SDM 512 drive module or servo drive and select Open I/O Configuration in V3.0.90 and
Configuration in V4.x.

In the Channels section, change the Cyclic transmission of the following objects:

All sub-indexes of object 0x5050 (Lib pdo rx_I5050 ARRAY[]) to Write.

All sub-indexes of object 0x5051 (Lib pdo tx_I5051 ARRAY[]) to Read.

2. Parameterize the I/O configuration of the Power Supply Module (PSM 510), Decentral Access Module (DAM 510), and Auxiliary
Capacitors Module (ACM 510) so that the library has access to all necessary objects.

Right-click on the entry of the PSM/DAM/ACM and select Open I/O Configuration in V3.0.90 and Configuration in V4.x.

In the Channels section, change the Cyclic transmission of the following objects:

All sub-indexes of object 0x5050 (Lib pdo rx_I5050 ARRAY[]) to Write.

All sub-indexes of object 0x5051 (Lib pdo tx_I5051 ARRAY[]) to Read.

These settings configure the cyclic communication with the device. These parameters are required for the library to work.

N O T I C E

- It is possible to use copy and paste to apply the same I/O configuration to multiple devices of the same type.

3. Set Module supervised to off for the servo drives and the PSM/DAM/ACM. The parameter is found in the I/O configuration of the
device.
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Illustration 68: I/O Configuration of an ISD 510 Device
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Illustration 69: I/O Mapping after Successful Configuration

4. Map the inputs and outputs of the instance of the AXIS_REF_DDS function block and the physical data points of the ISD 510 servo
drive (here myAxis is an instance of AXIS_REF_DDS):
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Illustration 70: I/O Mapping of an ISD 510 Servo Drive

5. Map the inputs and outputs of the instance of the PSM_REF, DAM_REF, and ACM_REF function blocks and the physical data points
of the PSM/DAM/ACM accordingly.

6.11.12 Setting the PLC Cycle Time

Context:

The minimum cycle time is 400 µs. The servo system devices can run Ethernet POWERLINK® cycle times in multiples of 400 µs and
multiples of 500 µs. The devices are automatically parameterized by the PLC on start-up, depending on the Ethernet POWERLINK®

configuration of the physical interface. The Ethernet POWERLINK® configuration can be accessed by right-clicking [CPU → Open IF3
POWERLINK Configuration] in the Physical View for V3.0.90 or [PLK → Configuration] for V4.x.

N O T I C E

- Ensure that the task cycle times of the PLC program and Ethernet POWERLINK® are the same. Otherwise, data could be lost
and performance reduced.
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Illustration 71: Ethernet POWERLINK<® Configuration Window to Parameterize Ethernet POWERLINK® Cycle Time

Procedure for setting the PLC time in Automation Studio™

1. Right-click [CPU → Open Software Configuration] for V3.0.90 and [CPU → Configuration → Timing] for V4.x in the Physical View.

2. Ensure that the PLC cycle time is the same as the Ethernet POWERLINK® cycle time.
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6.11.13 Connecting to the PLC

Information on how to connect to the PLC can be found in detail in the Automation Studio™ Help.

Version V3.0.90:

Open the B&R Help Explorer and go to [Automation Software → Getting Started → Creating programs with Automation Studio → First
project with X20 CPU → Configure online connection].

Version V4.x:

Open the B&R Help Explorer and go to [Automation Software → Getting Started → Creating programs in Automation Studio →
Example project for a target system with CompactFlash].

6.12 Programming with TwinCAT®

6.12.1 Requirements for Programming with TwinCAT®

To integrate the ISD 510/DSD 510 servo drives, servo drive modules SDM 511/SDM 512, and the PSM 510, DAM 510, or ACM 510 into a
TwinCAT® project, the following files are required:

• Library for the MSD 510 servo system: Danfoss_VLT_ServoMotion_V_x_y_z.lib

• ESI file (EtherCAT® Slave Information) for the standard ISD 510 servo drive: Danfoss_ISD510_S.xml

• ESI file (EtherCAT® Slave Information) for the advanced ISD 510 servo drive: Danfoss_ISD510_A.xml

• ESI file (EtherCAT® Slave Information) for the standard DSD 510 servo drive: Danfoss_DSD510_S.xml

• ESI file (EtherCAT® Slave Information) for the advanced DSD 510 servo drive: Danfoss_DSD510_A.xml

• ESI file (EtherCAT® Slave Information) for the Servo Drive Module: Danfoss_SDM510.xml

• ESI file (EtherCAT® Slave Information) for the Power Supply Module: Danfoss_PSM510.xml

• ESI file (EtherCAT® Slave Information) for the Decentral Access Module: Danfoss_DAM510.xml

• ESI file (EtherCAT® Slave Information) for the Auxiliary Capacitor Module: Danfoss_ACM510.xml

6.12.2 Creating a TwinCAT® Project

Information on how to install TwinCAT® can be found in detail in the Beckhoff Information System (https://infosys.beckhoff.com/).
Open the information system and select [TwinCAT 2 → TwinCAT Quick Start → Installation].

Information on how to create a project in TwinCAT® can be found in detail in the Beckhoff Information System (https://
infosys.beckhoff.com/). Open the information system and select [TwinCAT 2 → TwinCAT Quick Start or TwinCAT 2 → TX1200 TwinCAT
PLC → TwinCAT PLC Control].
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6.12.3 Including the TwinCAT® Library into a TwinCAT® Project

Procedure

1. In the Resources tab of TwinCAT® PLC Control, open the Library Manager.

2. In the upper left area of the Library Manager window, right-click and select Additional Library....

3. Select the Danfoss_VLT_ServoMotion_V_x_y_z file (according to the location on the hard drive).

4. Click on Open. Now the libraries are integrated into the TwinCAT® PLC control project.
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Illustration 72: Library Manager after Including the ServoMotion Library

Inside the library, the POUs are organized into folders:
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• DDS_Drive

- Contains program organization units (POUs) defined by PLCopen® (name starting with MC_) and POUs defined by Danfoss
(name starting with DD_). The Danfoss POUs provide additional functionality for the axis.

- It is possible to combine POUs defined by PLCopen® with POUs defined by Danfoss.

- The names of the POUs that target the SDM 511/SDM 512 drive modules and servo drives all end with _DDS.

• DDS_PSM

- Contains POUs defined by Danfoss (name starting with DD_) and provide the functionality for the Power Supply Module
(PSM 510).

- The names of the POUs that target the PSM 510 all end with _PSM.

• DDS_DAM

- Contains POUs defined by Danfoss (name starting with DD_) and provide the functionality for the Decentral Access
Module (DAM 510).

- The names of the POUs that target the DAM 510 all end with _DAM.

• DDS_ACM

- Contains POUs defined by Danfoss (name starting with DD_) and provide the functionality for the Auxiliary Capacitors
Module (ACM 510).

- The names of the POUs that target the ACM 510 all end with _ACM.

• DDS_BasCam

- Contains POUs for the creation of basic CAMs.

• DDS_LabCam

- Contains POUs for the creation of labeling CAMs.

• DDS_Intern

- Contains POUs that are needed internally for the libraries.

- Do not use these POUs in an application.

When integrating the VLT® Multiaxis Servo Drive library, some standard libraries are integrated automatically, unless they are
already part of the project.

N O T I C E

- Do not remove these libraries otherwise the DDS libraries will not work.

6.12.4 Constants within the DDS_Drive Library

Inside the library, the following lists of constants are defined:
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• Danfoss_VLT_ServoMotion

- Contains the version information of the library.

• DDS_AxisErrorCodes

- Constants for error codes of the axis.

- Error codes can be read using the function block MC_ReadAxisError_DDS and/or DD_ReadAxisWarning_DDS.

• DDS_AxisTraceSignals

- Constants for the trace signals of the axis.

- Intended to be used with the function block DD_Trace_DDS.

• DDS_BasCam

- Constants for the creation of basic CAMs.

• DDS_CamParsingErrors

- Constants for parsing problems of a CAM.

- Error reason is returned by function block MC_CamTableSelect_DDS.

• DDS_FB_ErrorConstants

- Constants for errors inside POUs.

- The reason is given in an output ErrorInfo.ErrorID that is available in all POUs.

• DDS_Intern

- Constants which are needed internally for the library.

- They are not intended to be used in an application.

• DDS_LabCam

- Constants for the creation of labeling CAMs.

• DDS_SdoAbortCodes

- Constants for errors concerning reading and writing of parameters.

- The reason is given in an output AbortCode that is available in several POUs.

• PSM_ErrorCodes

- Constants for error codes of the Power Supply Module (PSM 510).

- Error codes can be read using the function block DD_ReadPsmError_PSM and/or DD_ReadPsmWarning_PSM.

• PSM_TraceSignals

- Constants for the trace signals of the Power Supply Module (PSM 510).

- Intended to be used with the function block DD_Trace_PSM.

• DAM_ErrorCodes

- Constants for error codes of the Decentral Access Module (DAM 510).

- Error codes can be read using the function block DD_ReadDamError_DAM and/or DD_ReadDamWarning_DAM.

• DAM_TraceSignals

- Constants for the trace signals of the Decentral Access Module (DAM 510).

- Intended to be used with the function block DD_Trace_DAM.

• ACM_ErrorCodes

- Constants for error codes of the Auxiliary Capacitors Module (ACM 510).

- Error codes can be read using the function block DD_ReadAcmError_ACM and/or DD_ReadAcmWarning_ACM.

• ACM_TraceSignals

- Constants for the trace signals of the Auxiliary Capacitors Module (ACM 510).

- Intended to be used with the function block DD_Trace_ACM.
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6.12.5 Instantiating AXIS_REF_DDS in TwinCAT®

Procedure

1. Create 1 instance of function block AXIS_REF_DDS (located in folder DDS_Drive) for the SDM 511/SDM 512 drive module or servo
drive that has to be controlled or monitored.

2. Repeat step 1 for additional SDM 511/SDM 512 drive modules or servo drives.

Example:
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Illustration 73: Instantiation of AXIS_REF_DDS

6.12.6 Instantiating PSM_REF in TwinCAT®

Procedure

1. Create 1 instance of function block PSM_REF (located in folder DDS_PSM) for each Power Supply Module that has to be controlled
or monitored.

2. Repeat step 1 for additional Power Supply Modules.

6.12.7 Instantiating DAM_REF in TwinCAT®

Procedure

1. Create 1 instance of function block DAM_REF (located in folder DDS_DAM) for each Decentral Access Module that has to be
controlled or monitored.

2. Repeat step 1 for additional Decentral Access Modules.
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6.12.8 Instantiating ACM_REF in TwinCAT®

Procedure

1. Create 1 instance of function block ACM_REF (located in folder DDS_ACM) for each Auxiliary Capacitors Module that has to be
controlled or monitored.

2. Repeat step 1 for additional Auxiliary Capacitors Modules.

6.12.9 Adding a PLC Project to TwinCAT® System Manager

Context:

To create a link between the TwinCAT® PLC Control project and the TwinCAT® System Manager, connect the saved project, especially
the inputs and outputs, to the TwinCAT® System Manager:

Procedure

1. To add the project information to the TwinCAT® System Manager, right-click on PLC-Configuration and select Append PLC project....

2. In the Insert IEC 1131 Project window, select the project information file according to the location on the hard drive. The file has the
same name as the PLC project, but with the file extension .tpy.

3. Click on Open.

6.12.10 Importing Devices to TwinCAT®

Context:

The following procedure is an example of how to import an ISD 510 servo drive to TwinCAT®.
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Procedure

1. Copy the ESI file Danfoss ISD 510 S.xml into the folder TwinCAT Installation Folder\Io\EtherCAT on the hard drive. This only needs to
be done once per project. The TwinCAT® System Manager automatically searches for ESI files at this location on the hard drive
during start-up.

2. To add an EtherCAT® master, right-click on [I/O-Configuration → I/O Devices] and select Append Device....

3. In the following window, select [EtherCAT → EtherCAT] and click on OK.
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Illustration 74: Add an EtherCAT Master to the Project

4. Select Device 1 (EtherCAT) and select the correct Network Adapter on the right side of the window in the Adapter tab.

5. To add a Power Supply Module, right-click on Device1 (EtherCAT) and select Append Box....

6. In the Insert EtherCAT Device window, select [Danfoss GmbH → VLT® FlexMotion → VLT® Power Supply Module PSM 510] and click
on OK.

7. To add a Decentral Access Module, right-click on Device1 (EtherCAT) and select Append Box....

8. In the Insert EtherCAT Device window, select [Danfoss GmbH → VLT® FlexMotion → VLT® Decentral Access Module] and click on OK.

9. To add an Auxiliary Capacitors Module, right-click on Device1 (EtherCAT) and select Append Box....

10. In the Insert EtherCAT Device window, select [Danfoss GmbH → VLT® FlexMotion → VLT® Auxiliary Capacitors Module] and click on
OK.

11. To add a servo drive to the Decentral Access Module DAM 510, right-click on Box 1 (VLT® Decentral Access Module) and select
Append Box....

12. In the Insert EtherCAT Device window, select [Danfoss GmbH → VLT® FlexMotion → VLT® MSD 510 Integrated Servo Drive Standard]
and click on OK.

CommissioningOperating Guide  | VLT® Multiaxis Servo Drive MSD 510 System

AQ262450196490en-000101 / 175R1170| 105Danfoss A/S © 2019.10



e3
0b

h5
17

.1
0

Illustration 75: Add a Servo Drive to the Project
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Illustration 76: TwinCAT System Manager after Appending the PLC Project and Adding a Decentral Access Module and 2 ISD
510 Servo Drives

13. Answer the question if the servo drive is used as an NC axis with No. If the servo drive is to be used as an NC axis, see 6.12.15
Configuration as a TwinCAT® NC Axis.

N O T I C E

- Add 1 entry to the EtherCAT® master of the TwinCAT System Manager for each physical servo drive, PSM 510,
DAM 510, and ACM 510. Add the servo drive to the correct DAM 510 line.
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6.12.11 I/O Configuration and I/O Mapping

Context:

When connecting >1 SDM 511/SDM 512 drive module or servo drive, connect port C (X2) of the previous servo drive to port A (X1) of
the next servo drive. Also carry out the port assignment for the Decentral Access Module (DAM 510).

If the hardware setup is already present, the TwinCAT® System Manager Scan devices function can be used to automatically add the
connected devices to the configuration in the correct order.

Using the TwinCAT® System Manager, configure the SDM 511/SDM 512 drive module or servo drive so that the PDO mapping matches
the requirements of the library.

Procedure (Example for an ISD 510 servo drive)

1. Click on the ISD 510 servo drive entry.

2. Select the Slots tab on the right side of the window.

3. Remove the current PDO configuration by selecting the entry Module 1 (CSV PDO) in the Slot box.

4. Click on X.

5. Select Library PDO in the Module box.

6. Click on <.
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Illustration 77: ISD 510 Servo Drive with Correct I/O Configuration

6.12.12 Attaching the Input and Output Variables to the Physical Data Points

Context:

Use the TwinCAT® System Manager to attach the input and output variables of the PLC program to the physical inputs and outputs of
the device. This ensures that the library has access to all necessary objects.

W A R N I N G

- Repeat steps 2–22 for Box 1 (VLT® Power Supply Module) and the instance myPSM.

- Repeat steps 2–22 for Box 2 (VLT® Decentral Access Module) and the instance myDAM.
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Procedure

1. Select Library TxPDO via menu [I/O-Configuration → I/O Devices → Device1 (EtherCAT) → Box 1 (VLT Decentral Access Module) →
Drive 1 (VLT ISD 510 Integrated Servo Drive) → Module 1 (Library PDO) → Library TxPDO].

2. Select all entries Lib pdo tx1 to Lib pdo tx9 on the right side of the window.
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Illustration 78: Attaching Inputs and Outputs to the Physical Data Points

3. Right-click and select Change Multi Link....

4. In the Attach Variable 36.0 Byte(s) (Input) window, select [PLC-Configuration → MyFirstFlexMotionProject → Standard
→ .myAxis.TPDO]. Ensure that the Matching Size option is selected in the Attach Variable window.

5. Click on OK.

6. Click on library RxPDO via menu [I/O-Configuration → I/O Devices → Device1 (EtherCAT™) → Box1 (VLT™ Decentral Access
Module) → Drive2 (VLT™ ISD 510 Integrated Servo Drive) → Module1 (Library PDO) → Library RxPDO].

7. Select all entries Lib pdo rx1 to Lib pdo rx9 on the right side of the window.

8. Right-click and select Change Multi Link....

9. In the Attach Variable 36.0 Byte(s) (Output) window, select [PLC-Configuration → MyFirstIsd510Project → Standard
→ .myAxis.RPDO].

10. Click on OK.

11. Right-click on WcState via menu [I/O-Configuration → I/O Devices → Device1 (EtherCAT™) → Box1 (VLT™ Decentral Access
Module) → Drive2 (VLT™ ISD 510 Integrated Servo Drive) → WcState] and select Change Link....

12. In the Attach Variable State (Input) window, select [PLC-Configuration → MyFirstIsd510Project → Standard → .myAxis.WcState].

13. Click on OK.

14. Right-click on State via menu [I/O-Configuration → I/O Devices → Device1 (EtherCAT™) → Box1 (VLT™ Decentral Access Module)
→ Drive2 (VLT™ ISD 510 Integrated Servo Drive) → InfoData] and select Change Link....

15. In the Attach Variable State (Input) window, select [PLC-Configuration → MyFirstIsd510Project → Standard → .myAxis.State].

16. Click on OK.

17. Right-click on netId via menu [I/O-Configuration → I/O Devices Device1 (EtherCAT→) → Box1 (VLT® Decentral Access Module) →
Drive2 (VLT→ ISD 510 Integrated Servo Drive) → InfoData → AdsAddr] and select Change Link....

18. In the Attach Variable netId (Input) window, select [PLC-Configuration → MyFirstIsd510Project → Standard → .myAxis.AmsNetId].

19. Click on OK.

20. Right-click on Port via [I/O-Configuration → I/O Devices → Device1 (EtherCAT→) → Box1 (VLT→ Decentral Access Module) →
Drive2 (VLT→ ISD 510 Integrated Servo Drive) → InfoData → AdsAddr] and select Change Link....
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21. In the Attach Variable port (Input) window, select [PLC-Configuration → MyFirstIsd510Project → Standard
→ .myAxis.NodeNumber].

22. Click on OK.

6.12.13 Transferring the Mappings back to the PLC Program

To transfer the mappings back to the PLC program, select Activate Configuration... in menu item Actions.

After a rebuild in TwinCAT® PLC Control, the TwinCAT® configuration is according to illustration 79 (here myAxis and mySecondAxis are
instances of AXIS_REF_DDS, myPSM is an instance of PSM_REF, and myDAM is an instance of DAM_REF). The concrete addresses can be
different.
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Illustration 79: TwinCAT® Configuration: I/O Mapping of 2 Servo Drives, 1 PSM 510, and 1 DAM 510

N O T I C E

- Connect the PSM 510, DAM 510, ACM 510, and SDM 511/SDM 512 to 1 SYNC unit and the ISD 510/DSD 510 servo drives to
another. This protects against interruptions in communication to the PSM 510 and DAM 510 if the UAUX supply to the
decentral servo drives is switched off due to an error.

6.12.14 Setting the PLC Cycle Time in TwinCAT® PLC Control

Context:

The minimum cycle time is 400 µs. The MSD 510 devices can run EtherCAT® cycle times in multiples of 400 µs or 500 µs. The devices are
automatically parameterized by the PLC on start-up, depending on the EtherCAT® configuration of the physical interface. To access the
system base time, select [SYSTEM-Configuration → Real-Time Settings] in the TwinCAT® System Manager. Multiples of this base time
can then be used as EtherCAT® cycle times.
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N O T I C E

- Set the task cycle time of the PLC program to be the same as the EtherCAT® cycle time. Otherwise data may be lost and
performance reduced.

Procedure

1. Double-click Task configuration in the Resources tab.

2. Ensure that the PLC cycle time is the same as the EtherCAT® cycle time.
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Illustration 80: Task Configuration to Parameterize the PLC Cycle Time

N O T I C E

- After changing the task cycle time in TwinCAT® PLC Control, carry out a ReScan of the PLC configuration inside
the TwinCAT® System Manager to update the settings. Afterwards, activate the configuration in the PLC.

6.12.15 Configuration as a TwinCAT® NC Axis

Context:

The servo drives can be used with the built-in NC functionality of TwinCAT®.
Everything that is related to the PSM 510 and DAM 510 must be done as described in 6.12.2 Creating a TwinCAT® Project.

Procedure

1. In addition to the Danfoss_VLT_ServoMotion_V_x_y_z.lib file, include the TcMC2.lib file.

2. Create 1 instance of AXIS_REF (instead of AXIS_REF_DDS) for each ISD 510/DSD 510 servo drive that is used as an NC axis.

3. Append the PLC project into the TwinCAT® System Manager, import the devices, and add them to TwinCAT®, however in the last
step, answer the question if the servo drive is used as an NC axis with Yes. Then an NC task is created automatically.

6.12.15.1 I/O Configuration for Servo Drives used as NC Axes

Context:

In the TwinCAT® System Manager, select a different I/O Configuration for the servo drives used as NC axes.
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Procedure

1. Depending on the mode of operation to be used, select either the slot CSP PDO or CSV PDO. Per default, CSV PDO is mapped and
pre-selected. Map the following variables if the VLT® Multiaxis Servo Drive servo drive is required to work with CSP PDO:

In the Settings Tab of the NC Axis, select [NC-Configuration → NC-Task 1 SAF → Axes → Axis 1]. Click on the Link To (all Types)...
button and select the desired servo drive.

2. In the same tab, select the preferred Unit.

3. Depending on the selected unit, adjust the Scaling Factor for the axis encoder via menu [NC-Configuration → NC-Task 1 SAF →
Axes → Axis 1 → Axis 1_Enc] in the Parameter tab. Example: When the unit Degrees is selected, the scaling factor is 360°/220 =
0.00034332275390625.

4. Set the Reference Velocity in the Parameter tab via menu [NC-Configuration → NC-Task 1 SAF → Axes → Axis 1 → Axis 1_Enc.

5. Set the Output Scaling Factor (Velocity) to 125.

6. Test the functionality and the configuration in the Online tab of the axis.

6.12.16 Connecting to the PLC

Information on how to connect to the PLC can be found in detail in the Beckhoff Information System .

Open the information system and go to [TwinCAT 2 → TwinCAT System Manager → Operation → Controls → Choose Target System].

6.13 Programming Guidelines for Automation Studio™ and TwinCAT®

Recommendations for implementation:

• Initialize parameters that usually do not change only once at the beginning of the program. In Automation Studio™, use the _INIT
section.

• Call up function blocks that provide status or error information with Enable input at the beginning of the program.

• Use 1 instance of the function block MC_Power_DDS for every axis to control its power stage. Call up this function block in every
PLC cycle.

• Use 1 instance of the function block DD_Power_PSM for every Power Supply Module to control the DC-link voltage on the output.
Call up this function block in every PLC cycle.

• Use 1 instance of the function block DD_Power_DAM for every Decentral Access Module to control the DC-link voltage on the
output. Call up this function block in every PLC cycle.

• Use 1 instance of the function block DD_Power_ACM for every Auxiliary Capacitors Module to control the connection between the
DC-link and the ACM 510. Call up this function block in every PLC cycle.

• Call up function blocks that execute (motion) commands at the end of the program.

• Do not use any POUs from the library (folder) DDS_Intern.

• Do not change the reference to the axis on a function block while it is busy.

N O T I C E

- The full parameter list can be found in the VLT® Servo Drive System ISD 510, DSD 510, MSD 510 Programming Guide.
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6.14 Programming with SIMOTION SCOUT®

6.14.1 Requirements for Programming with SIMOTION SCOUT®

The following files are required to integrate the servo system modules into a SIMOTION SCOUT® project:

Table 19: Required Files

System Module File required

Whole servo system Package of libraries for the MSD 510 servo system: Danfoss_VLT_ServoMo-
tion_V_x_y_z.zip

Online Help file(.chm): Programming with SIMOTION SCOUT®

Servo Drive Module SDM 511/SDM 512 and
ISD 510/DSD 510 servo drive

GSDML file (General station description):

GSDML-V2.31-Danfoss-DDS-yyyymmdd.xml

Power Supply Module PSM 510 GSDML file (General station description):

GSDML-V2.31-Danfoss-PSM-yyyymmdd.xml

Decentral Access Module DAM 510 GSDML file (General station description):

GSDML-V2.31-Danfoss-DAM-yyyymmdd.xml

Auxiliary Capacitors Module ACM 510 GSDML file (General station description):

GSDML-V2.31-Danfoss-ACM-yyyymmdd.xml

6.14.2 Connecting to the PLC

Information on how to connect to the PLC can be found in detail in the SIMOTION SCOUT® Help.

Open SIMOTION SCOUT® and go to [Help → Help Topics → Getting Started with SIMOTION SCOUT → Download the project to the
target system → Connect to selected target devices → Go online].

6.14.3 Creating a SIMOTION SCOUT® Project

Information on how to install SIMOTION SCOUT®® can be found in detail in the SIMOTION SCOUT® Configuration Manual.

N O T I C E

- SIMATIC STEP 7 V5.5 or higher with HF11 must be installed to create a project.

Information on how to create a project in SIMOTION SCOUT® can be found in detail in the SIMOTION SCOUT® online help. Open
SIMOTION SCOUT® and go to [Help → Help Topics → Getting started with SIMOTION SCOUT → Create SIMOTION device and configure
PG/PC communication connection].
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6.14.4 Including the Servo Motion Libraries into a SIMOTION SCOUT® Project

Context:

The folder LIBRARIES in the Project tab contains these libraries:

• DDS_Drive

- Contains program organization units (POUs) defined by PLCopen® (name starting with MC_) and POUs defined by Danfoss
(name starting with DD_). The Danfoss POUs provide additional functionality for the servo drive.

- It is possible to combine POUs defined by PLCopen® with POUs defined by Danfoss.

- The names of the POUs that target the SDM 511/SDM 512 drive modules and servo drives all end with _DDS.

• DDS_PSM

- Contains POUs defined by Danfoss (name starting with DD_) and provide the functionality for the Power Supply Module
(PSM 510).

- The names of the POUs that target the PSM 510 all end with _PSM.

• DDS_DAM

- Contains POUs defined by Danfoss (name starting with DD_) and provide the functionality for the Decentral Access Module
(DAM 510).

- The names of the POUs that target the DAM 510 all end with _DAM.

• DDS_ACM

- Contains POUs defined by Danfoss (name starting with DD_) and provide the functionality for the Auxiliary Capacitors Module
(ACM 510).

- The names of the POUs that target the ACM 510 all end with _ACM.

• DDS_BasCam

- Contains POUs for the creation of basic CAMs.

• DDS_LabCam

- Contains POUs for the creation of labeling CAMs.

• DDS_Intern

- Contains POUs that are needed internally for the libraries.

- Do not use these POUs in an application.

When integrating the DDS_Drive package, some standard libraries are integrated automatically, unless they are already part of the
project.
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Illustration 81: Project Tree after Including Danfoss Servo Motion Libraries

N O T I C E

- Do not remove or rename these libraries.
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Procedure

1. Extract the files from the Danfoss_VLT_ServoMotion_V_x_y_z.zip file (according to the location on the hard drive).

The DDS_Xxxx.xml file and XML_DDS_Xxxx folder must be located together in the same folder to import the library.

2. In the Project tab, right-click on LIBRARIES and select [Export/import → Import folders/objects].
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Illustration 82: Import Library

3. Select file DDS_Intern.xml according to the location on the hard drive.

4. Click on OK. Now the library is integrated into the SIMOTION SCOUT® project.

5. Repeat steps 2–4 for DDS_BasCam.xml, DDS_Drive.xml, DDS_LabCam.xml, DDS_PSM.xml, DDS_DAM.xml, and DDS_ACM.xml.

6.14.5 Importing Devices into SIMOTION SCOUT®

Context:

N O T I C E

- For each physical servo drive, PSM 510, DAM 510, or ACM 510, add 1 entry to the PROFINET® Ethernet network in the HW
Config tool.
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Procedure

1. Open the HW Config tool.

2. Select [Options → Install GSD File...].

3. To add an SDM 511/SDM 512 drive module or servo drive, select one of the following xml files (according to the location on the
hard drive) and click on Install.

GSDML-V2.31-Danfoss-DDS-yyyymmdd.xml

GSDML-V2.32-Danfoss-DDS-yyyymmdd.xml

GSDML-V2.33-Danfoss-DDS-yyyymmdd.xml

GSDML-V2.34-Danfoss-DDS-yyyymmdd.xml

4. Repeat steps 2 and 3 for:

Power Supply Module (PSM 510): GSDML-V2.31-Danfoss-PSM-yyyymmdd.xml

Decentral Access Module (DAM 510): GSDML-V2.31-Danfoss-DAM-yyyymmdd.xml

Auxiliary Capacitors Module (ACM 510): GSDML-V2.31-Danfoss-ACM-yyyymmdd.xml

5. Drag the device Danfoss Drive Servo IRT on to an existing PROFINET® Ethernet network.

Find the servo drive device named Danfoss Drive Servo IRT by expanding the PROFINET IO entry in the hardware catalog on
the right side of the screen and selecting [Additional Field Devices → Drives → VLT® FlexMotion]. If the device is not visible,
update the hardware catalog by selecting [Options → Update catalog).

6. Expand Drive Object 1 and folder Profile in the hardware catalog on the right side of the screen and drag the Danfoss Telegram to
the free slot of Drive Object 1 at the bottom of the screen.
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Illustration 83: Dragging the Danfoss Telegram to a Free Slot

7. To set the communication parameters, double-click on the icon depicting the servo drive in the main window showing the
Ethernet network.

8. In the General tab, enter a name in field Device name.

9. In the General tab, click on the Ethernet... button to set the IP address of the servo drive and then click on OK.

10. Repeat steps 6–9 for:

Power Supply Module (PSM 510): VLT PSM IRT

Decentral Access Module (DAM 510): VLT DAM IRT

Auxiliary Capacitors Module (ACM 510): VLT ACM IRT
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6.14.6 Assigning IP Configuration and Device Name

Context:

N O T I C E

- If more than 1 servo drive is used in the same PROFINET® network, each servo drive must have a different name and IP
address.

- The IP address assignment is also required when using indirect communication via the VLT® Toolbox software (see the VLT®

Servo Drive System ISD 510, DSD 510, MSD 510 Programming Guide for further information).
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Procedure

1. Open menu [PLC → Ethernet → Edit Ethernet Node].

2. In the next window, click on Browse.
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Illustration 84: Edit Ethernet Node

All accessible Ethernet nodes are shown in this window.

The ISD 510 servo drives are listed under device type VLT® ISD 510.

The DSD 510 servo drives are listed under device type VLT® DSD 510.

The SDM 511/SDM 512 servo drive modules are listed under device type VLT® SDM 510.

3. Select the desired servo drive and click on OK (use the Flash button to identify the specific servo drive).
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Illustration 85: Selecting the Servo Drive

4. In the Edit Ethernet Node window, select the option Use IP parameters.

5. Enter the IP address and Subnet mask and click on Assign IP configuration.
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Illustration 86: Entering the IP Address and Assigning the IP Configuration

6. Enter the device name that was previously selected and click on Assign Name and then Close.
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Illustration 87: Assigning the Device Name

6.14.7 Creating a Sync Domain

Context:

A sync domain is a group of PROFINET® devices synchronized to a common cycle clock. One device has the role of the sync master
(clock generator). All other devices are sync slaves.

N O T I C E

- All devices that exchange data via Isochronous Real-Time (IRT) must belong to the same sync domain.
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Procedure

1. Open the HW Config tool.

2. Select the station with the PROFINET® devices to be involved in IRT communication.

3. Select the PROFINET® I/O interface in the section Station/IO system.

4. Select the menu [Edit → PROFINET IO → Domain management].
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Illustration 88: Domain management

5. In the Sync Domain tab, select the station in the upper field of the Nodes section.

6. In the lower field of the Nodes section, double-click on the device that should be configured as the sync master.

7. When the Device properties window opens, select Sync master as Synchronization role and click on OK.

e3
0b

h5
27

.1
0

Illustration 89: Device properties: Sync Master
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8. In the Domain management window, select all devices to be configured as sync slaves in the Nodes section (keep the CTRL key
depressed to select >1 device).

9. Click on the Device Properties button.

10. In the Device Properties window, select Sync slave as Synchronization role and click on OK.

e3
0b

h5
28

.1
0

Illustration 90: Device properties: Sync Slave

11. In the Domain management window, click on OK.

12. Select the station with the PROFINET® devices.

13. Select the menu [Edit → Object Properties].

14. In the next window, open the Isochronous Tasks tab, select the isochronous mode for I/O data change, and click on OK.
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Illustration 91: Use I/O Data Isochronously to the Servo

15. Click on the VLT® ISD 510 IRT device.

16. Double-click on the PN-IRT-Inteface in the Module.

17. In the next window, open the IO Cycle tab and set field Assign IO device in isochronous mode to Servo.

CommissioningOperating Guide  | VLT® Multiaxis Servo Drive MSD 510 System

AQ262450196490en-000101 / 175R1170| 123Danfoss A/S © 2019.10



e
3

0
b

g
3

6
4

.1
0

Illustration 92: Assign IO Device in Isochronous Mode

6.14.8 Configuring a Topology

Context:

The topology must be configured and parameterized.
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Procedure

1. Open the HW Config tool.

2. Select the path for the PROFINET® I/O system or PROFINET®module, for example a Danfoss MSD 510 series.

3. Select the menu [Edit → PROFINET IO → Topology].

4. In the next window, select the Graphic view tab.
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Illustration 93: Graphic View Tab in Topology Editor

5. Connect the PROFINET® device with the station. Establish connections between ports by holding down the left mouse button and
drawing a line between the 2 ports.

6. Once all connections are made, click on OK.
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6.14.9 Defining Send Clock and Update Time

6.14.9.1 Configuring the Send Clock Time

Procedure

1. Open the HW Config tool.

2. Select the station with the PROFINET® devices to be involved in IRT communication, for example PNxIO.

3. Select the menu [Edit → PROFINET IO → Domain management].

4. In the next window, open the Sync Domain tab and in the Send clock time [ms] field, select an appropriate time for the process, for
example 1.000 ms, then click on OK.
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Illustration 94: Configuring a Send Clock for PROFINET® IRT
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6.14.9.2 Configuring the Update Time

Procedure

1. Open the HW Config tool.

2. Select the path for the PROFINET® I/O system.

3. Select the menu [Edit → Object properties].

4. In the next window, open the Update Time tab, highlight the I/O device and click on the Edit button.

5. In the next window (Edit Update Time/Mode), select the Update Time and click on OK.
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Illustration 95: Set Update Time

N O T I C E

- The system cycle clocks of the PLC program must be the same as the PROFINET® send clock, otherwise data may be
lost and performance reduced.

6.14.10 Accessing Inputs and Outputs

Context:

SIMOTION SCOUT® provides access to the device inputs and outputs of the SIMOTION device via the process image of cyclic tasks using
I/O variables.
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Procedure

1. Open the Project tab and double-click on the ADDRESS LIST element in the device subtree, for example C240 [C240 PN].
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Illustration 96: Address List in the Project Navigator

2. In the next window (detailed view), create 1 variable for incoming and outgoing PPO data for each device.
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Illustration 97: Address List Detailed View

3. Set the following properties for each variable:

Name (of the I/O variable)

I/O address

Data type: ARRAY OF BYTE

Array length: 36

Process image: IPOsynchronousTask

N O T I C E

- The I/O address must fit the configuration of the device in the HW Config tool.

- I/O variables can only be created in offline mode.

6.14.11 Programming using the Danfoss VLT® Servo Motion Library

Before using data types, functions, or function blocks from libraries, the following construct must be used in the interface section:

USELIB DDS_BasCam, DDS_Drive, DDS_LabCam, DDS_PSM, DDS_DAM, DDS_ACM;

More information on how to use data types, functions, and function blocks from libraries can be found in detail in the online help for
SIMOTION SCOUT®. Open the SIMOTION SCOUT® and go to [Help → Help Topics → Programming → Integration of ST in SIMOTION →
Using libraries → Using data types, functions and function blocks from libraries].
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N O T I C E

- Do not use the POUs, Constants, and User-Defined Data Types (UDT) that start with iDD_ in an application.

6.14.12 Instantiating AXIS_REF_DDS in SIMOTION SCOUT®

Create 1 instance of AXIS_REF_DDS (located in folder DDS_Drive) for every servo drive that has to be controlled or monitored. Each
instance of AXIS_REF_DDS is the logical representation of 1 physical servo drive.

N O T I C E

- The instance of the AXIS_REF_DDS structure must be created as a global variable (variable in the interface section of a unit
declared with VAR_GLOBAL).

In the AXIS_REF_DDS structure, only assign the variable InputLogAddress once at the beginning of the application program for each
axis. This is to specify the input logical base address of the I/O module from the HW Config. For this initialization, use the system
function _getLogicalAddressOfIoVariable(). Only assign the variable InputLogAddress once in the 1st PLC cycle for initialization.

In the AXIS_REF_DDS structure, assign the variable Quality at the beginning of the application program for each axis in every cycle. Use
the system function _quality.<I/Ovariable>, whereby <I/Ovariable> is the variable containing the cyclic data that was assigned in the
ADDRESS LIST. Carry out this assignment in every PLC cycle.

Call the function DD_UpdateProcessInput_DDS at the beginning of the application program for each device in every cycle. Call the
function DD_UpdateProcessOutput_DDS at the end of the application program for each device in every cycle.

N O T I C E

- Only create instructions and other program parts between the calls of DD_UpdateProcessInput and
DD_UpdateProcessOutput.

6.14.13 Instantiating PSM_REF in SIMOTION SCOUT®

Create 1 instance of PSM_REF (located in folder DDS_PSM) for every Power Supply Module (PSM 510) that has to be controlled or
monitored. Each instance of PSM_REF is the logical representation of 1 physical PSM.

N O T I C E

- The instance of the PSM_REF structure must be created as a global variable (variable in the interface section of a unit
declared with VAR_GLOBAL).
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In the PSM_REF structure, assign the variable Quality at the beginning of the application program for each Power Supply Module in
every cycle. Use the system function _quality.<I/Ovariable>, whereby <I/Ovariable> is the variable containing the cyclic data that was
assigned in the ADDRESS LIST. Carry out this assignment in every PLC cycle.

Call the function DD_UpdateProcessInput_PSM at the beginning of the application program for each device in every cycle. Call the
function DD_UpdateProcessOutput_PSM at the end of the application program for each device in every cycle.

N O T I C E

- Only create instructions and other program parts between the calls of DD_UpdateProcessInput and
DD_UpdateProcessOutput.

6.14.14 Instantiating DAM_REF in SIMOTION SCOUT®

Create 1 instance of DAM_REF (located in folder DDS_DAM) for every Decentral Access Module (DAM 510) that has to be controlled or
monitored. Each instance of DAM_REF is the logical representation of 1 physical DAM.

N O T I C E

- The instance of the DAM_REF structure must be created as a global variable (variable in the interface section of a unit
declared with VAR_GLOBAL).

In the DAM_REF structure, assign the variable Quality at the beginning of the application program for each Decentral Access Module in
every cycle. Use the system function _quality.<I/Ovariable>, whereby <I/Ovariable> is the variable containing the cyclic data that was
assigned in the ADDRESS LIST. Carry out this assignment in every PLC cycle.

Call the function DD_UpdateProcessInput_DAM at the beginning of the application program for each device in every cycle. Call the
function DD_UpdateProcessOutput_DAM at the end of the application program for each device in every cycle.

N O T I C E

- Only create instructions and other program parts between the calls of DD_UpdateProcessInput and
DD_UpdateProcessOutput.

6.14.15 Instantiating ACM_REF in SIMOTION SCOUT®

Create 1 instance of ACM_REF (located in folder DDS_ACM) for every Auxiliary Capacitors Module (ACM 510) that has to be controlled or
monitored. Each instance of ACM_REF is the logical representation of 1 physical ACM.

N O T I C E

- The instance of the ACM_REF structure must be created as a global variable (variable in the interface section of a unit
declared with VAR_GLOBAL).
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In the ACM_REF structure, assign the variable Quality at the beginning of the application program for each Auxiliary Capacitors Module
in every cycle. Use the system function _quality.<I/Ovariable>, whereby <I/Ovariable> is the variable containing the cyclic data that was
assigned in the ADDRESS LIST. Carry out this assignment in every PLC cycle.

Call the function DD_UpdateProcessInput_ACM at the beginning of the application program for each device in every cycle. Call the
function DD_UpdateProcessOutput_ACM at the end of the application program for each device in every cycle.

N O T I C E

- Only create instructions and other program parts between the calls of DD_UpdateProcessInput and
DD_UpdateProcessOutput.

6.14.16 Global Compiler Settings

Context:

Activate the global compiler settings Permit language extensions.

Procedure

1. Open the menu [Options → Settings].

2. In the next window, select the Compiler tab.

3. Activate the checkbox Permit language extensions and click on OK.
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Illustration 98: Global Compiler Settings

6.14.17 Assigning Tasks

Context:

To guarantee synchronous operation, the application must use a Synchronous Task and a Peripheral Fault Task to evaluate the alarms.
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Procedure

1. Open the Project tab.

2. Double-click on EXECUTION SYSTEM in the device subtree.
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Illustration 99: Execution System in the Project Navigator

3. In the next window, expand entry Execution levels and then select OperationLevels and then SynchronousTask in the tree structure.

4. In the SynchronousTask window, activate checkbox Use task in execution system.

5. Click on the new entry IPOsynchronousTask in the tree structure.

6. In the Program assignment area at the left side of the Synchronous Task window, assign the program by selecting it and clicking on
the [>>] button. The program will then be moved to the Programs used section on the right side.
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Illustration 100: IPOsynchronousTask in Execution System

7. In the Task configuration tab, set the Number of level overflows in the IPO cycle clock to 1 and the IPOsynchronousTask / IPO cycle clock
to 50%.

CommissioningOperating Guide  | VLT® Multiaxis Servo Drive MSD 510 System

AQ262450196490en-000101 / 175R1170132 | Danfoss A/S © 2019.10



e
3

0
b

g
3

7
2

.1
0

Illustration 101: IPOsynchronousTasks Configuration

8. Expand entry SystemInterruptTasks in the tree structure and select the new entry PeripheralFaultTask.

9. In the PeripheralFaultTask window, activate checkbox Use task in execution system.

10. In the Program assignment area at the left side of the PeripheralFaultTask window, assign the program by selecting it and clicking
on the [>>] button. The program will then be moved to the Programs used section on the right side.

11. Click on Close to save and compile the settings.

6.15 Programming Guidelines for SIMOTION SCOUT®

Recommendations for implementation:

• Only assign the variable InputLogAddress in the AXIS_REF_DDS structure once for each axis at the beginning of the program. Use
the system function _getLogicalAddressOfIoVariable to get this address from the I/O variable of the address list. Use the input
address of the module as the I/O variable. Only assign this variable in the 1st PLC cycle for initialization.

• Initialize parameters that usually do not change only once at the beginning of the program.

• Only assign the variable Quality in the AXIS_REF_DDS structure once for each axis at the beginning of the program. Use the system
function _quality.var-name. Carry out this check for every PLC cycle.

• Call up the function blocks DD_UpdateProcessInput_DDS and DD_UpdateProcessOutput_DDS for every axis to update the process
image partition of inputs and outputs. Call up these function blocks in every PLC cycle.

• Only create instructions and other program parts between calling up function blocks DD_UpdateProcessInput_DDS and
DD_UpdateProcessOutput_DDS.

• Call up function blocks that provide status or error information with Enable input at the beginning of the program.

• Use 1 instance of function block MC_Power_DDS for every axis to control its power stage. Call up this function block in every PLC
cycle.

• Use 1 instance of function block DD_Power_PSM for every Power Supply Module (PSM 510) to control the DC-link voltage on the
output lines. its power stage. Call up this function block in every PLC cycle.

• Use 1 instance of function block DD_Power_DAM for every Decentral Access Module (DAM 510) to control the DC-link voltage on
the output lines. its power stage. Call up this function block in every PLC cycle.

• Use 1 instance of function block DD_Power_ACM for every Auxiliary Capacitors Module (ACM 510) to control the DC-link voltage on
the output lines. its power stage. Call up this function block in every PLC cycle

• Call up function blocks that execute (motion) commands at the end of the program.

• Do not use any UDTs, POUs, enumerations, or constants starting with the prefix iDD_.

• Do not change the reference to the axis on a function block while it is busy.
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6.16 VLT® Servo Toolbox Software

6.16.1 Overview

The VLT® Servo Toolbox is a standalone PC software designed by Danfoss. It is used for parameterization and diagnostics of the system
modules. It is also possible to operate the devices in a non-productive environment.

The VLT® Servo Toolbox contains several subtools, which provide various functionalities.

Table 20: Important Subtools

Subtool Description

Scope For visualization of the tracing functionality of the servo drives, the Power Supply Module (PSM 510),
the Decentral Access Module (DAM 510), and the Auxiliary Capacitors Module (ACM 510).

Parameter list For reading/writing parameters.

Firmware update For updating the firmware on the devices.

Drive control For operating the servo drives for testing purposes.

PSM control For operating the Power Supply Module (PSM 510) for testing purposes.

DAM control For operating the Decentral Access Module (DAM 510) for testing purposes.

ACM control For operating the Auxiliary Capacitors Module (ACM 510) for testing purposes.

CAM editor For designing CAM profiles for the servo drives.

Configuration parameter For setting up the motor and feedback parameters, and PID settings.

Drive commissioning For motor feedback adjustment and inertia measurement.

The detailed description of the VLT® Servo Toolbox functionality and the full parameter lists can be found in the VLT® Servo Drive
System ISD 510, DSD 510, MSD 510 Programming Guide.

6.16.2 System Requirements

To install the VLT® Servo Toolbox software, the PC must meet the following requirements:

• Supported hardware platforms: 32.bit, 64-bit.

• Supported operating systems: Windows 7, Windows 8.1, Windows 10.

• .NET framework version: 4.7.

• Minimum hardware requirements: 512 MB RAM, Intel Pentium 4 with 2.6 GHz or equivalent, 20 MB hard disk space.

• Recommended hardware requirements: Minimum 1 GB RAM, Intel Core i5/i7 or compatible.

6.16.3 Installing the VLT® Servo Toolbox Software

Context:

Administrator rights are required to install the software with the Windows operating system. If necessary, contact your system
administrator.
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Procedure

1. Check that your system meets the system requirements specified in 6.16.2 System Requirements.

2. Download the VLT® Servo Toolbox installation file from the Danfoss website.

3. Right-click on the .exe file and select Run as administrator.

4. Follow the on-screen instructions to complete the installation process.

6.16.4 VLT® Servo Toolbox Communication

6.16.4.1 Overview

This chapter describes the Ethernet-specific network interface settings needed by the VLT® Servo Toolbox. There are 2 basic
communication methods: direct communication and indirect communication. Their particular network settings are described in the
respective sections.

Read and perform the steps with care. Incorrect network configurations can lead to loss of connectivity of a network interface.

6.16.4.2 Firewall

Depending on the firewall settings and the fieldbus used, the messages sent and received by the VLT® Servo Toolbox may be blocked
by the firewall on the VLT® Servo Toolbox host system. This may lead to a loss of communication and the inability to communicate with
the devices on the fieldbus. Therefore, ensure that the VLT® Servo Toolbox is allowed to communicate through the firewall on the VLT®

Servo Toolbox host system. Inappropriate changes to firewall settings may lead to security issues.

N O T I C E

- When using a dedicated network interface, the VLT® Servo Toolbox must be allowed to communicate specifically through
this network interface.

6.16.4.3 Indirect Communication

6.16.4.3.1 Overview

Communication between MSD 510 devices and the VLT® Servo Toolbox through a PLC is called indirect communication. Ethernet-
based fieldbus communication (marked A in the graphic) takes place between the PLC and the MSD 510 devices. However there is
non-fieldbus communication between the PLC and the VLT® Servo Toolbox host system (marked B in the graphic).

In the scenario in the graphic, the PLC has the master function and uses cyclic communication with the devices. Therefore, not all
functionalities of the VLT® Servo Toolbox, for example the drive control, can be used.

The restrictions when using indirect communication are detailed in the VLT® Servo Drive System ISD 510, DSD 510, MSD 510
Programming Guide.
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Illustration 102: Logical View of Indirect Ethernet-based Fieldbus Communication (Communication via PLC)

N O T I C E

- The logical view only shows the connectivity from a high-level software perspective and does not reflect the actual physical
topology of the network.

6.16.4.3.2 Network Settings for Indirect Communication

Any network interface can be used to communicate through a PLC. A dedicated network interface is not required.

When establishing the communication through a PLC, the VLT® Servo Toolbox configures a routing table using the selected Network
Address Translation (NAT). Adding a route to the Windows routing table requires administrator privileges. Therefore, administrator
credentials may be requested when initializing the connection.

6.16.4.3.3 Enabling Indirect Communication

Context:

Carry out the following steps to enable indirect communication.

N O T I C E

When observing the network packets via Wireshark®, checksum offloading often causes confusion as the network packets to be
transmitted are handed over to Wireshark® before the checksums have been calculated. Wireshark® shows these empty
checksums as invalid, even though the packets contain valid checksums when they leave the network hardware later. Use 1 of
these 2 methods to avoid this checksum offloading problem:

- Turn off the checksum offloading in the network driver if possible.

- Turn off the checksum validation of the specific protocol in the Wireshark® preferences.

Disable IPv6 on the network interfaces used for communication on the PC:
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Procedure

1. Open the Network and Sharing Center.

2. Select Change adapter settings.

3. Right-click on the network interface used for fieldbus communication and select Properties.

4. If the TCP/IPv6 is available for the network interface, disable it.

6.16.4.3.4 Additional Settings for Indirect Communication with EtherCAT®

Context:

Set the IP address of the EtherCAT® Master:

Procedure

1. Open the TwinCAT® System Manager.

2. Select [I/O-Configuration → I/O Devices → Device1 (EtherCAT®)] and check the IP-address in the Adapter tab. The IP-address of the
PLC's network adapter may not be a link-local address (so not in the range of 169.254.0.1 to 169.254.255.254).

3. If necessary, change the IP-address inside the IPv4 Protocol properties according to the given operating system. This can be done
on the controller locally or via Remote Desktop.

6.16.4.3.5 Activating the IP Routing in the EtherCAT® Master

Context:

The procedure described here may vary depending on the type of PLC and operating system installed.

Procedure

1. Open the TwinCAT® System Manager.

2. Click on Advanced Settings... via menu [I/O-Configuration → I/O Devices → Device1 (EtherCAT)] in the EtherCAT tab.

3. Select EoE Support in the Advanced Settings window.

4. Enable Connect to TCP/IP Stack in the Windows Network section.

5. Enable IP Enable Router in the Windows IP Routing section.

6. Reboot the PLC for the changes to take effect.

6.16.4.3.6 Setting the IP Address of the EtherCAT® Slave

Context:

The procedure for setting the IP Address of the EtherCAT® slave is valid for:

• ISD 510/DSD 510 servo drives

• Power Supply Module (PSM 510)

• Decentral Access Module (DAM 510)

• Auxiliary Capacitors Module (ACM 510)

• Servo Drive Module SDM 511/SDM 512
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N O T I C E

- The last number of the IP address is the ID that is used in the VLT® Servo Toolbox to identify the device.

Procedure

1. Open the TwinCAT® System Manager.

2. Click on Advanced Settings... under [I/O-Configuration → I/O Devices → Device1 (EtherCAT) → Box 1 (VLT® Decentral Access
Module → Drive 2 (VLT® Integrated Servo Drive ISD 510)] in the EtherCAT® tab.

3. Select [Mailbox → EoE] in the Advanced Settings window.

4. Enable Virtual Ethernet Port and enter a valid IP-address.

5. Each slave in the configuration requires an IP-address. This address is reassigned with every transition from INIT to Pre-Operational
state of the slave state machine. The IP communication of the slaves is deactivated per default.

6.16.4.3.7 Additional Settings for Indirect Communication with PROFINET®

6.16.4.3.7.1 Overview

Each PROFINET© device needs a device name and an IP address. The IP address and the device name are assigned by the I/O controller,
when the connection to the I/O device is established.

For the automatic detection of accessible nodes via a PG/PC interface with TCP/IP, connect the nodes to the same physical Ethernet
subnet as the PG/PC. If a node is located in a different physical Ethernet subnet, the IP address of the sought node can be specified.

To reach further nodes, accessible nodes provide the capability of adding IP addresses and subnets to the PG/PC interface. The new IP
addresses and subnets are then added to the Ethernet interface of the PG/PC.
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6.16.4.3.7.2 Adding IP Addresses and Subnets

Procedure

1. Open SIMOTION SCOUT®.

2. Select the menu [Project → Accessible notes].

3. If accessible nodes are found in another subnet, the Add IP addresses / subnet masks window is displayed and shows them.
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Illustration 103: Accessible Nodes

4. Click on Yes to accept the addresses.

5. The IP address/subnet mask is now added.

N O T I C E

- If more than one Danfoss servo drive is used in the same PROFINET® network, each servo drive must have a different
name and IP address.

- The last number of the IP address is the ID that is used in the VLT® Servo Toolbox software to identify the device.

- When the Accessible nodes tab is closed, the addresses are retained. The newly added addresses are only discarded
when SIMOTION SCOUT® is closed.

6.16.4.4 Direct Communication

6.16.4.4.1 Overview

For Ethernet-based fieldbus communication (direct communication), the VLT® Servo Toolbox must use a dedicated network interface
on the VLT® Servo Toolbox host system. Do not use this network interface simultaneously for any other communication.
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Illustration 104: Logical View of Direct Ethernet-based Fieldbus Communication

W A R N I N G

- The logical view only shows the connectivity from a high-level software perspective and does not reflect the actual physical
topology of the network.

6.16.4.4.2 Network Settings for Direct Communication with Ethernet POWERLINK®

Disable all network protocols except TCP/IPv4 on the network interface used for direct Ethernet POWERLINK® communication. This
prevents other PC software or the operating system using this network interface for other tasks, such as file and printer sharing and
network discovery. Disabling these protocols reduces the number of non-relevant packets sent over the network interface and thus
reduces the overall network load.
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6.16.4.4.3 Disabling Unused Protocols on the Network Interface on the PC

Procedure

1. Open the Network and Sharing Center.

2. On the left, click on Change adapter settings.

3. Right-click on the network interface used for fieldbus communication and select Properties.

4. Uncheck all checkboxes except the one for Internet Protocol Version 4 (TCP/IPv4).

5. Disable the IPv4 Checksum offload on the network interfaces as described in 6.16.4.3.2 Network Settings for Indirect
Communication.
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Illustration 105: Local Area Connection 2 Properties
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6.16.4.4.4 Setting the Correct Ethernet POWERLINK® Master IP Address

Procedure

1. Open the Network and Sharing Center.

2. On the left, click on Change adapter settings.

3. Right-click on the network interface used for fieldbus communication and select Properties.

4. Click on Internet Protocol Version 4 (TCP/IPv4) (the checkbox must be checked) and then click on Properties.

5. Select Use the following IP address and use 192.168.100.240 as the IP address and 255.255.255.0 as the subnet mask. Leave all other
fields empty.
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Illustration 106: Internet Protocol Version 4 (TCP/IPv4) Properties

6.16.4.4.5 Network Settings for Direct Communication with EtherCAT®

Configuration of the EtherCAT®-specific network interface on the VLT® Servo Toolbox host PC is not required.

6.17 VLT® Servo Toolbox Commissioning

6.17.1 Step 1: Opening the Main Window

The Main Window is the basis for all VLT® Servo Toolbox functionalities. It consists of the following components:
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Illustration 107: Main Window

Table 21: Main Window Description

Leg‐
end
num‐
ber

Name Description

1 Menu bar Contains the general functionalities for saving and loading projects, managing connections, showing
and changing settings, managing open subtools, and showing help contents.

2 Tool bar Contains shortcuts for saving and loading projects, connecting to and disconnecting from networks,
automatic searching for online devices, and manually adding devices.
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Leg‐
end
num‐
ber

Name Description

3 Online status
and state in-
formation

Online devices are indicated by a glowing light bulb next to the device ID.

• An online device is a logical device for which a physical device exists, which the VLT® Servo Toolbox
is connected to.

• The color indicates the state of the device and is device-specific.

Offline status
and state in-
formation

Offline devices are indicated by a gray light bulb next to the device ID.

• An offline device is a logical device without a corresponding physical device. An offline device can
represent a saved device configuration or state, for example for offline analysis or troubleshooting.
It also contains pre-configured parameter values to be written to a physical device.

4 Available sub-
tools

A subtool is opened by double-clicking the left mouse button on its name in the Device Environment, or
by selecting the entry and pressing the Enter key on the keyboard.

5 Device envi-
ronment

The Device Environment section of the Main Window lists all logical devices managed by the VLT® Servo
Toolbox, visualizes their states, and serves as the user interface for accessing the device functionalities.

The Device Environment window lists all available subtools for each added device.

See the VLT® Servo Drive System ISD 510, DSD 510, MSD 510, Programming Guide for further infor-
mation on the subtools.

6 Workspace This is the space for hosting the subtools and its size depends on the Main Window size. The subtools
can be maximized, minimized, horizontally or vertically aligned, or cascaded.

7 Watchlist win-
dow

Evaluates the parameter values of 1 or more devices by cyclically reading them from the devices. Al-
lows parameter values to be logged and saved to a text file. It is also possible to modify/write values in
the watchlist.

8 Output win-
dow

Shows operating information, warnings, and errors. Depending on the user settings, shows messages
of up to 3 different logging levels (high, medium, and low). Used for showing advanced error and warn-
ing information.

9 Status strip Shows the communication state of the VLT® Servo Toolbox. If connected to a network, it shows the
used hardware interface (for example, network adapter) and the network name.

6.17.2 Step 2: Connecting to Network

Context:

Pre-configure the appropriate communication settings to connect to a network (see 6.16.4.1 Overview).

Procedure

1. In the Main Window toolbar, click on the Connect to bus icon to open the Connect to Network window.

2. Select the fieldbus type and the network interface to connect to.

3. Click on OK to connect.

4. Verify that the connection is successful by checking the status strip at the bottom of the Main Window.
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Illustration 108: Connect to Network Window (Ethernet POWERLINK®)

6.17.3 Step 3: Scanning for Devices

Procedure

1. After verifying that the VLT® Servo Toolbox is connected to the selected network, click on the Scan for Devices icon in the toolbar to
trigger the device scan procedure.

N O T I C E

- If connected to an Ethernet POWERLINK® network in cyclic mode, select the scan range (minimum and maximum
IDs) in the next window to reduce the time needed for scanning. In all other cases, the complete ID range is
scanned.

2. When the scan is complete, a list of available devices is shown in the Select Devices window. Select which devices to add to the
Device Environment and click on OK.

3. All selected devices appear in the Device Environment window and automatically go online (indicated by a glowing light bulb next
to each device name).

6.18 Motion Library

6.18.1 Function Blocks

The PLC library provides function blocks that support the functionality of the servo system and comply with this standard:

PLCopen® Technical Specification Function blocks for motion control (Formerly Part 1 and Part 2) Version 2.0 March 17, 2011.

In addition to the PLCopen® functionality, Danfoss offers further functions for the servo system.

The following PLCopen® characteristics apply to all function blocks:

• Commanding (using the inputs)

• Signaling (behaviour of the outputs)

• General calling conventions
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N O T I C E

- See the VLT® Servo Drive System ISD 510, DSD 510, MSD 510 Programming Guide for further information on the
available function blocks and their behavior.

6.18.2 Simple Programming Template

TwinCAT®:

A basic sample PLC application for starting up the servo system with 1 Power Supply Module (PSM 510), 1 Decentral Access Module
(DAM 510), and 2 axes is provided. The project DDS_ServoMotion_SampleProject can be downloaded from the Danfoss website.

Automation Studio™:

Detailed information on how to open the sample project within the ISD package in Automation Studio™ can be found in the
Automation Studio™ Help. Open the B&R Help Explorer and go to [Programming → Examples → Adding sample programs] and follow
the instructions for library samples.

PROFINET®

The project DDS_ServoMotion_SampleProject is a basic sample PLC (C240PN) application for starting up the servo system with 1 Power
Supply Module (PSM 510), 1 Decentral Access Module (DAM 510), and 2 axes.

CommissioningOperating Guide  | VLT® Multiaxis Servo Drive MSD 510 System

AQ262450196490en-000101 / 175R1170146 | Danfoss A/S © 2019.10



7 Operation

7.1 Operating Modes

7.1.1 Supported Operating Modes

The servo drive implements several modes of operation. The behavior of the servo drive depends on the activated mode of operation.
It is possible to switch between the modes while the servo drive is enabled.

The supported modes of operation are according to CANopen® CiA DS 402 and there are also ISD-specific modes of operation. All
supported modes of operation are available for EtherCAT®, Ethernet POWERLINK®, and PROFINET®.

The various modes of operation are described in detail in the VLT® Servo Drive System ISD 510, MSD 510, DSD 510 Programming
Guide.

Table 22: Operating Modes

Mode Description

Inertia meas-
urement mode

This mode measures the inertia of an axis. It is used to measure the inertia of the servo drive and the external
load, and to optimize the control loop settings. The friction effects are eliminated automatically.

Profile velocity
mode

In profile velocity mode, the servo drive is operated under velocity control and executes a movement with con-
stant speed. Additional parameters, such as acceleration and deceleration, can be parameterized.

Profile position
mode

In profile position mode, the servo drive is operated under position control and executes absolute and relative
movements. Additional parameters, such as velocity, acceleration, and deceleration, can be parameterized.

Profile torque
mode

In profile torque mode, the servo drive is operated under torque control and executes a movement with constant
torque. Linear ramps are used. Additional parameters, such as torque ramp and maximum velocity, can be para-
meterized.

Homing mode In homing mode, the application reference position of the servo drive can be set. Several homing methods, such
as homing on actual position, homing on block, limit switch, or home switch are available.

CAM mode In CAM mode, the servo drive executes a synchronized movement based on a master axis. The synchronization is
done by a CAM profile that contains slave positions corresponding to master positions. CAMs can be designed
graphically with the ISD Toolbox software, or can be parameterized via the PLC. The guide value can be provided
by an external encoder, virtual axis, or the position of another axis. The different CAM profile types are described
in the VLT® Servo Drive System ISD 510, MSD 510 Programming Guide.

Gear mode In gear mode, the servo drive executes a synchronized movement based on a master axis by using a gear ratio
between the master and the slave position. The guide value can be provided by an external encoder, virtual axis,
or the position of another axis.

Cyclic synchro-
nous position
mode

In cyclic synchronous position mode, the trajectory generator of the position is located in the control device, not
in the servo drive.

Cyclic synchro-
nous velocity
mode

In cyclic synchronous velocity mode, the trajectory generator of the velocity is located in the control device, not
in the servo drive.
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7.1.2 Motion Functions

Table 23: Motion Functions

Function Description

Digital CAM
switch

This functionality controls whether the digital output is enabled or disabled, depending on the axis position. It per-
forms a function comparable to switches on a motor shaft. Forward and backward movements of the axis position
are allowed. On and off compensation and hysteresis can be parameterized.

Touch probe This functionality stores the position actual value after a rising or falling edge at the configured digital input.

7.2 Operating Status Indicators

The operating status of the MSD 510 system components is indicated via the LEDs on each module.

N O T I C E

- Status indicators are not reliable for safety functions. Only use them for general diagnostics during commissioning and
troubleshooting.

7.2.1 Operating LEDs on SDM 511 and SDM 512

STATUS SDM

LINK/ACT

DEV

SVS ST

NET ST

X1

X2

e3
0b

g5
75

.1
1

Illustration 109: Operating LEDs on SDM 511 and SDM 512
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Table 24: Operating LEDs on SDM 511 and SDM 512

LED Color Flash status Description

DEV Green On Device is in state Operation enabled.

Flashing Auxiliary voltage is applied.

Red On Device is in state Fault or Fault reaction active.

Flashing DC-link is not applied.

SVS ST Green On 24 V safety supply is applied.

Off 24 V safety supply is not applied.

NET ST Green/red Fieldbus depend-
ent

Network status of the device (see corresponding fieldbus stand-
ard).

LINK/ACT X1

(Link/activity status of In)

Green On Ethernet link established.

Flashing Ethernet link established and active.

Off No link.

LINK/ACT X2

(Link/activity status of Out)

Green On Ethernet link established.

Flashing Ethernet link established and active.

Off No link.

7.2.2 Operating LEDs on the PSM 510

STATUS PSM

LINK/ACT

DEV

SVS ST

NET ST

X1

X2

e3
0b

g5
76

.1
1

Illustration 110: Operating LEDs on PSM 510
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Table 25: Operating LEDs on PSM 510

LED Color Flash status Description

DEV Green On Device is in state Operation enabled.

Flashing Device is in state Standby or Power-up.

Red On Device is in state Fault or Fault reaction active.

Flashing Input mains is not applied.

SVS ST Green On 24 V safety supply is applied.

Off 24 V safety supply is not applied.

NET ST Green On Connected.

Orange On Online.

Red Flashing Initialization.

On Initialization failed or other error.

LINK/ACT X1

(Link/activity status of In)

Green On Ethernet link established.

Flashing Ethernet link established and active.

Off No link.

LINK/ACT X2

(Link/activity status of Out)

Green On Ethernet link established.

Flashing Ethernet link established and active.

Off No link.

7.2.3 Operating LEDs on the DAM 510

STATUS DAM

LINK/ACT

DEV

SVS ST

NET ST

AUX

X1

X2

X3

e3
0b

g5
77

.1
1

Illustration 111: Operating LEDs on DAM 510
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Table 26: Operating LEDs on DAM 510

LED Color Flash status Description

DEV Green On Device is in state Operation enabled.

Flashing Device is in state Standby or Power-up.

Red On Device is in state Fault or Fault reaction active.

Flashing DC-link is not applied at the input.

SVS ST Green On 24 V safety supply is applied.

Off 24 V safety supply is not applied.

NET ST Green On Connected.

Orange On Online.

Red Flashing Initialization.

On Initialization failed or other error.

AUX

(State of the auxiliary voltage)

Green On Auxiliary voltage is applied to the output connector.

Off Auxiliary voltage is not applied to the output connector.

Red On Auxiliary voltage undervoltage detected in the hardware.

LINK/ACT X1

(Link/activity of In)

Green On Ethernet link established.

Flashing Ethernet link established and active.

Off No link.

LINK/ACT X2

(Link/activity status of Hybrid Out)

Green On Ethernet link established.

Flashing Ethernet link established and active.

Off No link.

LINK/ACT X3

(Link/activity status of Out)

Green On Ethernet link established.

Flashing Ethernet link established and active.

Off No link.
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7.2.4 Operating LEDs on the ACM 510

STATUS ACM

LINK/ACT

DEV

CAP ST

NET ST

X1

X2

e
3

0
b

g
5

7
8

.1
0

Illustration 112: Operating LEDs on ACM 510

Table 27: Operating LEDs on ACM 510

LED Color Flash status Description

DEV Green On Device is in state Operation enabled.

Flashing Device is in state Standby or Power-up.

Red On Device is in state Fault or Fault reaction active.

Flashing DC-link is not applied at the input.

CAP ST Green On Capacitors fully charged.

Flashing Capacitors charging/discharging.

Off Capacitors discharged.

NET ST Green On Connected.

Orange On Online.

Red Flashing Initialization.

On Initialization failed or other error.

LINK/ACT X1

(Link/activity of In)

Green On Ethernet link established.

Flashing Ethernet link established and active.

Off No link.

LINK/ACT X2

(Link/activity status of Out)

Green On Ethernet link established.

Flashing Ethernet link established and active.

Off No link.
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8 Functional Safety Concept

8.1 Functional Description

The VLT® Multiaxis Servo Drive MSD 510 system integrates the safety function Safe Torque Off (STO). The safety function is available in
daisy-chain format, which is possible between all system components except for ACM 510 (cables are not included). The hybrid cable
passes the STO signal from the DAM 510 to all ISD 510/DSD 510 servo drives in the chain. Once STO is activated (safe state), no torque
is generated on the ISD 510/DSD 510 servo drives, or on any motors connected to SDM 511/SDM 512. Reset of the safety function and
diagnostics can be carried out via the PLC.

N O T I C E

- Use the STO function when performing mechanical work on the servo system or affected area of a machine to avoid a
mechanical hazard. However, the STO function does not provide electrical safety.

8.2 Safety Precautions

W A R N I N G
UNCONTROLLED MOVEMENT

External forces on the motor could cause an uncontrolled and hazardous movement that could result in death or serious injury.

- Equip the motor with additional measures for preventing uncontrolled and hazardous movement, for example mechanical
brakes.

W A R N I N G
RISK OF ELECTRICAL SHOCK

The STO function does not isolate mains voltage to the servo system or auxiliary circuits. Failure to isolate the mains voltage
supply and wait for the specified discharge time to elapse could result in death or serious injury.

- Only perform work on electrical parts of the Danfoss system components or the ISD 510/DSD 510 servo drives after
isolating the mains voltage supply and waiting for the discharge time to elapse.

W A R N I N G
RISK OF RESIDUAL ROTATION

Due to failures in the power semiconductor of the drive, a residual rotation can result from a fault that could result in death or
serious injury. The rotation can be calculated to angle = 360°/(number of poles).

- Take this residual rotation into consideration and ensure that it does not pose a safety risk.

W A R N I N G
LED STATUS RELIABILITY

Status indicators (LEDs) are not reliable for safety functions.

- Only use status indicators for general diagnostics during commissioning and troubleshooting.
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N O T I C E

- After installing the STO function, perform a commissioning test. A passed commissioning test is mandatory after initial
installation and after each change to the safety installation (see 8.8 Commissioning Test).

N O T I C E

- If required, implement a manual reset function according to EN ISO 13849-1. For automatic restart without manual reset,
observe the requirements detailed in paragraph 6.3.3.2.5 of EN ISO 12100:2010 or equivalent standard.

N O T I C E

- Carry out a risk assessment to select the correct stop category for each stop function in accordance with EN 60204-1.

- When designing the machine application, consider timing and distance for coast to stop (Stop Category 0 or STO). See
EN 60204-1 for further information.

- All signals connected to the STO must be supplied by a PELV supply.

8.3 Qualified Personnel for Working with Functional Safety

The STO function can only be installed, programmed, commissioned, maintained, and decommissioned by qualified personnel.
Qualified personnel for the functional safety concept are qualified electrical engineers, or persons who have received training from
qualified electrical engineers and are suitably experienced to operate devices, systems, plant, and machinery in accordance with the
general standards and guidelines for safety technology.

Furthermore, they must:

• Be familiar with the basic regulations concerning health and safety/accident prevention.

• Have read and understood the safety guidelines given in this manual.

• Have a good knowledge of the generic and specialist standards applicable to the specific application.

Users of power drive systems (safety-related) (PDS(SR)) are responsible for:

• Hazard and risk analysis of the application.

• The overall safety of the application.

• Identifying safety functions required and allocating SIL or PL to each of the functions, other subsystems, and the validity of signals
and commands from them.

• Designing appropriate safety-related control systems, such as hardware, software, and parameterization.

8.4 Applied Standards and Compliance

Use of the STO function requires that all provisions for safety, including relevant laws, regulations, and guidelines, are satisfied.

The integrated STO function complies with the following standards:
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• IEC 60204-1: 2016 Stop Category 0 – uncontrolled stop

• EN 60204-1: 2018 Stop Category 0 – uncontrolled stop

• IEC/EN 61508: 2010 SIL 2

• IEC 61800-5-2: 2016 SIL 2

• EN 61800-5-2: 2017 SIL 2

• IEC 62061: 2005 and A1: 2012 and A2: 2015

• EN 62061: 2005 and Cor.:2010 and A1: 2013 and A2: 2015

• IEC/EN 62061: 2015 SIL CL2

• EN ISO 13849-1: 2015 Category 3, PL d

• EN ISO 13849-2: 2014

8.5 Abbreviations and Conventions

Table 28: Safety-related Abbreviations and Conventions

Abbrevia‐
tion

Reference Description

Cat. EN ISO 13849-1 Category B, 1–4

DC – Diagnostic coverage

FIT – Failure in time

Failure rate: 1E-9/hour

HFT EN IEC 61508 Hardware fault tolerance

HFT = n means that n + 1 faults may lead to a loss of the safety function.

MTTFD EN ISO 13849-1 Mean time to failure – dangerous

Unit: years

PFH EN IEC 61508 Probability of dangerous failures per hour

Take this value into account if the safety device is operated in high demand mode or in continu-
ous operating mode, where the frequency of demands for operation made on a safety-related
system occurs more than once per year.

PL EN ISO 13849-1 Performance level

A discrete level used to specify the capability of safety-related parts of a system to perform safe-
ty-oriented functions under foreseeable conditions. Levels: a–e.

SFF EN IEC 61508 Safe Failure Fraction [%]

Proportion of safe failures and detected dangerous failures of a safety function or a subsystem as
a percentage of all possible failures.

SIL EN IEC 61508

EN IEC 62061

Safety Integrity Level

STO EN IEC 61800-5-2 Safe Torque Off
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8.6 Installation

Safety relays that have a plus and minus switching output signal can be directly connected to the servo system to activate STO.

The example in illustration 113 shows the basic connection to be made for the STO function. A suitable safety device to switch it off is
not supplied by Danfoss. The STO is activated by opening STO+ and STO–.

Table 29: Activation of STO Function

STO+ STO– STO function

24 V GND STO deactivated

Open GND STO activated

24 V Open STO activated

Open Open STO activated

C A U T I O N

- Do not exceed 30 V at the STO inputs.

- STO is activated if the plus input is between –3 V and +3 V.

- STO is deactivated if the plus input is between +21.6 V and +26.4 V.

Illustration 113: Safety Relay with Plus and Minus Switching Output

Signals with test pulses must not have test pulses of >1 ms. Longer pulses may lead to reduced availability of the servo system.

8.6.1 Protective Measures

• Install the MSD 510 system components in a cabinet that is rated at least IP54 as per IEC 60529 or in an equivalent environment. A
higher IP protection may be necessary for certain applications.

• If external influences can affect the motor axis, for example suspended loads, use additional measures, such as a safety holding
brake, to eliminate hazards.

8.7 Application Example

An example of an application that can be put in Safe Torque Off mode by a safety circuit is shown in illustration 114.

Select the safety switch devices in accordance with the requirements of the application.
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+24 VDC

GND

e
3

0
b

g
2

7
3

.1
0

8a

8b

53

42

1

X1

X2

X1

X2

9

7

6

1 24 V DC supply

3 Emergency stop button

5 Decentral Access Module (DAM)

7 Feed-in cable

9 Loop cable

2 Safety device

4 Safety device contacts

6 Hybrid cable

8a/8b Servo drive

Illustration 114: Application Example: Safe Torque Off Function

8.8 Commissioning Test

N O T I C E

- Perform a commissioning test for the whole servo system after installation of the STO function, after every change to the
installed function, or after a safety fault.

There are 2 ways to implement the commissioning test depending on the method used to program the PLC, however the steps of the
test are the same:

• Using the Danfoss Library or the TwinCAT® Library.

• Bit-wise readout of the status.

8.8.1 Commissioning Test using Libraries

Depending on the application, 1 or both of the following libraries are required to program the commissioning test:
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• Danfoss Library

- MC_ReadAxisInfo_DDS

- MC_ReadStatus_DDS

- MC_ReadAxisError_DDS

- MC_Reset_DDS

• TwinCAT® Library

- MC_ReadStatus

- MC_ReadAxisError

- MC_Reset

Table 30: Commissioning Test using Libraries

Test steps Reason for the test
step

Expected result for Danfoss library Expected result for Twin‐
CAT® library

1 Run the application (all
the servo drives are ena-
bled).

Check that the appli-
cation can run.

Application runs as expected. Application runs as expec-
ted.

2 Stop the application. – All servo drives are at speed 0 RPM. All servo drives are at speed
0 RPM.

3 Disable all the servo
drives.

– All servo drives are disabled. All servo drives are disabled.

4 Enable STO. Check that STO can
be activated without
error.

MC_ReadAxisInfo_DDS output SafeTor-
queOff = True for all servo drives on the
corresponding line.

–

5 Disable STO. Check that STO can
be deactivated with-
out error. No reset is
required.

MC_ReadAxisInfo_DDS output SafeTor-
queOff = False for all servo drives on the
corresponding line.

–

6 Run the application (all
the servo drives are ena-
bled).

– Application runs as expected. Application runs as expec-
ted.

7 Enable STO. Check that errors are
generated correctly
when STO is activated
while the servo drives
are running.

Motors are torque free. Motors coast
and stop after some time.

MC_ReadAxisInfo_DDS output SafeTor-
queOff = True

and

MC_ReadStatus_DDS output ErrorStop =
True

and

MC_ReadAxisError_DDS output AxisError-
ID = 0xFF80 on all enabled servo drives.

Motors are torque free. Mo-
tors coast and stop after
some time.

For enabled motors:

MC_ReadStatus output Error-
Stop = True

and

MC_ReadAxisError output Axi-
sErrorID = 0xFF80 on all ena-
bled servo drives.

8 Try to run the applica-
tion (enable 1 or more
servo drives).

Checks that the STO
function is working
correctly.

Application does not run. Application does not run.
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Test steps Reason for the test
step

Expected result for Danfoss library Expected result for Twin‐
CAT® library

9 Disable STO. Check that the STO
start is still inhibited
by the error signal.

MC_ReadAxisInfo_DDS output SafeTor-
queOff = False

and

MC_ReadStatus_DDS output ErrorStop =
True

MC_ReadStatus output Error-
Stop = True

10 Try to run the applica-
tion (enable 1 or more
servo drives).

Check whether reset
is required.

Application does not run. Application does not run.

11 Send a reset signal via
MC_Reset(_DDS).

– MC_ReadAxisInfo_DDS output SafeTor-
queOff = False

and

MC_ReadStatus_DDS output ErrorStop =
False

MC_ReadStatus output Error-
Stop = False

12 Try to run the applica-
tion (all servo drives are
enabled).

– Application runs as expected. Application runs as expec-
ted.

8.8.2 Commissioning Test using PROFINET® Devices

Table 31: Commissioning Test using PROFINET® Devices

Test steps Reason for the test step Expected result

1 Run the application (all the servo
drives are enabled).

Check that the application can run. Application runs as expected.

2 Stop the application. – All servo drives are at speed 0 RPM.

3 Disable all the servo drives. – All servo drives are disabled.

4 Enable STO. Check that STO can be activated
without error.

No errors are present. The successful STO activa-
tion can be checked on the LEDs on the devices.

5 Disable STO. Check that STO can be deactivated
without error. No reset is required.

No errors are present. The STO status can be
checked on the LEDs on the devices.

6 Run the application (all the servo
drives are enabled).

– Application runs as expected.

7 Enable STO. Check that errors are generated
correctly when STO is activated
while the servo drives are running.

Motors are torque free. Motors coast and stop
after some time.

Error 0x11E is shown in object 0x603F on all ser-
vo drives.

8 Try to run the application (enable 1
or more servo drives).

Checks that the STO function is
working correctly.

Application does not run.

9 Disable STO. Check that the STO start is still in-
hibited by the error signal.

Error 0x11E is shown in object 0x603F on all ser-
vo drives.
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Test steps Reason for the test step Expected result

10 Try to run the application (enable 1
or more servo drives).

Check whether reset is required. Application does not run.

11 Send a reset signal via the PLC. – STO error 0x11E is cleared in all servo drives.

12 Try to run the application (all servo
drives are enabled).

– Application runs as expected.

8.9 Operation of the STO Function

The STO function does not require any parameterization and is always enabled.

The servo drive modules (SDM 511/512) provide STO status signals via the fieldbus.

All signals transmitted via the fieldbus are not part of the safety function and can only be used for operational purposes.

See the VLT® Servo Drive System ISD 510, DSD 510, MSD 510 Programming Guide for:

• General information on how to access and map data objects.

• Information on a library provided to simplify the use of the fieldbus functions.

If STO is activated when the servo drive is disabled, and no attempt is made to enable the servo drive while STO is active, it is not
necessary to reset the STO function after reapplying supply to the STO terminals.

If STO is activated when the servo drive is enabled, an error code is issued.

8.9.1 Error Codes

If bit 3 of the statusword is set, this indicates any faults that occur on the servo drive. If the fault occurred because of the STO circuit, the
cause of the fault can be found in object 0x603F.

Table 32: Error Codes

Error code PROFINET®

error code
Classification Description Reset

0xFF80 0x11E Fault STO activated while the servo drive was enabled, or an
attempt to enable the servo drive was made while STO
was activated.

Reset via the PLC.

0xFF81 0x11F Safety fault Servo drive internal diagnostic fault. Carry out a power cy-
cle.

0xFF85 0x120 Safety fault Internal STO supply on the power card is not within lim-
its.

Carry out a power cy-
cle.

Error code 0xFF80/0x11E can be a normal status of the application. In this case, the servo drive requires a reset signal from the PLC. To
use the STO function in an application that requires a control guard (see ISO 12100 for details), this reset information can be given
automatically by the PLC. All servo drives on the same line will display this fault at the same time. Carry out a check on the PLC to
compare the fault of all servo drives on 1 line.

Error code 0xFF81/0x11F means that there is a fault on the servo drive that can only be reset by carrying out a power cycle. Complete
the commissioning test after the power cycle. Operation of the servo system can only be resumed if the test is completed successfully.
If error code 0xFF81/0x11F or 0xFF85/0x120 is issued again, contact Danfoss Service.
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8.9.2 Fault Reset

To reset faults, change bit 7 of the controlword from 0 to 1. See the VLT® Servo Drive System ISD 510, DSD 510, MSD 510
Programming Guide for further information.

8.10 Functional Safety Characteristic Data

Table 33: Functional Safety Characteristic Data

Data PSM 510 SDM 511 SDM 512 DAM 510

General information

Response time (from switching on the input until torque generation is
disabled)

<100 ms

Lifetime 20 years

Data for EN/ISO 13849-1

Performance level (PL) – d d –

Category – 3 3 –

Mean time to dangerous failure (MTTFD) – >5000 years >5000 years (1) –

Diagnostic coverage (DC) – 60% 60% –

Data for EN/ISO 61508 and EN/IEC 62061

Safety integrity level (SIL) – 2 2 –

Probability of failure per hour (PFH) 0 /h <4 x 10-9/h <4 x 10-9/h 0 /h

Safe failure fraction (SFF) 100% >95% >95% 100%

Subsystem classification Type A

Functional test interval 1 year

1 For each axis.

N O T I C E

- The PSM 510, DAM 510, and ACM 510 do not contribute to the dangerous failure rate of the Danfoss system and can
therefore be excluded from safety-related calculations.

8.11 Maintenance, Security, and User Accessibility

Maintenance: Test the STO safety function at least once per year as follows:

• Remove the STO input voltage.

• Verify that the motors stop running.

• Verify that no unexpected error codes appear.

Security: If security risks exist, take suitable measures to prevent them.
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User accessibility: Restrict access to the ISD 510/DSD 510 servo drives and other system components if access to them could result in
safety risks.
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9 Diagnostics

9.1 Faults

If faults occur during the operation of the MSD 510 system, check:

• The LEDs on the servo drives, servo drive modules SDM 511/SDM 512, and ACM 510 for general problems relating to
communication or device status.

• The LEDs on the PSM 510 and DAM 510 for general problems with communication, auxiliary supply, or STO voltage.

• The error codes.

The error codes can be read using the VLT® Servo Toolbox software, the LCP, or the PLC. The LCP only shows faults relating to the
device it is connected to.

N O T I C E

- If the fault cannot be eliminated by 1 of the measures listed in the troubleshooting tables, notify Danfoss Service.

Have the following information available to enable Danfoss to provide help quickly and effectively:

• Type number

• Error code

• Firmware version

• System setup (for example, number of servo drives, system modules, and lines).

• System status when the fault occurred.

• Ambient conditions.

9.2 Troubleshooting

9.2.1 Troubleshooting for the Servo Drive Modules SDM 511/SDM 512

9.2.1.1 Drive not Running/Starting Slowly

Possible Cause

• Bearing wear.

• Incorrect parameter settings.

• Incorrect control loop parameters.

• Incorrect torque settings.

Troubleshooting

• Check the bearings and the shaft.

• Check the parameter settings.
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9.2.1.2 Drive Hums and Draws High Current

Possible Cause

• Drive defective.

Troubleshooting

• Contact Danfoss.

9.2.1.3 Drive Stops Suddenly and Restart is not Possible

Possible Cause

• No drive communication.

• Drive in error mode.

Troubleshooting

• Check the fieldbus connection and the LEDs on the drive.

9.2.1.4 Motor Rotating in Wrong Direction

Possible Cause

• Mirror mode activated.

Troubleshooting

• Check the parameter settings.

9.2.1.5 Motor not Generating Expected Torque

Possible Cause

• Drive defective.

• Parameter error.

Troubleshooting

• Check the parameter settings.

• Contact Danfoss.

9.2.1.6 Drive Screaming

Possible Cause

• Incorrect calibration.

• Faulty current measurement.

• Incorrect control loop parameters.

Troubleshooting

• Check the parameter settings.

• Contact Danfoss.
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9.2.1.7 Uneven Running

Possible Cause

• Defective bearing.

Troubleshooting

• Check the shaft.

9.2.1.8 Vibration

Possible Cause

• Defective bearing.

• Incorrect control loop parameters.

Troubleshooting

• Check the shaft.

• Check the parameter settings.

9.2.1.9 Unusual Running Noises

Possible Cause

• Defective bearing.

• Defects on connected mechanics.

• Incorrect control loop parameters.

Troubleshooting

• Check the shaft.

• Check for loose mechanical components on the connected mechanics.

• Check the parameter settings.

9.2.1.10 Drive Speed Drops Sharply under Load

Possible Cause

• Drive is running at current limit.

• Drive is running with incorrect parameters.

Troubleshooting

• Check the application.

• Check the parameter settings.

9.2.1.11 Brake not Releasing

Possible Cause

• Defective brake control.

• Incorrect mechanical brake parameters.
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Troubleshooting

• Check the parameter settings.

• Contact Danfoss.

9.2.1.12 Holding Brake not Holding the Servo Drive

Possible Cause

• Mechanical brake defective.

• Shaft load exceeds the holding torque of the brake.

Troubleshooting

• Contact Danfoss.

9.2.1.13 Delayed Brake Engagement

Possible Cause

• Software error.

Troubleshooting

• Contact Danfoss.

9.2.1.14 Noises when Power-Off Brake is Engaged

Possible Cause

• Mechanical brake damaged.

Troubleshooting

• Contact Danfoss.

9.2.1.15 LEDs not Lighting Up

Possible Cause

• No power supply.

Troubleshooting

• Check the power supply.

9.2.1.16 Drive Protection Trips Immediately

Possible Cause

• Short circuit.

• Incorrect control loop parameters.
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Troubleshooting

• Check the wiring.

• Contact Danfoss.

9.2.2 Troubleshooting for the Servo System

9.2.2.1 LCP Display is Dark/Not Functioning

This fault applies to the ISD 510/DSD 510 servo drives, the SDM 511/SDM 512 servo drive modules, PSM 510, DAM 510, and ACM 510.

Possible Causes

• Missing input power.

• Missing or open fuses or circuit breaker tripped.

• No power to the LCP.

• Incorrect contrast setting.

• Display is defective.

Troubleshooting

Table 34: Fault, LCP Display is Dark/Not Functioning

Possible cause Possible solution

Missing input power. Check the input power source.

Missing or open fuses or circuit breaker tripped. Check the fuses and circuit breaker.

No power to the LCP. • Check the LCP cable for proper connection or damage.

• Replace any faulty LCP or connection cables.

Incorrect contrast setting. Press [Status] + [▵]/[▿] to adjust the contrast.

Display is defective. Replace the faulty LCP or connection cable.

9.2.2.2 Open Power Fuses or Circuit Breaker Trip

This fault applies to the PSM 510 and DAM 510.

Possible Causes

• Phase-to-phase short.

• Short on backlink.

• Short on SDM 511/SDM 512 output

• Short on hybrid cable.

• Short on EXM 510 connector or cable.

Troubleshooting

• Check the cabling

• Check for loose connections.
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9.2.2.3 DC-link Voltage Too High (Error 0x3210/0x103)

This fault applies to PSM 510.

Possible Causes

• Brake resistor not connected.

• Brake resistor too high resistance.

• Brake resistor functionality not activated.

• Several servo drives are decelerating with insufficient ramp time.

• Brake resistor configured incorrectly.

• Mains voltage out of range.

Troubleshooting

Table 35: Fault, DC-link voltage Too High

Possible cause Possible solution Applies to:

Brake resistor not connected. Check the brake resistor cabling. PSM 510

Brake resistor too high resistance. Check if the lowest resistance value has been entered. PSM 510

Brake resistor functionality not activated. Activate the brake function. PSM 510

Several servo drives are decelerating with in-
sufficient ramp time.

• Avoid simultaneous deceleration of several servo
drives.

• Change the deceleration speed.

DAM 510, PSM 510,
ISD 510/DSD 510 servo
drives, SDM 511/
SDM 512 servo drive
modules

Mains voltage out of range Check the mains voltage and wiring.

9.2.2.4 DC-link Voltage Too Low (Error 0x3220/0x104)

This fault applies to all system modules.

Possible Cause

• Incorrect mains input supply.

Troubleshooting

• Check that the supply voltage matches the allowed specification.

9.2.2.5 DC-link Overcurrent (Error 0x2396/0x15C)

This fault applies to the PSM 510 and the DAM 510.

Possible Causes

• The sum of the servo drive current exceeds the maximum rating of the DAM 510.

• The sum of the system modules' current exceeds the maximum rating of the PSM 510.

• Short on backlink.
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Troubleshooting

• Check the servo drive current consumption.

• Avoid simultaneous acceleration of all servo drives.

• Decrease the acceleration value.

9.2.2.6 DC link Overpower (Error 0x2313/0x161)

This fault applies to the PSM 510.

Possible Causes

• The PSM 510 was operating at over 140% of the nominal power rating for too long.

Troubleshooting

• Check the current consumption.

9.2.2.7 PT Power Overload (Error 0x2314/0x162)

This fault applies to the PSM 510.

Possible Causes

• The PSM 510 was operating at 100–140% of the nominal power rating for too long.

Troubleshooting

• Check the current consumption.

9.2.2.8 UAUX Overcurrent (Error 0x2391/0x125)

This fault applies to the DAM 510.

Possible Causes

• The servo drives are consuming more power on the UAUX line than allowed.

Troubleshooting

• Check the number of attached servo drives with the shell diagrams in the VLT® Servo Drive System ISD 510, DSD 510, MSD 510
Design Guide.

• Avoid simultaneous lifting of the servo drive brakes.

9.2.2.9 UAUX Overvoltage (Error 0x3292/0x133)

This fault applies to the DAM 510.

Possible Causes

• Incorrect UAUX supply.
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Troubleshooting

• Check that the supply matches the auxiliary supply requirements.

9.2.2.10 UAUX Undervoltage (Error 0x3294/0x135)

This fault applies to the PSM 510, DAM 510, and ACM 510.

Possible Causes

• Incorrect UAUX supply.

• Incorrect current dimensioning of the supply equipment.

Troubleshooting

• Check that the supply matches the auxiliary supply requirements.

• Check that the output power of the supply is sufficient.

9.2.2.11 Mains Phase Loss (Error 0x3130/0x12F)

This fault applies to the PSM 510.

Possible Causes

• A phase is missing on the supply side.

• The voltage imbalance is too high.

Troubleshooting

• Check the supply voltages and supply currents to the device.

9.2.2.12 Grounding Fault

This fault applies to the PSM 510, DAM 510, ACM 510, and SDM 511/SDM 512.

Possible Causes

• Grounding fault.

• When 2 PSM510 modules are mounted in parallel and the maximum delay time for power-up is exceeded (see 6.7 Power-Up Time).

Troubleshooting

• Check for proper grounding and loose connections.

• Check the hybrid cables for short circuits or leakage currents.

• Check the EXM 510 connection and cable.

9.2.2.13 Brake Resistor Error

This fault applies to the PSM 510.
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Possible Causes

• Faulty brake resistor.

• Internal/external brake resistor not connected.

Troubleshooting

• Remove the power to the device, wait for the discharge time to elapse, then replace the brake resistor.

9.2.2.14 Brake Chopper Error

This fault applies to the PSM 510.

Possible Causes

• Faulty brake chopper.

• Brake chopper power exceeds the power cycle limit.

• Incorrect parameterization.

Troubleshooting

• Check the parameterization of the brake chopper.

• Check the brake chopper connection.

• Measure the resistance of the brake chopper and compare it with the parameter settings.

9.2.2.15 Internal Fan Error

This fault applies to PSM 510 and SDM 511/SDM 512.

Possible Causes

• Fan is not mounted.

• Fan is blocked.

Troubleshooting

• Check if the fan is blocked.

• Check the fan cables for proper connection or damage.

9.3 Error Codes

9.3.1 No error (0x0000 / 0x0)

This error code is valid for PSM 510, DAM 510, ACM 510, and SDM 511/SDM 512.

Table 36: No error (0x0000 / 0x0)

Code PROFINET® code Name Severity (warning/error/trip lock) Description LCP name

0x0000 0x0 No error Error No error. -
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9.3.2 Generic err (0x1000 / 0x100)

This error is valid for PSM 510, DAM 510, ACM 510, and SDM 511/SDM 512.

Table 37: Generic err (0x1000 / 0x100)

Code PROFINET® code Name Severity (warning/error/trip
lock)

Description LCP name

0x1000 0x100 Generic application error Error Generic application error. generic err

9.3.3 Overcurrent on output (0x2310 / 0x101)

This error is valid for SDM 511/SDM 512.

Table 38: Overcurrent on output (0x2310 / 0x101)

Code PROFINET® code Name Severity (warning/error/trip
lock)

Description LCP name

0x2310 0x101 Overcurrent on output Error Overcurrent on output. overcurr out

9.3.4 High current overload (0x2311 / 0x15F)

This error is valid for DAM 510 and SDM 511/SDM 512.

Table 39: High current overload (0x2311 / 0x15F)

Code PROFINET® code Name Severity (warning/error/trip
lock)

Description LCP name

0x2311 0x15F High current over-
load

Error High current overload er-
ror.

High curr ovld

9.3.5 I2T current overload (0x2312 / 0x160)

This error is valid for DAM 510 and SDM 511/SDM 512.

Table 40: I2T current overload (0x2312 / 0x160)

Code PROFINET® code Name Severity (warning/error/trip
lock)

Description LCP name

0x2312 0x160 I2T current overload Error I2T current overload error. IIT curr ovld

9.3.6 High power overload (0x2313 / 0x161)

This error is valid for PSM 510.
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Table 41: High power overload (0x2313 / 0x161)

Code PROFINET® code Name Severity (warning/error/trip
lock)

Description LCP name

0x2313 0x161 High power over-
load

Warning, error High power overload er-
ror.

High pwr ovld

9.3.7 PT power overload (0x2314 / 0x162)

This error is valid for PSM 510.

Table 42: PT power overload (0x2314 / 0x162)

Code PROFINET® code Name Severity (warning/error/trip lock) Description LCP name

0x2314 0x162 PT power overload Warning, error PT power overload error. pt pwr ovld

9.3.8 Short circuit (0x2320 / 0x163)

This error is valid for PSM 510 and DAM 510.

Table 43: Short circuit (0x2320 / 0x163)

Code PROFINET® code Name Severity (warning/error/trip
lock)

Description LCP name

0x2320 0x163 Short circuit Trip lock DC overcurrent short circuit error. DC over curr

9.3.9 Earth leakage (0x2330 / 0x151)

This error is valid for PSM 510, DAM 510, and SDM 511/SDM 512.

Table 44: Earth leakage (0x2330 / 0x151)

Code PROFINET® code Name Severity (warning/error/trip lock) Description LCP name

0x2330 0x151 Earth leakage Warning, error Current leaking to earth. earth leakage

9.3.10 AUX overcurrent (0x2391 / 0x125)

This error is valid for DAM 510.

Table 45: AUX overcurr (0x2391 / 0x125)

Code PROFINET®

code
Name Severity (warning/error/

trip lock)
Description LCP name

0x2391 0x125 AUX overcur-
rent

Error Current on the AUX line has reached
the overcurrent limit.

AUX overcurr
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9.3.11 AUX user limit current (0x2393 / 0x127)

This error is valid for DAM 510.

Table 46: AUX user limit current (0x2393 / 0x127)

Code PROFINET®

code
Name Severity (warning/

error/trip lock)
Description LCP name

0x2393 0x127 AUX user limit
current

Error Current on the AUX line has reached
the user-defined limit for fault.

AUX curr limit

9.3.12 AUX user limit current warning (0x2394 / 0x128)

This error is valid for PSM 510 and DAM 510.

Table 47: AUX user limit current warning (0x2394 / 0x128)

Code PROFINET®

code
Name Severity (warning/

error/trip lock)
Description LCP name

0x2394 0x128 AUX user limit cur-
rent warning

Warning Current on the AUX line has reached
the user-defined limit for warning.

AUX curr
warn

9.3.13 AUX fuse failure (0x2395 / 0x129)

This error is valid for DAM 510.

Table 48: AUX fuse failure (0x2395 / 0x129)

Code PROFINET®

code
Name Severity (warning/

error/trip lock)
Description LCP name

0x2395 0x129 AUX fuse fail-
ure

Error Fuse failure. Current or voltage is above
the limit on the AUX line.

AUX fuse fail

9.3.14 DC overcurrent trip (0x2396 / 0x15C)

This error is valid for DAM 510 and SDM 511/SDM 512.

Table 49: DC overcurrent trip (0x2396 / 0x15C)

Code PROFINET® code Name Severity (warning/error/trip lock) Description LCP name

0x2396 0x15C DC Overcurrent trip Error DC overcurrent trip. overcurr trip

9.3.15 Output power trip (0x2397 / 0x12B)

This error is valid for PSM 510.

DiagnosticsOperating Guide  | VLT® Multiaxis Servo Drive MSD 510 System

AQ262450196490en-000101 / 175R1170174 | Danfoss A/S © 2019.10



Table 50: Output power trip (0x2397 / 0x12B)

Code PROFINET® code Name Severity (warning/error/
trip lock)

Description LCP name

0x2397 0x12B Output power
trip

Error The peak output power of the de-
vice is exceeded.

Out pow

9.3.16 I2T overload motor (0x239B / 0x102)

This error is valid for SDM 511/SDM 512.

Table 51: Short circuit (0x239B / 0x102)

Code PROFINET® code Name Severity (warning/error/trip
lock)

Description LCP name

0x239B 0x102 I2T overload motor Warning, error I2T overload motor error. IIT ovld motor

9.3.17 Mains phase loss (0x3130 / 0x12F)

This error is valid for PSM 510.

Table 52: Mains phase loss (0x3130 / 0x12F)

Code PROFINET™
code

Name Severity (warning/
error/trip lock)

Description LCP name

0x3130 0x12F Mains
phase loss

Error Mains phase loss detected.

This occurs when a phase on mains is missing,
or when the mains is imbalanced.

phase loss

9.3.18 DC link overvoltage (0x3210 / 0x103)

This error is valid for PSM 510, DAM 510, and ACM 510.

Table 53: DC link overvoltage (0x3210 / 0x103)

Code PROFINET® code Name Severity (warning/error/trip
lock)

Description LCP name

0x3210 0x103 DC link overvolt-
age

Error DC-link voltage exceeds lim-
it.

UDC overvolt

9.3.19 Overcurrent trip SW (0x3210 / 0x103)

This error is valid for SDM 511/SDM 512.
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Table 54: Overcurrent trip SW (0x3210 / 0x103)

Code PROFINET® code Name Severity (warning/error/trip
lock)

Description LCP name

0x3210 0x103 overcurrent trip
SW

Error DC-link voltage exceeds lim-
it.

UDC overvolt

9.3.20 DC link undervoltage (0x3220 / 0x104)

This error is valid for PSM 510, DAM 510, ACM 510, and SDM 511/SDM 512.

Table 55: DC link undervoltage (0x3220 / 0x104)

Code PROFINET®

code
Name Severity (warning/

error/trip lock)
Description LCP name

0x3220 0x104 DC link under-
voltage

Error DC-link voltage below limit in Opera-
tion enabled state.

UDC undervolt

9.3.21 UDC charging error (0x3230 / 0x152)

This error is valid for PSM 510, DAM 510, ACM 510, and SDM 511/SDM 512.

Table 56: UDC charging error (0x3230 / 0x152)

Code PROFINET®

code
Name Severity (warning/

error/trip lock)
Description LCP name

0x3230 0x152 UDC charging
error

Error The maximum time limit to charge
the DC-link has been exceeded.

UDC charging
err

9.3.22 DC Link Voltage unbalanced (0x3280 / 0x153)

This error is valid for PSM 510, DAM 510, ACM 510, and SDM 511/SDM 512.

Table 57: DC Link Voltage unbalanced (0x3280 / 0x153)

Code PROFINET™
code

Name Severity (warning/error/
trip lock)

Description LCP name

0x3280 0x153 DC Link voltage un-
balanced

Trip lock DC-link voltage unbal-
anced.

DC link unbal

9.3.23 UAUX high voltage (0x3291 / 0x132)

This error is valid for PSM 510, DAM 510, and ACM 510.
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Table 58: UAUX high voltage (0x3291 / 0x132)

Code PROFINET® code Name Severity (warning/error/trip
lock)

Description LCP name

0x3291 0x132 UAUX high voltage Warning UAUX above warning limit. UAUX high volt

9.3.24 UAUX overvoltage (0x3292 / 0x133)

This error is valid for DAM 510.

Table 59: UAUX overvoltage (0x3292 / 0x133)

Code PROFINET® code Name Severity (warning/error/trip
lock)

Description LCP name

0x3292 0x133 UAUX overvolt-
age

Error UAUX above overvoltage lim-
it.

UAUX overvolt

9.3.25 UAUX low voltage (0x3293 / 0x134)

This error is valid for PSM 510, DAM 510, ACM 510, and SDM 511/SDM 512.

Table 60: UAUX low voltage (0x3293 / 0x134)

Code PROFINET® code Name Severity (warning/error/trip
lock)

Description LCP name

0x3293 0x134 UAUX low voltage Warning UAUX below warning limit. UAUX low volt

9.3.26 UAUX undervoltage (0x3294 / 0x135)

This error is valid for PSM 510, DAM 510, and ACM 510.

Table 61: UAUX undervoltage (0x3294 / 0x135)

Code PROFINET® code Name Severity (warning/error/
trip lock)

Description LCP name

0x3294 0x135 UAUX undervolt-
age

Error UAUX below undervoltage
limit.

UAUX undervolt

9.3.27 UDC high voltage (0x3295 / 0x136)

This error is valid for PSM 510, DAM 510, and ACM 510.
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Table 62: UDC high voltage (0x3295 / 0x136)

Code PROFINET®

code
Name Severity (warning/

error/trip lock)
Description LCP name

0x3295 0x136 UDC high
voltage

Warning The DC-link voltage is higher than the
high-voltage warning limit.

UDC high volt

9.3.28 UDC low voltage (0x3296 / 0x137)

This error is valid for PSM 510, DAM 510, and ACM 510.

Table 63: UDC low voltage (0x3296 / 0x137)

Code PROFINET®

code
Name Severity (warning/

error/trip lock)
Description LCP name

0x3296 0x137 UDC low volt-
age

Warning The DC-link voltage is lower than the
low-voltage warning limit.

UDC low volt

9.3.29 UAUX charging error (0x3297 / 0x154)

This error is valid for DAM 510.

Table 64: UAUX charging error (0x3297 / 0x154)

Code PROFINET®

code
Name Severity (warning/

error/trip lock)
Description LCP name

0x3297 0x154 UAUX charging
error

Error Load error when UAUX is charging. The maxi-
mum time limit to charge the AUX line has
been exceeded.

UAUX charg
err

9.3.30 UDC shutdown error (0x3298 / 0x165)

This error is valid for DAM 510.

Table 65: UDC shutdown error (0x3298 / 0x165)

Code PROFINET® code Name Severity (warning/error/
trip lock)

Description LCP name

0x3298 0x165 UDC shutdown
error

Error Error when UDC is in shut-
down phase.

UDC shutdwn err

9.3.31 UAUX shutdown error (0x3299 / 0x155)

This error is valid for DAM 510.
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Table 66: UAUX shutdown error (0x3299 / 0x155)

Code PROFINET®

code
Name Severity (warning/error/

trip lock)
Description LCP name

0x3299 0x155 UAUX shutdown
error

Error Error when UAUX is in shut-
down phase.

UAUX shtdwn
err

9.3.32 UAUX undervoltage hardware (0x329A / 0x156)

This error is valid for PSM 510, DAM 510, and ACM 510.

Table 67: UAUX undervoltage hardware (0x329A / 0x156)

Code PROFINET®

code
Name Severity (warning/

error/trip lock)
Description LCP name

0x329A 0x156 UAUX undervoltage
hardware

Error UAUX undervoltage detected by
hardware circuit.

AUX undervol
HW

9.3.33 Automated fault reset failure (0x329B / 0x168)

This error is valid for PSM 510, DAM 510, and ACM 510.

Table 68: Automated fault reset failure (0x329B / 0x168)

Code PROFINET®

code
Name Severity (warning/

error/trip lock)
Description LCP name

0x329B 0x168 Automated fault re-
set failure

Trip lock Too many auto fault resets have been
executed in the intended time interval.

afr failure

9.3.34 Device overtemperature (0x4210 / 0x157)

This error is valid for PSM 510, DAM 510, and ACM 510.

Table 69: Device overtemperature (0x4210 / 0x157)

Code PROFINET®

code
Name Severity (warn‐

ing/error/trip
lock)

Description LCP name

0x4210 0x157 Device over-
temperature

Warning, error Triggered when the maximum temperature of the
main device component is exceeded.

PSM: Thyristor rectifier module.

DAM: Maximum temperature of both high side and
low side IGBTs.

overtemp
device
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9.3.35 Too low temperature (0x4220 / 0x138)

This error is valid for PSM 510, DAM 510, ACM 510, and SDM 511/SDM 512.

Table 70: Too low temperature (0x4220 / 0x138)

Code PROFINET® code Name Severity (warning/error/
trip lock)

Description LCP name

0x4220 0x138 Too low temper-
ature

Error The device is too cold to op-
erate.

low temp device

9.3.36 Overtemperature: Power module (0x4290 / 0x105)

This error is valid for SDM 511/SDM 512.

Table 71: Overtemperature: Power module (0x4290 / 0x105)

Code PROFINET® code Name Severity (warning/error/
trip lock)

Description LCP name

0x4290 0x105 Overtemperature:
Power module

Error Overtemperature on power
module.

overtemp PM

9.3.37 Overtemperature: Control card (0x4291 / 0x106)

This error is valid for PSM 510, DAM 510, ACM 510, and SDM 511/SDM 512.

Table 72: Overtemperature: Control card (0x4291 / 0x106)

Code PROFINET®

code
Name Severity (warning/

error/trip lock)
Description LCP name

0x4291 0x106 Overtemperature:
Control card

Error Maximum temperature of con-
trol card exceeded.

overtemp CC

9.3.38 Overtemperature: Power card (0x4292 / 0x107)

This error is valid for PSM 510, DAM 510, and ACM 510.

Table 73: Overtemperature: Power card (0x4292 / 0x107)

Code PROFINET®

code
Name Severity (warning/error/

trip lock)
Description LCP name

0x4292 0x107 Overtemperature:
Power card

Warning, error Maximum temperature of pow-
er card exceeded.

overtemp PC

9.3.39 Inrush overtemperature: DC link (0x4293 / 013C)

This error is valid for PSM 510, DAM 510, and ACM 510.
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Table 74: Inrush overtemperature: DC link (0x4293 / 0x13C)

Code PROFINET®

code
Name Severity (warning/

error/trip lock)
Description LCP name

0x4293 0x13C Inrush overtem-
perature: DC link

Error Inrush fault.

Too many transitions into state Operation
enabled in a short time period.

inrush UDC

9.3.40 Inrush overtemperature AUX line (0x4294 / 0x13D)

This error is valid for DAM 510.

Table 75: Inrush overtemperature AUX line (0x4294 / 0x13D)

Code PROFINET®

code
Name Severity (warning/

error/trip lock)
Description LCP name

0x4294 0x13D Inrush overtem-
perature AUX line

Error Inrush fault.

Too many power-ups of the AUX voltage
have occurred within a short time period.

inrush
UAUX

9.3.41 Overtemperature: Motor (0x4310 / 0x108)

This error is valid for SDM 511/SDM 512.

Table 76: Overtemperature: Motor (0x4310 / 0x108)

Code PROFINET® code Name Severity (warning/error/
trip lock)

Description LCP name

0x4310 0x108 Overtemperature:
Motor

Error Overtemperature on mo-
tor.

overtemp motor

9.3.42 UAUX undervoltage (0x5112 / 0x109)

This error is valid for SDM 511/SDM 512.

Table 77: Short circuit (0x5112 / 0x109)

Code PROFINET®

code
Name Severity (warning/error/

trip lock)
Description LCP name

0x5112 0x109 UAUX under-
voltage

Error, trip lock Undervoltage on auxiliary
voltage.

undervolt UAUX

9.3.43 Charge switch failure voltage (0x5121 /0x158)

This error is valid for PSM 510 and SDM 511/SDM 512.
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Table 78: Charge switch failure voltage (0x5121 / 0x158)

Code PROFINET®

code
Name Severity (warning/

error/trip lock)
Description LCP name

0x5121 0x158 Charge switch
failure voltage

Trip lock Indicates a malfunction of the in-
ternal charge circuit.

Chg switch
fail

9.3.44 EE Checksum Error (parameter missing) (0x5530 / 0x10A)

This error is valid for PSM 510, DAM 510, ACM 510, and SDM 511/SDM 512.

Table 79: EE Checksum Error (parameter missing) (0x5530 / 0x10A)

Code PROFINET®

code
Name Severity (warning/

error/trip lock)
Description LCP name

0x5530 0x10A EE Checksum Error (pa-
rameter missing)

Trip lock Missing parameter in internal de-
vice configuration.

config err

9.3.45 Parameter error (0x6320 / 0x10B)

This error is valid for PSM 510, DAM 510, ACM 510, and SDM 511/SDM 512.

Table 80: Param err (0x6320 / 0x10B)

Code PROFINET® code Name Severity (warning/error/trip
lock)

Description LCP name

0x6320 0x10B Parameter error Trip lock A parameter has an invalid value. param err

9.3.46 Conf par ver (0x6382 / 0x15D)

This error is valid for PSM 510, DAM 510, ACM 510, and SDM 511/SDM 512.

Table 81: Configuration parameters version error (0x6382 / 0x15D)

Code PROFINET®

code
Name Severity (warning/

error/trip lock)
Description LCP name

0x6382 0x15D Configuration param-
eters version error

Trip lock Configuration parameter set version mis-
match: parameter set is not valid for this
device.

conf par ver

9.3.47 Configuration parameters limits error (0x6383 / 0x164)

This error is valid for PSM 510, DAM 510, and ACM 510.
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Table 82: Configuration parameters limits error (0x6383 / 0x164)

Code PROFINET®

code
Name Severity (warn‐

ing/error/trip
lock)

Description LCP name

0x6383 0x164 Configuration pa-
rameters limits er-
ror

Trip lock ≥1 parameter in the configuration parameter
set is out of limits: the parameter set is not
valid for this device.

conf par
lim

9.3.48 Power EEprom configuration error (0x6384 / 0x166)

This error is valid for PSM 510, DAM 510, ACM 510, and SDM 511/SDM 512.

Table 83: Power EEprom configuration error (0x6384 / 0x166)

Code Name Severity (warning/
error/trip lock)

Description LCP name

0x6384 0x166 Power Eeprom config-
uration error

Trip lock The power device Eeprom is corrupt or
incompatible with this control board.

conf par EE-
PROM

9.3.49 Brake chopper failure (0x7111 / 0x141)

This error is valid for PSM 510.

Table 84: Brake chopper failure (0x7111 / 0x141)

Code PROFINET®

code
Name Severity (warning/

error/trip lock)
Description LCP name

0x7111 0x141 Brake chop-
per failure

Warning, error The brake chopper is monitored during oper-
ation.

A brake failure has been detected by the
brake check function.

brake ch fail

9.3.50 Brake chopper overcurrent (0x7112 / 0x167)

This error is valid for PSM 510.

Table 85: Brake chopper overcurrent (0x7112 / 0x167)

Code PROFINET®

code
Name Severity (warning/error/

trip lock)
Description LCP name

0x7112 0x167 Brake chopper
overcurrent

Trip lock The brake chopper current ex-
ceeds the limit.

brake ch over-
curr

9.3.51 Brake resistor maximum power limit (0x7181 / 0x142)

This error is valid for PSM 510.
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Table 86: Brake resistor maximum power limit (0x7181 / 0x142)

Code PROFINET®

code
Name Severity (warning/

error/trip lock)
Description LCP name

0x7181 0x142 Brake resistor maxi-
mum power limit

Warning, error The brake resistor maximum
power limit is exceeded.

brake pwr
lim

9.3.52 Brake resistor user power limit (0x7182 / 0x143)

This error is valid for PSM 510.

Table 87: Brake resistor user power limit (0x7182 / 0x143)

Code PROFI‐
NET®

code

Name Severity
(warning/
error/trip
lock)

Description LCP
name

0x7182 0x143 Brake resis-
tor user
power limit

Warning, er-
ror

The brake resistor power limit is exceeded.

The power transmitted to the brake resistor is calculated as an
average value over the last 300 s of run time.

-The calculation is based on the DC-link voltage and the brake
resistor value set in parameter 2-16 (Brake resistor power 300 s).

The error is reported when the value is exceeded within 300 s.

brake usr
pwr lim

9.3.53 Brake mains voltage too high (0x7183 / 0x159)

This error is valid for PSM 510.

Table 88: Brake mains voltage too high (0x7183 / 0x159)

Code PROFINET®

code
Name Severity (warning/error/

trip lock)
Description LCP name

0x7183 0x159 Brake mains volt-
age too high

Warning The brake resistor mains volt-
age is too high.

brake volt
high

9.3.54 Internal position sensor error (0x7320 / 0x10C)

This error is valid for SDM 511/SDM 512.

Table 89: Internal position sensor error (0x7320 / 0x10C)

Code PROFINET®

code
Name Severity (warning/

error/trip lock)
Description LCP name

0x7320 0x10C Internal position sensor
error

Trip lock Absolute position sensor er-
ror.

int sensor err
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9.3.55 External position sensor error (0x7380 / 0x10D)

This error is valid for DAM 510 and SDM 511/SDM 512.

Table 90: External position sensor error (0x7380 / 0x10D)

Code PROFINET®

code
Name Severity (warning/

error/trip lock)
Description LCP name

0x7380 0x10D External position sensor
error

Error External encoder data could
not be read.

ext sensor err

9.3.56 Following error (0x8611 / 0x10E)

This error is valid for SDM 511/SDM 512.

Table 91: Following error (0x8611 / 0x10E)

Code PROFINET® code Name Severity (warning/error/trip
lock)

Description LCP name

0x8611 0x10E Following error Warning, error A following error has occurred. following err

9.3.57 Homing error on entering homing mode (0x8693 / 0x10F)

This error is valid for SDM 511/SDM 512.

Table 92: Homing error on entering homing mode (0x8693 / 0x10F)

Code PROFINET®

code
Name Severity (warning/

error/trip lock)
Description LCP name

0x8693 0x10F Homing error on enter-
ing homing mode

Warning Could not enter homing mode
(for example velocity not 0).

Homing mode
fail

9.3.58 Homing error on start homing method (0x8694 / 0x110)

This error is valid for SDM 511/SDM 512.

Table 93: Homing error on start homing method (0x8694 / 0x110)

Code PROFINET®

code
Name Severity (warning/

error/trip lock)
Description LCP name

0x8694 0x110 Homing error on start
homing method

Warning Could not start homing method
(for example drive not in stand-
still).

Homing meth-
od fail

9.3.59 Homing error distance (0x8695 / 0x111)

This error is valid for SDM 511/SDM 512.
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Table 94: Homing error distance (0x8695 / 0x111)

Code PROFINET® code Name Severity (warning/error/
trip lock)

Description LCP name

0x8695 0x111 Homing error dis-
tance

Warning Homing distance
reached.

Homing distance

9.3.60 Mechanical brake failure (0xFF01 / 0x112)

This error is valid for SDM 511/SDM 512.

Table 95: Mechanical brake failure (0xFF01 / 0x112)

Code PROFINET® code Name Severity (warning/error/trip
lock)

Description LCP name

0xFF01 0x112 Mechanical brake
failure

Trip lock No brake or wire failure. brake mech fail

9.3.61 Short circuit in mechanical brake control (0xFF02 / 0x113)

This error is valid for SDM 511/SDM 512.

Table 96: Short circuit in mechanical brake control (0xFF02 / 0x113)

Code PROFINET®

code
Name Severity (warning/error/

trip lock)
Description LCP name

0xFF02 0x113 Short circuit in mechani-
cal brake control

Trip lock Short circuit in brake
control.

brake mech
short

9.3.62 External interface power failure (0xFF0A / 0x114)

This error is valid for SDM 511/SDM 512.

Table 97: External interface power failure (0xFF0A / 0x114)

Code PROFINET®

code
Name Severity (warning/

error/trip lock)
Description LCP name

0xFF0A 0x114 External interface pow-
er failure

Error External interface power sup-
ply failure.

ext IF pwr fail

9.3.63 Communication interrupted (0xFF10 / 0x14F)

This error is valid for PSM 510, DAM 510, ACM 510, and SDM 511/SDM 512.
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Table 98: Communication interrupted (0xFF10 / 0x14F)

Code PROFINET®

code
Name Severity (warning/

error/trip lock)
Description LCP name

0xFF10 0x14F Communication in-
terrupted

Error The fieldbus communication has been
interrupted while the device was ena-
bled.

Comm inter-
rupt

9.3.64 Fan feedback inconsistent (0xFF21 / 0x145)

This error is valid for PSM 510 and SDM 51x.

Table 99: Fan feedback inconsistent (0xFF21 / 0x145)

Code PROFINET®

code
Name Severity (warning/

error/trip lock)
Description LCP name

0xFF21 0x145 Fan feedback in-
consistent

Warning Internal fan fault.

Internal fan not running/mounted.

fan feedback

9.3.65 Fan lifetime critical (0xFF22 / 0x15A)

This error is valid for PSM 510 and SDM 511/SDM 512.

Table 100: Fan lifetime critical (0xFF22 / 0x15A)

Code PROFINET® code Name Severity (warning/error/
trip lock)

Description LCP name

0xFF22 0x15A Fan lifetime criti-
cal

Warning The theoretical lifetime of the fan
has been exceeded.

fan lifetime

9.3.66 Timing violation 1 (0xFF60 / 0x115)

This error is valid for SDM 511/SDM 512.

Table 101: Timing violation 1 (0xFF60 / 0x115)

Code PROFINET® code Name Severity (warning/error/trip lock) Description LCP name

0xFF60 0x115 Timing violation 1 Trip lock Contact Danfoss. timing err 1

9.3.67 Timing violation 2 (0xFF61 / 0x116)

This error is valid for SDM 511/SDM 512.
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Table 102: Timing violation 2 (0xFF61 / 0x116)

Code PROFINET® code Name Severity (warning/error/trip lock) Description LCP name

0xFF61 0x116 Timing violation 2 Trip lock Contact Danfoss. timing err 2

9.3.68 Timing violation 3 (0xFF62 / 0x117)

This error is valid for SDM 511/SDM 512.

Table 103: Timing violation 3 (0xFF62 / 0x117)

Code PROFINET® code Name Severity (warning/error/trip lock) Description LCP name

0xFF62 0x117 Timing violation 3 Trip lock Contact Danfoss. timing err 3

9.3.69 Timing violation 4 (0xFF63 / 0x118)

This error is valid for SDM 511/SDM 512.

Table 104: Timing violation 4 (0xFF63 / 0x118)

Code PROFINET® code Name Severity (warning/error/trip lock) Description LCP name

0xFF63 0x118 Timing violation 4 Trip lock Contact Danfoss. timing err 4

9.3.70 Timing violation 5 (0xFF64 / 0x119)

This error is valid for SDM 511/SDM 512.

Table 105: Timing violation 5 (0xFF64 / 0x119)

Code PROFINET® code Name Severity (warning/error/trip lock) Description LCP name

0xFF64 0x119 Timing violation 5 Trip lock Contact Danfoss. timing err 5

9.3.71 Timing violation 6 (0xFF65 / 0x11A)

This error is valid for SDM 511/SDM 512.

Table 106: Timing violation 6 (0xFF65 / 0x11A)

Code PROFINET® code Name Severity (warning/error/trip lock) Description LCP name

0xFF65 0x11A Timing violation 6 Trip lock Contact Danfoss. timing err 6

9.3.72 Timing violation 7 (0xFF66 / 0x168)

This error is valid for SDM 511/SDM 512.
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Table 107: Timing violation 7 (0xFF66 / 0x168)

Code PROFINET® code Name Severity (warning/error/trip lock) Description LCP name

0xFF66 0x168 Timing violation 7 Trip lock Contact Danfoss. timing err 7

9.3.73 Timing violation 8 (0xFF67 / 0x16B)

This error is valid for SDM 511/SDM 512.

Table 108: Timing violation 8 (0xFF67 / 0x16B)

Code PROFINET® code Name Severity (warning/error/trip lock) Description LCP name

0xFF67 0x16B Timing violation 8 Trip lock Contact Danfoss. timing err 8

9.3.74 Timing violation 9 (0xFF68 / 0x16C)

This error is valid for SDM 511/SDM 512.

Table 109: Timing violation 9 (0xFF68 / 0x16C)

Code PROFINET® code Name Severity (warning/error/trip lock) Description LCP name

0xFF68 0x16C Timing violation 9 Trip lock Contact Danfoss. timing err 9

9.3.75 Firmware: Package description mismatch (0xFF70 / 0x11B)

This error is valid for PSM 510, DAM 510, ACM 510, and SDM 511/SDM 512.

Table 110: Firmware: Package description mismatch (0xFF70 / 0x11B)

Code PROFINET®

code
Name Severity (warning/

error/trip lock)
Description LCP name

0xFF70 0x11B Firmware: Package de-
scription mismatch

Trip lock The firmware found does not
match the package description.

FW pack err

9.3.76 Firmware: Power cycle needed (0xFF71 / 0x11C)

This error is valid for PSM 510, DAM 510, ACM 510, and SDM 511/SDM 512.

Table 111: Firmware: Power cycle needed (0xFF71 / 0x11C)

Code PROFINET®

code
Name Severity (warning/

error/trip lock)
Description LCP name

0xFF71 0x11C Firmware: Pow-
er cycle needed

Warning, error The firmware update transfer is completed
but a power cycle is required before the
new firmware is active.

need power-
cycle
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9.3.77 Firmware: Update started (0xFF72 / 0x11D)

This error is valid for PSM 510, DAM 510, ACM 510, and SDM 511/SDM 512.

Table 112: Firmware: Update started (0xFF72 / 0x11D)

Code PROFINET®

code
Name Severity (warning/

error/trip lock)
Description LCP name

0xFF72 0x11D Firmware: Up-
date started

Warning, error Firmware update is in progress.

Warning changes to error when an attempt is
made to enable the device in this state.

FW update

9.3.78 Firmware: Update invalid (0xFF73 / 0x15B)

This error is valid for PSM 510 and DAM 510.

Table 113: Firmware: Update invalid (0xFF73 / 0x15B)

Code PROFINET®

code
Name Severity (warning/

error/trip lock)
Description LCP name

0xFF73 0x15B Firmware: Up-
date invalid

Error Invalid or corrupted firmware package
update.

Last valid firmware package has been loa-
ded.

FW upd invalid

9.3.79 STO active while drive enabled (0xFF80 / 0x11E)

This error is valid for SDM 511/SDM 512.

Table 114: STO active while drive enabled (0xFF80 / 0x11E)

Code PROFINET®

code
Name Severity (warning/

error/trip lock)
Description LCP name

0xFF80 0x11E STO active while
drive enabled

Error STO activated while drive was enabled
or tried to enable while STO active.

STO active

9.3.80 STO mismatch (0xFF81 / 0x11F)

This error is valid for SDM 511/SDM 512.

Table 115: STO mismatch (0xFF81 / 0x11F)

Code PROFINET® code Name Severity (warning/error/
trip lock)

Description LCP name

0xFF81 0x11F STO mis-
match

Trip lock Dual diagnosis of STO voltage not
plausible.

STO mismatch
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9.3.81 P_STO error (0xFF85 / 0x120)

This error is valid for SDM 511/SDM 512.

Table 116: P_STO error (0xFF85 / 0x120)

Code PROFINET® code Name Severity (warning/error/
trip lock)

Description LCP name

0xFF85 0x120 P_STO error Trip lock P_STO voltage on the power card ex-
ceeds the limits.

P_STO error

9.3.82 Guide value reversed (0xFF90 / 0x121)

This error is valid for SDM 511/SDM 512.

Table 117: Guide value reversed (0xFF90 / 0x121)

Code PROFINET®

code
Name Severity (warning/

error/trip lock)
Description LCP name

0xFF90 0x121 Guide value re-
versed

Error Position guide value went backwards
while the servo drive was in CAM
mode.

guide val rev

9.3.83 Guide value implausible (0xFF91 / 0x122)

This error is valid for SDM 511/SDM 512.

Table 118: Guide value implausible (0xFF91 / 0x122)

Code PROFINET®

code
Name Severity (warning/error/

trip lock)
Description LCP name

0xFF91 0x122 Guide value im-
plausible

Error Increments between succeeding
values too large.

guide val impl

9.3.84 Sign of life error (0xFF95 / 0x14E)

This error is valid for SDM 511/SDM 512 with PROFINET® only.

Table 119: Sign of life error (0xFF95 / 0x14E)

Code PROFINET® code Name Severity (warning/error/trip lock) Description LCP name

0xFF95 0x14E Sign of life error Error Sign of life error. SOL error
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10 Maintenance, Decommissioning, and Disposal

10.1 Warnings

W A R N I N G
HIGH VOLTAGE

Potentially lethal voltage is present on the connectors that may lead to death or serious injury.

- Before working on the power or signal connectors (disconnecting or connecting the cable), or performing any maintenance
work, disconnect the Power Supply Module (PSM 510) from the mains and wait for the discharge time to elapse.

W A R N I N G
DISCHARGE TIME

The MSD 510 system contains DC-link capacitors that remain charged for some time after the mains supply is switched off at
the Power Supply Module (PSM 510). Failure to wait the specified time after power has been removed before performing
service or repair work could result in death or serious injury.

- To avoid electrical shock, fully disconnect the Power Supply Module (PSM 510) from the mains and wait for the capacitors
to fully discharge before carrying out any maintenance or repair work on the servo system or its components.

Minimum waiting time (minutes)

15

10.2 Maintenance Tasks

The MSD 510 system components are largely maintenance free.

The maintenance tasks must be performed by qualified personnel. No other tasks are required.

Table 120: Overview of Maintenance Tasks

Component Maintenance task Maintenance interval Instruction

MSD 510 system com-
ponents

Carry out a visual inspection. Every 6 months Check for any abnormalities on the surface
of the component.

Check the fan. Every 12 months Check that the fan can turn and remove
any dust or dirt.

Functional safety Perform a system power cycle
and check the STO function.

Every 12 months Activate STO and check the status with the
PLC.

10.3 Inspection during Operation

10.3.1 System Components

Carry out regular inspections during operation.

Check:
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• The cooling vents are not blocked.

• The fan is not making any unusual noises.

• The condition of electrical wiring and cables.

10.4 Repair

Always contact the local Danfoss sales company for information about the repair policy.
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10.5 System Component Replacement

10.5.1 Dismounting the System Components

1. Disconnect the mains and all auxiliary supplies from the PSM 510 and wait for the discharge time to elapse.

2. Unplug the motor feedback connectors (only on SDM511/SDM512).

3. Disconnect the EMC plate on the bottom of the system components. Do not dismount the connectors from the EMC plate.
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Illustration 115: Disconnecting the EMC Plate

Unplug the RJ45 connector [2] (only on DAM 510).

Unscrew the screw [4] on the EMC plate.

Release the EMC plate by pressing the clip [3].

Unscrew the PE screw [1].

4. Disconnect the I/O shielding plate on the top of the system components:
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Illustration 116: Disconnecting the I/O Shielding Plate

Unplug the top connectors [1].

Unscrew the screw on the I/O shielding plate [2].

Pull the I/O shielding plate upwards to remove it.

5. Release the securing clamp at the top of the module.
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Illustration 117: Releasing the Securing Clamp

6. Tilt the module forward and remove it from the backplate.
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Illustration 118: Removing the Module

10.5.2 Fitting and Commissioning the System Components

1. Check if preparation is required (see 4.6.1 System Modules).

2. Fit the system modules (see 4.7.3 Fitting Instructions for System Modules).

3. Connect the electrical cables (see chapter Electrical Installation).

4. Switch the system on (see 6.9 Switching on the MSD 510 System).

5. Configure the system module's parameters according to the fieldbus used (see 6.4 EtherCAT® ID Assignment, 6.5 Ethernet
POWERLINK® ID Assignment, and 6.6 PROFINET® ID Assignment).

6. Conduct a test run.

10.6 Cable Replacement

10.6.1 Overview

Replace the cables when the rated number of bending cycles has been reached or the cable is damaged.
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N O T I C E

- Do not forcefully connect or fit the connectors. Incorrect connection causes permanent damage to the connectors.

10.6.2 Feed-In Cable Replacement

10.6.2.1 Disconnecting the Feed-In Cable

Procedure

1. Disconnect the Power Supply Module (PSM 510) from its power source (mains network and all auxiliary supplies).

2. Wait for the necessary discharge time to elapse.

3. Disconnect any cables connected to the X3, X4, or X5 ports on the ISD 510/DSD 510 servo drive for easier access to the feed-in
cable.

4. Disconnect the PE wire from the PE screw on the Decentral Access Module (DAM 510).

5. Disconnect the Ethernet connector.

6. Remove the EMC plate from the Decentral Access Module (DAM 510).

7. Open the cable binder holding the STO cable.

8. Open the cable binder holding the feed-in cable on Decentral Access Module (DAM 510).

9. Loosen the feed-in cable connectors on the DAM 510.

10. Disconnect the feed-in cable from the DAM 510.

11. Loosen the threaded ring of the connector on the servo drive.

12. Disconnect the feed-in cable from the servo drive.

10.6.2.2 Replacing the Feed-In Cable

Replace the feed-in cable with a cable of identical type and length. See the VLT® Servo Drive System ISD 510, DSD 510, MSD 510
Design Guide for part numbers.

10.6.2.3 Connecting the Feed-In Cable

1. Connect the female connector of the feed-in cable to the male connector of the 1st servo drive.

2. Turn the threaded rings of the connectors hand tight.

3. Ensure that there is no mechanical tension on the cables.

4. Insert the feed-in cable wires into the correct connector on the EMC plate at the bottom of the Decentral Access Module
(DAM 510).

5. Secure the feed-in cable with a cable binder.

6. Secure the STO cable with a cable binder.

7. Mount the EMC plate on the DAM 510.

8. Connect the Ethernet connector to the DAM 510.

9. Connect the PE wire to the PE screw on the DAM 510.

10. Reconnect any cables that were connected to the X3, X4, or X5 ports.
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10.6.3 Loop Cable Replacement

10.6.3.1 Disconnecting the Loop Cable

Procedure

1. Disconnect the Power Supply Module (PSM 510) from its power source (mains network) and all auxiliary supplies.

2. Wait for the necessary discharge time to elapse.

3. Disconnect any cables connected to the X3, X4, or X5 ports on both ISD 510/DSD 510 servo drives for easier access to the loop
cable.

4. Loosen the threaded rings of the loop cable connectors on both servo drives.

5. Disconnect the loop cable from the servo drives.

10.6.3.2 Replacing the Loop Cable

Replace the loop cable with a cable of identical type and length. See the VLT® Servo Drive System ISD 510, DSD 510, MSD 510
Design Guide for part numbers.

10.6.3.3 Connecting the Loop Cable

1. Connect the male connector of the loop cable to the female connector on the servo drive.

2. Connect the female connector of the loop cable to the male connector on the adjacent servo drive.

3. Turn the threaded rings hand tight on both servo drives.

4. Ensure that there is no mechanical tension on the cables.

5. Tighten the threaded rings of the connectors on both servo drives.

6. Reconnect any cables that were connected to the X3, X4, or X5 ports on both servo drives.

10.7 Fuse Replacement in Decentral Access Module (DAM 510)

Context:

If a single fuse blows, replace all the fuses with fuses from the same batch (fuse CAT number 5012006.25, SIBA).
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Procedure

1. Remove the screws [1] and remove the cover.
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Illustration 119: Opening the Cover on DAM 510

2. Use a screwdriver to remove the fuses and replace them with the same number of identical type fuses (see 5.4.1 Fuses).
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Illustration 120: Removing the Fuse

3. Replace the cover and tighten the screws [1]. The tightening torque is 2 Nm.
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10.8 Fan Replacement

Context:
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Illustration 121: Fan Replacement on 50 mm Modules
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Illustration 122: Fan Replacement on 100 mm Modules

N O T I C E

- Further information on fan types can be found in the VLT® Servo Drive System ISD 510, DSD 510, MSD 510 Design Guide.

Procedure

1. Use a screwdriver as a lever to release the fan holder.

2. Remove the fan.

3. Replace the fan with a fan of identical type.
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10.9 Product Returns

Danfoss products can be returned for disposal at no charge. A prerequisite for this is that they are free of deposits, such as oil, grease,
or other types of contamination that hampers disposal. Furthermore, foreign materials or third-party components cannot be included
with the returned product.

Ship the products free on board to the local Danfoss sales company.

10.10 Recycling

Take metals and plastics to recycling stations.

The servo drives and system modules are classified as electronic waste, and the packaging is classified as packaging waste.

10.11 Disposal

Devices containing electronic components cannot be disposed of as normal domestic waste.

Dispose of the servo drives and system modules as hazardous waste, electrical waste, recyclable waste, and so on, in accordance with
applicable local regulations.
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11 Specifications

11.1 Nameplates

Check the nameplate and compare it with the order data. Use the part number for reference. The part number uniquely identifies the
module type.

Ensure that the nameplate is clearly legible.

11.1.1 Example Nameplate on the Front of the System Modules

Ensure that the nameplate is clearly legible.

The following data is shown on the nameplate on the front of the MSD 510 system modules:

VLT PSM 510

DANGER

PART NO:     175G0166

SERIAL NO:  966001Q368

OUTPUT: Pnom: 30kW

Notes:

MAC PSM
X1 IN:

X2 OUT:

15 MIN

00:1B:08:15:B3:XX
00:1B:08:15:B3:XX

00:1B:08:15:B3:XX

e3
0b

g2
76

.1
01

2

3
4

5

6

7

8

9
Motor over-temperature sensing is required

1 Danfoss logo

3 Part number

5 Output

7 Notes

9 Warning symbols

2 MSD 510 module name

4 Serial number

6 Data matrix

8 MAC addresses

Illustration 123: Example Nameplate on the Front of the MSD 510 System Modules

11.1.2 Example Nameplate on the Side of the System Modules

The following data is shown on the nameplate on the side of the system modules:
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1 Type code

3 Output voltage

5 Ambient temperature range

7 UAUX supply

9 Rated power

2 Supply voltage

4 Maximum power

6 Protection rating: IP20 according to IEC/EN 60529 (except
connectors which are IP00)

8 Short-circuit current rating

Illustration 124: Example Nameplate on the Side of the System Modules for PSM 510
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11.2 Power Supply Module (PSM 510)

11.2.1 Dimensions of PSM 510
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Illustration 125: Dimensions of PSM 510

11.2.2 Characteristic Data for PSM 510

Table 121: Characteristic Data for Power Supply Module (PSM 510)

Definition Unit Power size 1 Power size 2 Power size 3

Input

Mains input voltage V AC 400–480 ±10%, 3-phase (see 5.2 Electrical Environmental Conditions)

Input current @ UMIN A 20 34 50

Input power VA 12.5 22 32

UAUX input voltage V DC 24/48 ±10%

UAUX current consumption at 24 V DC A DC 2.0

UAUX current consumption at 48 V DC A DC 1.0

Output

DC-link voltage V DC 565–680 ±10%

DC-link capacitance µF 1800

Rated current IN A 20 40 60
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Definition Unit Power size 1 Power size 2 Power size 3

Rated power PN kW 10 20 30

Peak power Pmax t <3.0 s) kW 20 40 60

Internal brake resistor (1)

Peak power Pmax kW 8

Rated power PN W 150

Nominal resistance Ω 15

External brake resistor

Peak power Pmax kW 60

Rated power PN kW 7.5

Minimum resistance Ω 10

General

Line filter in accordance with EN 61800-3 – Category C3

Cooling – Integrated fan

Mounting – Wall-mounted on backplate using backlink connector

Weight kg 6

Dimensions (W x H x D) mm 137.3 x 406.3 x 270

1 An external brake resistor can be connected.

11.3 Servo Drive Module (SDM 511/SDM 512)

11.3.1 Motor Overload Protection

N O T I C E

- Internal motor overload protection operates at 105% of the motor full load current.

- Instruct SDM 511/SDM 512 with nominal motor current (full load current according to the motor technical label) to use the
protection properly.

SDM 511/SDM 512 incorporates internal overload protection in the following multiples of current setting:

Table 122: Multiples of Current Setting

Multiple of current setting Maximum trip time

7.2 20 s

1.5 8 min

1.2 2 hrs
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11.3.2 Motor Overtemperature Protection

The internal motor overload protection implemented in SDM 511/SDM 512 does not have thermal memory retention or speed
sensitivity.

N O T I C E

- Internal motor overtemperature protection is not incorporated, so motor overtemperature sensing is required. SDM 511/
SDM 512 has an input for motor temperature sensor.

11.3.3 Dimensions
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Illustration 126: Dimensions of SDM 511/SDM 512, Enclosure Size 1 (FS1)
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Illustration 127: Dimensions of SDM 511, Enclosure Size 2 (FS2)

11.3.4 Characteristic Data SDM 511

Table 123: Characteristic Data for SDM 511

Specifications Unit Enclosure size
1 (FS1), 2.5 A

Enclosure size
1 (FS1), 5 A

Enclosure size
1 (FS1), 10 A

Enclosure size
1 (FS1), 20 A

Enclosure size
2 (FS2), 40 A

Input

DC-link V DC 565–680 ±10%

DC-link capacitance μF 330 900

UAUX V DC 24/48 ±10%

UAUX current consumption (at
24 V DC)

A DC 1.8 2.5

UAUX current consumption (at
48 V DC)

A DC 0.9 1.3

Output

Output number of phases – 3

Output voltage V AC VIN PSM

Rated current IN Arms 2.5 5 10 20 40

Rated power PN kW 0.5 2.2 4 11 22
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Specifications Unit Enclosure size
1 (FS1), 2.5 A

Enclosure size
1 (FS1), 5 A

Enclosure size
1 (FS1), 10 A

Enclosure size
1 (FS1), 20 A

Enclosure size
2 (FS2), 40 A

Peak current (rms value) Imax t
<2.65 s

Arms 10 20 30 40 80

Nominal switching frequency kHz 4/5

Possible switching frequency kHz 8/10

Derating of nominal and peak
current with 8 kHz switching
frequency

% 65

Derating of nominal and peak
current with 10 kHz switching
frequency

% 55

Protective measures – Overload, short-circuit, and ground fault protection

Maximum output frequency Hz 590

Functional safety – STO

Cooling – Integrated fan

Mounting – Wall-mounted on backplate using backlink connector

Number of motor connectors – 1

Weight kg 3.9 6.2

Dimensions

(W x H x D)

mm 84.3 x 471 x 270 134.3 x 471 x
270

11.3.5 Characteristic Data SDM 512

Table 124: Characteristic Data for SDM 512

Specifications Unit Enclosure size 1
(FS1), 2 x 2.5 A

Enclosure size 1
(FS1), 2 x 5 A

Enclosure size 1
(FS1), 2 x 10 A

Input

DC-link V DC 565–680 ±10%

DC-link capacitance µF 330

UAUX V DC 24/48 ±10%

UAUX current consumption (at 24 V DC) A DC 2.3

UAUX current consumption (at 48 V DC) A DC 1.2

Output

Output number of phases – 3

Output voltage V AC VIN PSM

Rated current IN Arms 2 x 2.5 2 x 5 2 x 10

Rated power PN kW 2 x 0.75 2 x 2.2 2 x 4
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Specifications Unit Enclosure size 1
(FS1), 2 x 2.5 A

Enclosure size 1
(FS1), 2 x 5 A

Enclosure size 1
(FS1), 2 x 10 A

Peak current (rms value) Imax t <2.65 s Arms 2 x 10 2 x 15 2 x 20

Nominal switching frequency kHz 4/5

Possible switching frequency kHz 8/10

Derating of nominal and peak current with
8 kHz switching frequency

% 65

Derating of nominal and peak current with
10 kHz switching frequency

% 55

Protective measures – Overload, short-circuit, and ground fault protection

Maximum output frequency Hz 590

Functional safety – STO

Cooling – Integrated fan

Mounting – Wall-mounted on backplate using backlink connector

Number of motor connectors – 2

Weight kg 4.0

Dimensions

(W x H x D)

mm 84.3 x 471 x 270
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11.4 Decentral Access Module (DAM 510)

11.4.1 Dimensions of DAM 510
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Illustration 128: Dimensions of DAM 510

11.4.2 Characteristic Data for DAM 510

Table 125: Characteristic Data for Decentral Access Module (DAM 510)

Definition Unit Power size 1 Power size 2

Input

DC-link V DC 565–680 ±10%

DC-link capacitance µF 660

Maximum input current A DC 15 25

UAUX V DC 24/48 ±10%

UAUX current consumption at 24 V DC A DC 0.5

UAUX current consumption at 48 V DC A DC 0.3
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Definition Unit Power size 1 Power size 2

Output

Output voltage V DC VOUT PSM

Output current DC-link A DC 15 25

Peak current DC-link (rms value) t <1.0 s Arms 30 for <1 s 48 for <1 s

Output current UAUX A DC 15

Protective measures – Overload, short-circuit, and ground fault protection

Cooling – Natural convection

Mounting – Wall-mounted on backplate using backlink connector

Weight kg 3.05

Dimensions (W x H x D) mm 84.3 x 467.9 x 270

11.4.3 Hybrid Cable Protection

The AUX 24/48 V has 3 levels of protection:

• Software (seconds timing range): The control boards opens the 24/48 V AUX if an overload is present (>15 A).

• Hardware (microseconds timing range): Opens automatically if a short circuit of >36 A is present.

• Hardware: A 20 A non-replaceable SMD (surface-mounted device) fuse in case the first 2 fuses fail.
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11.5 Auxiliary Capacitors Module (ACM 510)

11.5.1 Dimensions

84.3

[3.32]

50

[1.97]

13

[0.51]

21.3

[0.84]

25

[0.98]

270

[10.63]

25

[0.98]

3
6

7

[1
4

.4
5

]3
7

1

[1
5

]

3
8

0

[1
4

.9
6

]

7

[0
.2

8
]

6

[0
.2

4
]

Ø5.2
[0.2]

Ø5.2
[0.2]

e
3

0
b

g
5

8
8

.1
0

Illustration 129: Dimensions of ACM 510

11.5.2 Characteristic Data for ACM 510

Table 126: Auxiliary Capacitors Module (ACM 510) Characteristic Data

Definition Unit Value

DC-link V DC 565–680 ±10%

DC-link capacitance µF 2750

UAUX V DC 24/48 ±10%

UAUX current consumption at 24 V DC A DC 0.5

UAUX current consumption at 48 V DC A DC 0.3

Cooling – Natural convection

Mounting – Wall-mounted on backplate using backlink connector

Weight kg 3.54

Dimensions (W x H x D) mm 84 x 371 x 270
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11.6 Expansion Module (EXM 510)

11.6.1 Dimensions
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Illustration 130: Dimensions of EXM 510

11.6.2 Characteristic Data for EXM 510

Table 127: Expansion Module (EXM 510) Characteristic Data

Definition Unit Value

DC-link V DC 565–680 ±10%

Maximum current A DC 62

Mounting – Wall-mounted on backplate using backlink connector

Weight kg 0.6

Dimensions (W x H x D) mm 87 x 380 x 145

11.7 Connectors on the System Modules

11.7.1 Backlink Connector

The backlink connector is located at the top of the backside of all the MSD 510 system modules.
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Illustration 131: Pin Assignment of Backlink Connector

Table 128: Pin Assignment of Backlink Connector

Pin Description

1 24/48 V

2 GND
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Pin Description

3 FE: Functional earth

4 DC–

5 DC+

11.7.2 Brake Connectors

Brake connectors are located on the Power Supply Module (PSM 510) and the Servo Drive Modules (SDM 511/SDM 512).

11.7.2.1 Brake Resistor Connector on PSM 510
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Illustration 132: Brake Connector on PSM 510

Table 129: Pin Assignment of Brake Connector on PSM 510

Pins (left to
right)

Description Notes Ratings

1 DC+/R+ Used for connecting a brake re-
sistor.

Nominal voltage: 560–800 V DC

Maximum brake current: 80 A

Conductor cross-section range: 0.75–16 mm2 (AWG 18–AWG 4)

2 R–

N O T I C E

- The maximum length of the brake cable is 30 m (shielded).

11.7.2.2 Brake and Motor Temperature Sensor Connector on SDM 511/SDM 512

The brake connector on SDM 511/SDM 512 is used for both the mechanical brake and the temperature sensor (if present).
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Illustration 133: Brake Connector on SDM 511/SDM 512

Table 130: Brake Connector on SDM 511/SDM 512

Connector name Description Pins Ratings/Notes

Mechanical brake and mo-
tor temperature sensor con-
nector

Used to connect the mo-
tor's mechanical brake (if
present).

See table
131.

Nominal voltage: 24 V

Maximum (peak) voltage: 48 V ±10%

Maximum brake current: 2.5 A

Conductor cross-section range: 0.2–1.5 mm2 (AWG 24–
AWG 16)

Table 131: Pin Assignment of Mechanical Brake and Motor Temperature Sensor Connector on SDM 511/SDM 512

Pins Description Notes Rating/parameter

1 TEMP– Used to connect the motor's temperature
sensor (if present).

KTY83–110

KTY84–130

PT1000

2 TEMP+

3 BRAKE– Used to connect the motor's mechanical
brake (if present).

Nominal voltage: 24 V

Maximum (peak) voltage: 48 V ±10%

Maximum brake current: 2.5 A

Conductor cross-section range: 0.2–1.5 mm2 (AWG 24–AWG 16)

4 BRAKE+

N O T I C E

- The motor temperature measurement can either be connected to the motor feedback connector (see 11.7.13 Motor
Feedback Connectors) or the brake and motor temperature sensor connector on the servo drive module SDM 511/
SDM 512. The connectors cannot be connected in parallel.
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N O T I C E

- The signals on this connector are referred to GND and must therefore be reinforced insulated against the motor phases. The
internal insulation must withstand 4240 V DC and an 8000 Vpeak impulse.

N O T I C E

- Only PELV potential can be connected to the temperature sensor input.

N O T I C E

- The maximum length of the brake cable is 80 m (shielded).

11.7.3 Ethernet Connectors

Ethernet connectors are located on all the system modules.

e
3

0
b

e
3

9
5

.1
0

8
1

Illustration 134: Ethernet Connector

N O T I C E

- Only PELV potential can be connected to the digital inputs and outputs.
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11.7.3.1 Ethernet Connectors on PSM 510 and ACM 510

Table 132: Ethernet Connectors on PSM 510 and ACM 510

Connector name Description Pins Ratings

X1 IN Ethernet IN 1: TX+

2: TX–

3: RX+

4: –

5: –

6: RX–

7: –

8: –

According to standard 100BASE-T.

X2 OUT Ethernet OUT1

11.7.3.2 Ethernet Connectors on DAM 510

Table 133: Ethernet Connectors on DAM 510

Connector name Description Pins Ratings

X1 IN Ethernet IN 1: TX+

2: TX–

3: RX+

4: –

5: –

6: RX–

7: –

8: –

According to standard 100BASE-T.

X2 OUT Ethernet OUT1

X3 OUT Ethernet OUT2 (connection to hybrid cable)
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11.7.3.3 Ethernet Connectors on SDM 511/SDM 512

Table 134: Ethernet Connectors

Connector name Description Pins Ratings

SDM1 X1 IN Ethernet IN1 1: Tx+

2: TX–

3: RX+

4: –

5: –

6: RX–

7: –

8: –

According to standard 100BASE-T.

SDM1 X2 OUT Ethernet OUT1

SDM2 X1 IN (1) Ethernet IN2

SDM2 X2 OUT (1) Ethernet OUT2

1 Only on SDM 512

11.7.4 I/O Connectors

11.7.4.1 I/O Connector on PSM 510/ACM 510
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Illustration 135: I/O Connector on PSM 510 (I/O PSM) and ACM 510 (I/O ACM)

Table 135: Pin Assignment of I/O Connector on PSM 510/ACM 510

Pins Description Notes Rating/parameter

1 DIN1– Digital input Input voltage: 0–48 V DC

High (logic "1") voltage: 15–48 V DC

Low (logic "0") voltage: <5 V DC

Maximum input signal frequency: 50 Hz

Maximum input current at 48 V: 11 mA

Maximum input resistance: 4.5 KΩ

2 DIN1+
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Pins Description Notes Rating/parameter

3 DIG_OUT– Digital output Maximum voltage between terminals: 24 V DC or AC

Maximum current: 1 A

Maximum output switching frequency: 50 Hz

4 DIG_OUT+

The conductor cross-section range is 0.2–1.5 mm2 (AWG 24–AWG 16).

N O T I C E

- Only PELV potential can be connected to the digital inputs and outputs.

11.7.4.2 I/O Connector on SDM 511/SDM 512
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Illustration 136: I/O Connector on SDM 511/SDM 512

Table 136: Pin Assignment of I/O Connector on SDM 511/SDM 512

Pins Description Notes Rating/parameter

1 24 V AUX – –

2 Ground – –

3 DigInOut1 Digital input/output (switchable via software) Digital input:

Nominal voltage: 0–24 V

Bandwidth: ≦100 kHz

Digital output:

Nominal voltage: 24 V ±20%

Maximum current: 150 mA

()

Maximum switching frequency: 100 Hz
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Pins Description Notes Rating/parameter

4 DigOut1 Digital output Nominal voltage: 24 V ±20%

Maximum current: 150 mA

(1)

Maximum switching frequency: 100 Hz

5 DigOut2

6 DigOut3

7 DigIn4 Digital input Digital input:

Galvanic isolated

High (logic "1") voltage: 10–30 V DC

Low (logic "0") voltage: <5 V DC

Nominal voltage: 0–24 V

Maximum current: 3 mA

Input resistance: 10 kΩ

Maximum switching frequency: 100 Hz

8 DigIn3

9 DigIn2 Analog/digital input Digital input:

Nominal voltage: 0–24 V

Bandwidth: ≦100 kHz

Analog input:

Nominal voltage: 0–10 V

Input impedance: 5.46 kΩ

Bandwidth: ≦25 kHz

10 DigIn1

1 Maximum output current for all 4 digital outputs together. If all 4 digital outputs are used, the maximum output current of each is 30 mA.

The conductor cross-section range is 0.2–1.5 mm2 (AWG 24–AWG 16).

N O T I C E

- Only PELV potential can be connected to the digital inputs and outputs.

11.7.5 UAUX Connector

The UAUX connector is located on the Power Supply Module (PSM 510).
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Illustration 137: UAUX Connector

Table 137: Pin Assignment of UAUX Connector

Pins

(left to
right)

De‐
scrip‐
tion

Notes Rating/parameter

1 24 V
AUX

Used for 24–48 V DC in-
put to the Power Supply
Module (PSM 510).

Nominal input voltage: 24 V/48 V DC ±10%

Nominal current: Depends on the number of servo drives in the application.

Maximum current: 50 A

Maximum cross-section: 16 mm2

Maximum cable length: 3 m

Conductor cross-section range 0.75–16 mm2, solid or flexible (AWG 18–AWG 4)

2 GND

N O T I C E

- Only PELV potential can be connected to the UAUX input.

11.7.5.1 24/48 V Cable Cross Sections for PSM 510

Table 138: 24/48 V Cable Cross Sections for PSM 510

Minimum cable cross section for CE (minimum 70 °C, Cu) 16 mm2

Minimum cable cross section for UL (minimum 60 °C, Cu) 4 AWG

11.7.6 LCP Connector (M8, 6-pole)

The LCP connector is located on the front of all the system modules. It used to connect the LCP directly via a cable.
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Illustration 138: LCP Connector (M8, 6 pole)

Table 139: Pin Assignment of LCP Connector

Pins Description Notes Rating/parameter

1 Not connected – –

2 /LCP RST Reset Active at ≦0.5 V

3 LCP RS485 Positive RS485 signal Speed:

38.4 kBd

The levels fulfill the RS485 specification.

4 /LCP RS485 Negative RS485 signal

5 GND GND –

6 VCC 5 V supply for LCP 5 V ±10% at 120 mA maximum load

N O T I C E

- Only PELV potential can be connected to the LCP input.

11.7.7 AC Mains Connector

The AC mains connector is located on the bottom of the Power Supply Module (PSM 510).
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Illustration 139: AC Mains Connector
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Table 140: Pin Assignment of AC Mains Connector

Pins

(left to
right)

Descrip‐
tion

Notes Rating/parameter

1 L3 Used to connect
L1/L2/L3

Nominal voltage: 400–480 V AC ±10%

Nominal power: 30 kW

Maximum cross-section: 16 mm2 (AWG 4)

Conductor cross-section range 0.75–16 mm2, solid or flexible (AWG 18–AWG 4)

2 L2

3 L1

11.7.7.1 Mains Cable Cross-Sections for PSM 510

Table 141: Mains Cable Cross-Sections for PSM 510

PSM 510 (10 kW) PSM 510 (20 kW) PSM 510 (30 kW)

Minimum cable cross-section for CE 4 mm2

(minimum 70 °C, Cu)

16 mm2

(minimum 70 °C, Cu)

16 mm2

(minimum 90 °C, Cu)

Minimum cable cross-section for UL AWG 10

(minimum 60 °C, Cu)

AWG 6

(minimum 60 °C, Cu)

AWG 4

(minimum 75 °C, Cu)

11.7.8 Motor Connector

The motor connectors are located on the bottom of the Servo Drive Modules (SDM 511 and SDM 512).
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Illustration 140: Motor Connector
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Table 142: Pin Assignment of Motor Connector

Pins

(left to
right)

De‐
scrip‐
tion

Notes Rating/parameter

1 U SDM 511 has 1 motor
connector.

SDM 512 has 2 motor
connectors.

Nominal voltage: 400–480 V AC±10%

Nominal power: Depends on the servo drive size.

Conductor cross-section range:

• SDM 511 2.5–20 Arms: Conductor cross-section range 0.2–6 mm2, flexible
(AWG 24–AWG 8)

• SDM 511 40 Arms: Conductor cross-section range 0.75–16 mm2, solid or flexible
(AWG 18–AWG 4)

• SDM 512 2.5–10 Arms: Conductor cross-section range 0.2–6 mm2, flexible
(AWG 24–AWG 8)

2 V

3 W

11.7.8.1 Motor Cable Cross-Sections for SDM 511

Table 143: Motor Cable Cross-Sections for SDM 511

SDM 511
(2.5 Arms)

SDM 511
(5 Arms)

SDM 511
(10 Arms)

SDM 511
(20 Arms)

SDM 511
(40 Arms)

Minimum cable cross-section for CE
(min 70 °C, Cu)

1.5 mm2 4 mm2 10 mm2

Minimum cable cross-section for UL
(min 60 °C, Cu)

14 AWG 10 AWG 6 AWG

11.7.8.2 Motor Cable Cross-Sections for SDM 512

Table 144: Motor Cable Cross-Sections for SDM 511

SDM 512 (2.5 Arms) SDM 512 (5 Arms) SDM 512 (10 Arms)

Minimum cable cross-section for CE (min 70 °C, Cu) 1.5 mm2

Minimum cable cross-section for UL (min 60 °C, Cu) 14 AWG

11.7.9 Relay Connector

The relay connector is used for a user-defined reaction and is located as follows:

• Servo Drive Module SDM 511: 1 relay connector

• Servo Drive Module SDM 512: 2 relay connectors

• Power Supply Module PSM 510: 1 relay connector

• Auxiliary Capacitors Module ACM 510: 1 relay connector
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N O T I C E

- Only PELV potential can be connected to the relay outputs.

11.7.9.1 Relay Connector on PSM 510/ACM 510
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Illustration 141: Relay Connector on PSM 510/ACM 510

Table 145: Pin Assignment of Relay Connector on PSM 510 (REL PSM) and ACM 510 (REL ACM)

Pins Description Notes Rating/parameter

11 NC Normally closed, 24 V DC Nominal current: 2 A

Conductor cross-section range: 0.2–1.5 mm2 (AWG 24–AWG 16)
12 NO Normally open, 24 V DC

13 COM Common

11.7.9.2 Relay Connectors on SDM 511/SDM 512
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Illustration 142: Relay Connector for SDM 511 Enclosure Size 1 (FS1)/SDM 512
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Illustration 143: Relay Connector for SDM 511 Enclosure Size 2 (FS2)

Table 146: Pin Assignment of Relay Connector on SDM 511/SDM 512

Name Pins Description Notes Rating/parameter

REL SDM1 11 NC Normally closed, 24 V DC Nominal current: 2 A

Conductor cross-section range: 0.2–1.5 mm2 (AWG 24–AWG 16)
12 NO Normally open, 24 V DC

13 COM Common

REL SDM2 (1) 21 NC Normally closed, 24 V DC

22 NO Normally open, 24 V DC

23 COM Common

1 Only on SDM 512.

11.7.10 STO Connectors

11.7.10.1 STO Connectors on SDM 511 and SDM 512

The STO connectors are located on the Servo Drive Modules as follows:

• SDM 511: 1 input and 1 output STO connector

• SDM 512: 2 input and 2 output STO connectors
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Illustration 144: STO Connectors on SDM 511/SDM 512

Table 147: Pin Assignment of STO Connectors on SDM 511/SDM 512

Connector name Pins De‐
scrip‐
tion

Notes Rating/parameter

SDM511:

• STO SDM

SDM512:

• STO SDM1

• STO SDM2

1 STO– Used for STO output
voltage 1/2 to the input
of the PSM 510,
DAM 510, or SDM 511/2.

Nominal voltage: 24 V DC ±10%

Nominal current: Depends on the number of servo drives in
the application.

Maximum current: 1 A

Conductor cross-section range: 0.2–1.5 mm2 (AWG 24–
AWG 16)

2 STO+

3 STO– Used for STO input volt-
age 1/2.

4 STO+

N O T I C E

- Only PELV potential can be connected to the STO inputs.

11.7.10.2 STO Connectors on PSM 510

There is 1 input and 1 output STO connector on the Power Supply Module (PSM 510).
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Illustration 145: STO Output Connector on PSM 510
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Illustration 146: STO Input Connector on PSM 510

Table 148: Pin Assignment of STO Connectors on PSM 510

Connec‐
tor
name

Pins De‐
scrip‐
tion

Notes Rating/parameter

STO PSM 1 STO– Used for STO output
voltage to the input
of the other system
modules.

Nominal voltage: 24 V DC ±10%

Nominal current: Depends on the number of servo drives in the applica-
tion.

Maximum current: 1 A

Conductor cross-section range: 0.2–1.5 mm2 (AWG 24–AWG 16)

2 STO+

3 STO– Used for STO input
voltage.

4 STO+
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N O T I C E

- Only PELV potential can be connected to the STO inputs.

11.7.10.3 STO Connectors on the DAM 510

11.7.10.3.1 STO Connectors on the Top of DAM 510

There is 1 input and 1 output STO connector on the top of the Decentral Access Module (DAM 510).
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Illustration 147: STO Output Connector on the Top of DAM 510
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Illustration 148: STO Input Connector on the Top of DAM 510
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Table 149: Pin Assignment of STO Connectors on the Top of DAM 510

Connec‐
tor
name

Pins De‐
scrip‐
tion

Notes Rating/parameter

STO DAM 1 STO– Used for STO output
voltage to the input
of the other system
modules.

Nominal voltage: 24 V DC ±10%

Nominal current: Depends on the number of servo drives in the applica-
tion.

Maximum current: 1 A

Conductor cross-section range: 0.2–1.5 mm2 (AWG 24–AWG 16)

2 STO+

3 STO– Used for STO input
voltage.

4 STO+

N O T I C E

- Only PELV potential can be connected to the STO inputs.

11.7.10.3.2 STO Connector on the Bottom of DAM 510

There is 1 output STO connector on the bottom of the Decentral Access Module (DAM 510). The output is for the hybrid cable.
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Illustration 149: STO Connector on the Bottom of DAM 510

Table 150: Pin Assignment of STO Connector on the Bottom of DAM 510

Connec‐
tor
name

Pins

(left to
right)

De‐
scrip‐
tion

Notes Rating/parameter

STO DAM 1 STO+ Used for the STO
output from the
DAM to the hybrid
cable.

Nominal voltage: 24 V DC ±10%

Nominal current: Depends on the number of servo drives in the appli-
cation.

Maximum current: 1 A

Conductor cross-section range: 0.2–1.5 mm2 (AWG 24–AWG 16)

Plug terminal tightening torque: 0.22–0.25 Nm

2 STO–
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11.7.11 UDC Connector

The UDC connector is located on the bottom of the Decentral Access Module (DAM 510).
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Illustration 150: UDC Connector

Table 151: Pin Assignment of UDC Connector

Pins

(left to
right)

De‐
scrip‐
tion

Notes Rating/parameter

1 UDC+ Used to connect the DC-link voltage
from the Decentral access Module
(DAM 510) to the hybrid cable for the
ISD line.

Nominal voltage: 560–800 V DC

Nominal current: Depends on the number of servo drives in the ap-
plication.

Maximum current: 25 A

Conductor cross-section range: 0.2–6 mm2 (AWG 24–AWG 10)

Plug terminal tightening torque: 0.5–0.8 Nm

2 UDC–

11.7.12 AUX Connector

The AUX connector is located on the bottom of the Decentral Access Module (DAM 510).
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Illustration 151: AUX Connector
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Table 152: Pin Assignment of AUX Connector

Pins

(left to
right)

Description Notes Rating/parameter

1 AUX+

(24/48 V)

Used to connect the AUX output
from the Decentral access Module
(DAM 510) to the hybrid cable for
the servo drive line.

Nominal voltage: 24/48 V DC ±10%

Nominal current: Depends on the number of servo drives in the
application.

Maximum current: 15 A

Conductor cross-section range: 0.2–2.5 mm2 (AWG 24–AWG 12)

Plug terminal tightening torque: 0.5–0.6 Nm

2 AUX– (GND)

N O T I C E

- Only PELV potential can be connected to the AUX output.

11.7.13 Motor Feedback Connectors

The motor feedback connectors allow the connection of an encoder or resolver to the Servo Drive Modules SDM 511/SDM 512.

SDM 511 has 1 motor feedback connector (E SDM1).

SDM 512 has 2 motor feedback connectors (E SDM1 and E SDM2).

The motor feedback connectors fulfill the following specifications:

• BISS B

• Resolver

• HIPERFACE®

• HIPERFACE® DSL

• EnDat 2.1

• EnDat 2.2

Use a shielded feedback cable that fulfills the requirements for the used feedback type. The maximum cable length is 80 m.
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Illustration 152: Motor Feedback Connector on SDM 511/SDM 512

SpecificationsOperating Guide  | VLT® Multiaxis Servo Drive MSD 510 System

AQ262450196490en-000101 / 175R1170| 233Danfoss A/S © 2019.10



Table 153: Pin Assignment of Motor Feedback Connectors E SDM1 and E SDM2

Pins Description Resolver BISS B HIPER‐
FACE

HIPER‐
FACE DSL

EnDat
2.1 and
2.2

Rating/parameter

1 \RESCOS X – X – (1) Resolver negative cosine input

2 RESCOS X – X – (1) Resolver positive cosine input

3 SUPPLY+ (2) – X X – X +5/11 V (depending on feedback type),
maximum 250 mA

4 \RXTX – X X – X Encoder negative data signal

5 RXTX – X X – X Encoder positive data signal

6 HIPERFACE_DSL+ – – – X – HIPERFACE DSL positive line

7 – – – – – – –

8 – – – – – – –

9 TEMP– X X X – X Motor temperature sensor input

10 \RESSIN X – X – (1) Resolver negative sine input

11 SUPPLY+ (2) – – – – – +5/11 V (depending on feedback type),
maximum 250 mA

12 SUPPLY– (2) – X X – X GND

13 \RESSY X – – – (1) Resolver negative exciter output

14 RESSY X – – – (1) Resolver positive exciter output

15 HIPERFACE_DSL– – – – X – HIPERFACE DSL negative line

16 – – – – – – –

17 – – – – – – –

18 TEMP+ X X X – X Motor temperature sensor input

19 RESSIN X – X – (1) Resolver positive sine input

20 ENC_CLK – X – – X Encoder positive clock signal

21 \ENC_CLK – X – – X Encoder negative clock signal

22 SUPPLY+ (2) – X X – X +5/11 V (depending on feedback type),
maximum 250 mA

23 SENS+ (3) – X X – X Positive supply sense line

24 SENS– (3) – X X – X Negative supply sense line

25 SUPPLY– (2) – X X – X GND

26 – – – – – – –

1 The SINE and COSINE signals are optional for EnDat
2  The supply switches automatically between 5 V and 11 V depending on which feedback type is selected. Pins 3, 11, and 22 are all equivalent and it is not necessary to connect all of

them. To reduce the voltage drop over the feedback cable, it is possible to use multiple supply lines in parallel.
3 To activate the internal power supply compensation, connect the 2 sense lines (SENS+ and SENS–) on the motor side to the supply (SUPPLY+ and SUPPLY–). This automatically

adapts the supply voltage, depending on the cable length, and compensates the voltage drop over the feedback cable.
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N O T I C E

- The motor temperature measurement can either be connected to the motor feedback connector or the brake and motor
temperature sensor connector on the servo drive module SDM 511/SDM 512 (see 11.7.2.2 Brake and Motor Temperature
Sensor Connector on SDM 511/SDM 512). The connectors cannot be connected in parallel.

N O T I C E

- Only PELV potential can be connected to the motor feedback connector.

11.7.14 External Encoder Connectors

This connector is used to connect an external encoder to SDM 511/SDM 512 and DAM 510. It provides a guide value for CAM mode and
Gear mode.

The external encoder connectors are located on the Servo Drive Modules (SDM 511/SDM 512) and the Decentral Access Module
(DAM 510) as follows:

• SDM 511: E SDM1

• SDM 512: E SDM1 and E SDM2

• DAM 510: E DAM
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Illustration 153: External Encoder Connector

Table 154: External Encoder Connectors

Connector
name

Description Pins Ratings/Notes

E SDM1/
E SDM2/
E DAM

Used to connect the exter-
nal encoder to SDM 511/
SDM 512/DAM 510.

See table
155.

Nominal voltage: 24 V DC, isolated (see table 155)

Nominal current: Depends on the number of servo drives in the appli-
cation.

Maximum current: 150 mA (see table 155)

Fulfill the following specifications:

• BISS/SSI
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Table 155: Pin Assignment of External Encoder Connectors (X1/X2)

Pins Description Notes

SSI/BiSS

Notes

1 24 V 24 V DC ±10% (used for powering the encoder) Maximum current: 150 mA

2 – – –

3 – – –

4 RS422 RXD Positive data Bus speed:

SSI: Up to 10 Mhz clock frequency with 30 m cable.

BiSS: Fulfills the RS485 specification.

5 RS422 TXD Positive data

6 GX Isolated ground.

If encoders are powered externally, the ground of the
external supply must be connected to GX.

–

7 – – –

8 /RS422 RXD Negative data Bus speed:

SSI: 0.5 Mbit with 25 m cable.

BiSS: Fulfills the RS485 specification.

9 /RS422 TXD Negative data

N O T I C E

- Only PELV potential can be connected to the external encoder.

11.7.15 Expansion Module Connector
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Illustration 154: Expansion Module Connector
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Table 156: Pin Assignment of Expansion Module Connector

Pins

(left to
right)

Descrip‐
tion

Note Rating/parameter

1 DC+ Shield the DC cables
using the cable tie on
the EXM 510 EMC
plate.

Nominal voltage: 560–800 V DC

Nominal current: Depends on the number of servo drives in the application.

Maximum current: 62 A

(1)

Conductor cross-section range: 0.75–16 mm2, solid or flexible (AWG 18–AWG 4)

Only use with ferrule without plastic sleeve with CRIMPFOX 16 S.

Use shielded conductors for UDC (DC+, DC–).

Plug terminal tightening torque: 1.7–1.8 Nm

2

3 DC–

4

5 FE (func-
tional
earth)

–

6 GND –

7 24/48 V –

1 The maximum current rating for 1 pair of EXM is 62 A. In systems with 2 PSM 510 modules, 2 pairs of EXM 510 modules can be used to achieve a maximum current rating of 124 A.

11.8 General Specifications and Environmental Conditions for MSD 510 System

Table 157: General Specifications and Environmental Conditions for MSD 510 System

Specification Value

Protection rating IP20 according to IEC/EN 60529 (except connectors, which are IP00).

W A R N I N G
RISK OF ELECTRICAL SHOCK

The IP20 rating of the system is not fulfilled if the system is operated with a
module that is not connected to the backplate. This may result in death or seri-
ous injury.

- Do not touch the backplate when a module is removed from the back-
plate.

Vibration test Random vibration: 1.14 g (2h/axis according to EN 60068-2-64)

Sinusoidal vibration: 0.7 g (2h/axis according to EN 60068-2-6)

Maximum relative humidity Storage/transport: 5–95% (non-condensing)

Stationary use: 5–93% (non-condensing)

Ambient temperature range Operating: 5–40 °C nominal, up to 55 °C with derating (see illustration 155)

Transport: –25 °C to +55 °C

Storage: –25 °C to +55 °C
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Specification Value

Installation altitude Nominal current up to 1000 m above sea level.

Derating of output current (1% / 100 m) at 1000–3000 m.

Operation above 3000 m is not permitted.

EMC standard for emission and immunity EN 61800-3

EMC immunity for functional safety EN 61800-5-2 Annex E

Degree of pollution according to EN
60664-1

2

Overvoltage category according to EN
61800-5-1
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Illustration 155: Derating

11.9 Storage

Store the servo system components in a dry, dust-free location with low vibration (veff ≦0.2 mm/s).

The storage location must be free from corrosive gases.

Avoid sudden temperature changes.

Long-term Storage

To recondition the electrolytic capacitors, servo drives and system components not in service must be connected to a supply source
once per year to allow the capacitors to charge and discharge. Otherwise the capacitors could suffer permanent damage.
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VLT Servo Drive Systems Glossary

A
A-flange The A side is the shaft side of the servomotor.

ACM Auxiliary Capacitors Module.

Ambient temperature The temperature in the immediate vicinity of the servo system or compo-

nent.

Automation Studio™ Automation Studio is a registered trademark of B&R. It is the integrated

software development environment for B&R controllers.

B
Bearings The ball bearings of the servomotor.

Beckhoff® Beckhoff is a registered trademark of and licensed by Beckhoff Automation

GmbH, Germany.

B&R Multi-national company, specializing in factory and process automation

software and systems for a wide range of industrial applications.

B side The rear side of the servo drive with the plug-and-socket connectors.

Brake Mechanical holding brake on the servo drive.

C

CANopen® CANopen is a registered community trademark of CAN in Automation e.V.

CE European test and certification mark.

CIA DS 402 Device profile for drives and motion control. CIA is a registered community

trademark of CAN in Automation e.V.

Connector (M23) Servo drive hybrid connector.

Cooling Decentral servo drives are cooled by natural convection (without fans). The

Servo Drive Modules SDM 511/SDM 512 and all system modules except the

ACM 510 are cooled by an internal fan.

D
DAM Decentral Access Module

DC-link Each servo drive has its own DC-link, consisting of capacitors.

DC-link voltage A DC voltage shared by several servo drives connected in parallel.

DC voltage A direct constant voltage.

DSD Decentral Servo Drive

E
EPSG Ethernet POWERLINK Standardization Group.

ETG EtherCAT Technology Group

EtherCAT® EtherCAT (Ethernet for Control Automation Technology) is an open high-

performance Ethernet-based fieldbus system. EtherCAT is registered trade-
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mark and patented technology, licensed by Beckhoff Automation GmbH,

Germany.

Ethernet POWERLINK® Ethernet POWERLINK is a deterministic real-time protocol for standard

Ethernet. It is an open protocol managed by the Ethernet POWERLINK

Standardization Group (EPSG). It was introduced by Austrian automation

company B&R in 2001.

F
Feed-in cable Hybrid connection cable between the Decentral Access Module (DAM 510)

and ISD 510/DSD 510 servo drive.

Feedback system The feedback system measures the rotor position.

Fieldbus Communication bus between controller and servo axis and system mod-

ules; in general between controller and field nodes.

Firmware Software in the unit; runs on the control board.

Function block Device functionalities are accessible via the engineering environment soft-

ware.

I
IGBT The insulated-gate bipolar transistor is a 3-terminal semiconductor device,

primarily used as an electronic switch to combine high efficiency and fast

switching.

Installation elevation Installation elevation above normal sea level, typically associated with a de-

rating factor.

IRT Isochronous Real-Time.

ISD Integrated Servo Drive

L
LCP Local control panel.

Loop cable Hybrid connection cable between 2 decentral servo drives, with 2 M23 con-

nectors.

M
M23 connectors Connectors (X1 & X2) for connecting the hybrid feed-in and loop cables on

the B side of the standard and advanced version of the ISD 510/DSD 510

servo drive.

MSD Multi-axis Servo Drive

Motor shaft Rotating shaft on the A side of the servo motor, typically without a key

groove.

Multi-turn encoder Describes an absolute encoder, in which the absolute position remains

known after several revolutions.

P
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PLC A programmable logic controller is a digital computer used for automation

of electromechanical processes, such as control of machinery on factor as-

sembly lines.

PELV Protected extra low voltage is an electricity supply voltage in a range which

carries a low risk of dangerous electrical shock.

PLCopen® The name PLCopen is a registered trademark and, together with the PLCop-

en logos, is owned by the association PLCopen. PLCopen is a vendor- and

product-independent worldwide association, that defines a standard for in-

dustrial control programming.

POU Program organization unit. This can be a program, function block, or func-

tion.

PSM Power Supply Module.

PWM Pulse width modulation.

R
RCCB Residual current circuit breaker.

Resolver A feedback device for servomotors, typically with 2 analog tracks (sine and

cosine).

S
Safety (STO) A servo drive safety circuit that switches off the voltages of the driver com-

ponents for the IGBTs.

Scope Scope is part of the DDS Toolbox software and is used for diagnosis. It ena-

bles internal signals to be depicted.

SDM Servo Drive Module.

SIL 2 Safety Integrated Level II.

Single-turn encoder Describes an absolute encoder, in which the absolute position for 1 revolu-

tion remains known.

SSI Synchronous serial interface.

Standstill (servo drive) Power is on, there is no error in the axis, and there are no motion com-

mands active on the axis.

STO Safe Torque Off function. On activation of STO, the ISD 510 servo drive is no

longer able to produce torque in the motor.

System modules This term includes the Power Supply Module (PSM 510), the Decentral Ac-

cess Module (DAM 510), and the optional Auxiliary Capacitors Module

(ACM 510).

T

TwinCAT® TwinCAT is a registered trademark of and licensed by Beckhoff Automation

GmbH, Germany. It is the integrated software development environment

for controllers from Beckhoff.
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U
UAUX Auxiliary supply, provides power to the control electronics of the servo

drives and the Power Supply Module (PSM 510), Decentral Access Module

(DAM 510), and Auxiliary Capacitors Module (ACM 510).

V

VLT® Servo Toolbox A pc software tool used for parameter setting and diagnostics of VLT Servo

Drive systems

W

Wireshark® Wireshark is a network protocol analyzer released under the GNU General

Public License version 2.
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